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Untuk keselamatan Anda
Baca petunjuk-petunjuk ringkas ini. Tidak mematuhi 
peraturan dan ketentuan dapat membahayakan atau 
melanggar hukum. Bacalah buku petunjuk lengkap untuk 
informasi lebih lanjut.

MENGAKTIFKAN DENGAN AMAN Jangan 
aktifkan perangkat ini bila penggunaan telepon 
selular dilarang atau bila dapat menimbulkan 
gangguan atau bahaya.

UTAMAKAN KESELAMATAN DI JALAN 
RAYA Patuhi peraturan hukum di tempat Anda. 
Pastikan posisi tangan Anda tetap berada di 
roda kemudi selama mengemudikan kendaraan. 
Prioritas pertama Anda saat mengemudi adalah 
keselamatan di jalan raya.

GANGGUAN Semua perangkat nirkabel dapat 
mengalami gangguan yang mungkin 
mempengaruhi kinerjanya.

NONAKTIFKAN BILA BERADA DI RUMAH 
SAKIT Patuhi peraturan yang berlaku. Matikan 
perangkat ini saat berada di dekat peralatan 
medis.

NONAKTIFKAN DI DALAM PESAWAT 
TERBANG Patuhi peraturan yang berlaku. 
Perangkat selular dapat menimbulkan 
gangguan di dalam pesawat terbang.

NONAKTIFKAN SEWAKTU MENGISI BAHAN 
BAKAR Jangan gunakan perangkat ini di 
tempat pengisian bahan bakar. Jangan 
gunakan telepon selular di dekat bahan bakar 
atau bahan kimia.

NONAKTIFKAN SAAT BERADA DI AREA 
PELEDAKAN Patuhi peraturan yang berlaku. 
Jangan gunakan perangkat ini di tempat yang 
sedang terjadi ledakan. 

GUNAKAN DENGAN WAJAR Gunakan 
telepon ini hanya dalam posisi normal seperti 
yang dijelaskan dalam dokumentasi produk. 
Bila tidak perlu, jangan sentuh antena.

LAYANAN RESMI Hanya petugas layanan 
yang memenuhi syarat yang boleh memasang 
atau memperbaiki produk ini.

PERANGKAT TAMBAHAN DAN BATERAI 
Gunakan hanya perangkat tambahan dan 
baterai yang telah disetujui. Jangan gunakan 
produk-produk yang tidak kompatibel.

KEDAP AIR Perangkat ini tidak kedap air. Jaga 
agar tetap kering.
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SALINAN DATA CADANGAN Jangan lupa 
untuk selalu membuat salinan data cadangan 
atau menyimpan data tertulis untuk semua 
informasi penting.

HUBUNGAN KE PERANGKAT LAIN Bacalah 
buku petunjuk sebelum Anda menghubungkan 
perangkat ini ke perangkat lain untuk petunjuk 
keselamatan secara lengkap. Jangan gunakan 
produk-produk yang tidak kompatibel.

PANGGILAN DARURAT Pastikan perangkat 
dalam keadaan aktif dan berada dalam 
jangkauan layanan. Tekan terus  untuk 
menampilkan tombol telepon pada layar. 
Masukkan nomor darurat, kemudian tekan 

. Beritahukan lokasi Anda. Jangan akhiri 
panggilan sebelum diperbolehkan.

Smartphone Anda
Smartphone selular yang dijelaskan dalam buku petunjuk 
ini telah disetujui untuk digunakan dalam jaringan EGSM 
900, GSM 1800 dan GSM 1900. Untuk informasi lebih 
lanjut tentang jaringan, hubungi operator selular Anda.

Bila menggunakan fitur-fitur pada smartphone ini, patuhi 
semua peraturan dan hormatilah kebebasan pribadi serta 
hak hukum orang lain.

PERINGATAN: Untuk menggunakan semua fitur dalam 
smartphone ini, kecuali alarm aktif, perangkat harus 
diaktifkan terlebih dahulu. Jangan aktifkan 
smartphone ini jika penggunaan telepon selular dapat 
menimbulkan gangguan atau bahaya.

Layanan jaringan
Untuk menggunakan telepon, Anda harus memiliki 
layanan dari operator selular. Fungsi beberapa fitur dalam 
smartphone ini tergantung pada fitur-fitur yang didukung 
jaringan selular. Layanan jaringan ini mungkin tidak 
tersedia di semua jaringan atau Anda mungkin harus 
membuat perjanjian khusus dengan operator selular 
sebelum dapat menggunakan layanan jaringan. Operator 
selular Anda mungkin harus memberikan petunjuk 
tambahan untuk penggunaan layanan tersebut dan 
menjelaskan biaya yang akan dikenakan. Beberapa 
jaringan mungkin memiliki keterbatasan yang akan 
mempengaruhi penggunaan layanan jaringan. Misalnya, 
beberapa jaringan mungkin tidak mendukung semua 
layanan dan karakter bahasa.

Operator selular Anda mungkin akan meminta agar 
beberapa fitur tertentu diblokir atau tidak diaktifkan pada 
smartphone ini. Jika demikian, maka fitur-fitur tersebut 
tidak akan terlihat pada menu smartphone Anda. Untuk 
informasi lebih lanjut, hubungi operator selular Anda.
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Perangkat ini mendukung protokol WAP 2.0 (HTTP dan SSL) 
yang beroperasi pada protokol TCP/IP. Beberapa fitur pada 
perangkat ini, seperti yang digunakan dengan MMS dan 
browser Web memerlukan dukungan jaringan untuk 
teknologi ini.

Memori bersama
Berikut adalah beberapa fitur dalam smartphone ini yang 
mungkin menggunakan memori bersama: kontak, pesan 
teks dan pesan multimedia, gambar, nada dering, file 
audio, klip video, catatan kalender dan catatan agenda 
serta aplikasi yang di-download. Penggunaan salah satu 
atau beberapa fitur tersebut akan mengurangi memori 
yang tersedia untuk fitur-fitur lain yang menggunakan 
memori bersama. Contohnya, penyimpanan beberapa 
gambar mungkin akan menggunakan semua memori yang 
tersedia. Smartphone Anda akan menampilkan pesan 
bahwa memori sudah penuh saat Anda mencoba 
menggunakan salah satu fitur memori bersama. Dalam hal 
ini, hapus beberapa informasi atau catatan yang disimpan 
dalam fitur memori bersama sebelum Anda melanjutkan 
penyimpanan.

Perangkat tambahan, baterai dan 
pengisi daya
Periksa nomor model pengisi daya sebelum digunakan 
dengan smartphone ini. Smartphone ini dirancang untuk 
digunakan dengan daya dari ACP-12 dan AC-1A.

PERINGATAN: Gunakan hanya baterai, pengisi daya 
dan perangkat tambahan yang diakui oleh Nokia 
untuk penggunaan bagi model khusus ini. Penggunaan 
jenis lainnya akan membuat persetujuan atau jaminan 
yang telah disetujui menjadi tidak sah dan mungkin 
membahayakan.

Sebelum mengeluarkan baterai, pastikan untuk 
menonaktifkan smartphone dan memutuskan sambungan 
ke pengisi daya (charger).

Untuk ketersediaan perangkat tambahan yang diakui, 
silakan hubungi agen Anda. Untuk melepas kabel 
sambungan perangkat tambahan, pegang dan cabut 
steker, bukan kabelnya.

Smartphone Anda dan perangkat tambahan terdiri dari 
beberapa komponen kecil. Jauhkan komponen tersebut 
dari jangkauan anak-anak.
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Persiapan
Smartphone multimedia Nokia 7710 menyediakan 
berbagai aplikasi media, misalnya perekam kamera, 
pemutar musik, Visual Radio™, RealPlayer dan Web 
browser. Selain itu, smartphone ini juga dilengkapi dengan 
berbagai fungsi penting seperti pengolah kata (word 
processor), jam, kalkulator dan kalender.

Komponen smartphone

Bagian depan dan atas

Gbr. 1 Bagian depan dan atas

1  Tombol suara. Tekan untuk beralih antara 
pengeras suara dan lubang suara selama panggilan 
suara berlangsung. Tekan untuk memulai atau 
mengakhiri rekaman suara. Tekan terus untuk 
mengaktifkan panggilan suara.

2  Tekan untuk mengakhiri atau menolak panggilan. 
Tekan untuk membuka Tampilan penelepon dari 
aplikasi Telepon.

3  Tekan untuk menjawab panggilan. Pada Tampilan 
penelepon di aplikasi Telepon dan Meja, tekan untuk 
melihat nomor telepon yang terakhir dipanggil.

4 Tombol gulir. Tekan bagian atas , bawah , kiri 
 dan kanan  untuk menggerakkan kursor pada 

layar, dan untuk memilih objek. Tekan di bagian tengah 
untuk mengaktifkan atau memilih. Tekan untuk 
memanggil nomor yang telah dihubungi, nomor 
sambungan cepat, atau kontak yang dipilih. Tekan 
kanan dan kiri untuk mengatur volume lubang suara, 
headset dan pengeras suara (loudspeaker).

5  Tombol Menu. Tekan untuk membuka menu. Tekan 
beberapa kali untuk beralih di antara halaman dialog.

6 Mikrofon
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7  Tombol Meja. Tekan  untuk membuka aplikasi Meja 
yang merupakan tampilan utama pada smartphone ini. 
Untuk informasi lebih lanjut, lihat “Meja” pada 
halaman 34. Jika Anda menekan terus tombol ini, maka 
daftar aplikasi yang terakhir kali digunakan akan 
terbuka, kemudian Anda dapat memilih salah satu di 
antaranya. Tombol ini juga dapat digunakan untuk 
membuka Tampilan saya. Untuk informasi lebih lanjut, 
lihat “Pengaturan Tampilan saya” pada halaman 129.

8  Tombol Esc. Berguna untuk menutup dialog atau 
kembali ke tampilan sebelumnya. Tombol ini juga akan 
membatalkan pilihan dalam dialog jika tombol Batal 
tersedia. Jika aplikasi tidak merespon, tekan tombol ini 
kurang lebih selama 5 detik untuk menutup aplikasi 
yang berjalan di latar belakang dan mengosongkan 
beberapa memori. Agar tidak kehabisan memori, 
sebaiknya tutup secara teratur aplikasi yang tidak 
digunakan dengan cara menekan tombol .

9 Lubang suara.
10 Tombol alih  memungkinkan untuk beralih di antara 

tampilan dalam sebuah aplikasi. 
11 Tombol zoom. Jika dapat digunakan,  akan 

membuat pilihan zoom tersedia di telepon, sehingga 
Anda dapat beralih antara panggilan Modus potret dan 
Modus lansekap.

Fungsi tombol  dan  tergantung pada aplikasi dan 
tampilan di layar. Saat panggilan berlangsung, tekan  
untuk membuka pengaturan audio lalu tekan  atau 

, masing-masing untuk memperbesar atau 

memperkecil tingkat volume suara. Anda juga dapat 
memilih untuk menggunakan fungsi pengeras suara 
atau menghilangkan suara perangkat. Kedua tombol ini 
juga digunakan untuk mengaktifkan permainan. 

Bagian kanan dan dasar

Gbr. 2 Bagian kanan dan dasar

1 Konektor pengisi daya
2 Konektor Pop-Port™ untuk headset, kabel sambungan 

dan loopset.
3 Kantung pena stylus.
4  Tombol daya. Tekan terus untuk mengaktifkan 

atau menonaktifkan smartphone. Tekan sebentar 
untuk mengubah profil.
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Belakang

Gbr. 3 Lensa kamera dan pengeras suara

Memasang kartu SIM dan baterai
• Jauhkan kartu SIM dari jangkauan anak-anak. Untuk 

ketersediaan dan informasi tentang penggunaan 
layanan kartu SIM, hubungi vendor kartu SIM Anda, 
misalnya penyedia layanan, operator jaringan atau 
vendor lainnya.

• Kartu SIM dan bagian kontaknya mudah rusak oleh 
goresan atau lipatan, karena itu hati-hati saat 
memegang, memasukkan atau mengeluarkannya.

• Sebelum melepas penutup (cover) belakang, pastikan 
Anda telah mematikan perangkat dan mencabut kabel 
pengisi daya dan sambungan ke smartphone. Simpan 
dan gunakan selalu smartphone dengan penutup 
belakang terpasang.

1 Untuk melepas penutup belakang, dengan bagian 
belakang smartphone menghadap Anda, tekan tombol 
untuk membuka penutup belakang kemudian angkat 
penutup belakang (Lihat gbr. 4).

Gbr. 4 Melepas penutup belakang

2 Jika baterai terpasang pada smartphone, keluarkan 
baterai tersebut dari smartphone. (Lihat gbr. 5).
Sebelum mengeluarkan baterai, matikan smartphone 
terlebih dulu dan cabut kabel pengisi daya.
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Gbr. 5 Melepas baterai

3 Buka tuas slot kartu SIM (Lihat gbr. 6), lalu dorong 
kartu SIM dari samping ke dalam slot kartu SIM (Lihat 
gbr. 7). Pastikan sudut miring pada kartu SIM 
menghadap ke dalam ke arah slot dan bidang kontak 
berwarna emas pada kartu menghadap ke bawah.

Gbr. 6 Membuka tuas slot kartu SIM

Gbr. 7 Memasukkan kartu SIM dan kartu memori

4 Tutup tuas slot kartu SIM (Lihat gbr. 8).

Gbr. 8 Menutup tuas slot SIM
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5 Untuk memasukkan baterai, luruskan bagian kontak 
berwarna emas pada baterai dengan masing-masing 
konektor pada kompartemen baterai. Tekan di bagian 
ujung yang berlawanan pada baterai sampai masuk ke 
tempatnya (Lihat gbr. 9). 

Gbr. 9 Memasang baterai

6 Rapatkan penutup dengan benar. (Lihat gbr. 10)

Gbr. 10 Memasang kembali penutup (cover) belakang

Melepas dan memasang kartu 
memori
Smartphone Anda telah dilengkapi dengan kartu memori 
(MMC) siap pakai. Kartu ini mungkin berisi sejumlah file 
dan aplikasi yang telah diinstal sebelumnya. Anda dapat 
menggunakan kartu memori untuk mengelola file-file, 
aplikasi, salinan data cadangan, dan lain-lain, dengan cara 
yang sama untuk setiap objek di smartphone.

Penting: Jangan lepaskan kartu memori saat 
sedang berfungsi. Melepaskan kartu ketika 
sedang berfungsi dapat merusak kartu memori 
dan smartphone, dan data yang tersimpan pada 
kartu juga akan rusak.

Jauhkan kartu memori dari jangkauan anak-anak.

Untuk melepas kartu memori, dengan bagian 
belakang smartphone menghadap Anda, tekan tombol 
untuk membuka penutup belakang kemudian lepaskan 
penutup belakang (Lihat gbr. 4). Keluarkan kartu 
memori dari slotnya dengan seksama. Hati-hati, 
jangan sampai bagian kontak berwarna emas pada 
kartu tergores.
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Untuk memasang kartu memori, dengan bagian 
belakang smartphone menghadap Anda, tekan tombol 
untuk membuka penutup belakang kemudian lepaskan 
penutup belakang (Lihat gbr. 4). Dorong kartu memori 
secara perlahan ke dalam slotnya (Lihat gbr. 7). 
Pastikan bidang kontak berwarna emas pada kartu 
menghadap ke bawah.

Catatan: Gunakan hanya kartu Multimedia (MMC) 
yang kompatibel dengan smartphone ini. Kartu memori 
lain, seperti kartu Secure Digital (SD), tidak sesuai 
untuk slot kartu MMC dan karenanya tidak kompatibel 
dengan smartphone ini. Menggunakan kartu memori 
yang tidak kompatibel dapat merusak kartu memori 
dan smartphone ini, dan data yang disimpan dalam 
kartu yang tidak kompatibel tersebut juga dapat rusak.

Mengisi daya baterai
Selama pengisian daya baterai berlangsung, jangan 
gunakan fitur seperti browser Web atau RealPlayer, karena 
membutuhkan daya yang cukup besar. Aktivitas yang 
memerlukan daya terlalu besar dapat mengganggu proses 
pengisian daya baterai.
1 Hubungkan konektor pengisi daya ke bagian dasar 

smartphone (Lihat gbr. 2 pada halaman 13).

2 Pasang pengisi daya ke stopkontak. Baris indikator 
baterai mulai bergulir di bagian indikator status. Anda 
tetap dapat menggunakan smartphone ini selama 
pengisian berlangsung. Jika daya baterai sudah benar-
benar habis, diperlukan hingga beberapa menit 
sebelum indikator pengisian daya muncul di layar.

3 Bila daya baterai sudah terisi penuh, baris tersebut 
akan berhenti bergulir. Lepaskan pengisi daya dari 
smartphone Anda, kemudian dari stopkontak.

Lihat juga “Informasi baterai” pada halaman 170 dan 
“Perangkat tambahan, baterai dan pengisi daya” pada 
halaman 11.

Mengaktifkan smartphone
PERINGATAN: Untuk menggunakan semua fitur 
dalam smartphone ini, kecuali alarm aktif, perangkat 
harus diaktifkan terlebih dahulu. Jangan aktifkan 
smartphone ini jika penggunaan smartphone selular 
dapat menimbulkan gangguan atau bahaya.

Untuk mengaktifkan atau menonaktifkan 
smartphone, tekan terus tombol daya . 
Smartphone ini dapat digunakan tanpa mengaktifkan 
fungsi telepon saat profil Penerbangan dipilih. Untuk 
informasi lebih lanjut, lihat “Profil” pada halaman 49.
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Jika smartphone meminta kode PIN, masukkan kode 
PIN (ditampilkan sebagai ****), lalu tekan OK. Kode PIN 
melindungi kartu SIM terhadap penyalahgunaan oleh 
orang lain dan biasanya disertakan bersama kartu SIM. 
Jika Anda memasukkan kode PIN yang salah tiga kali 
berturut-turut, maka kode PIN akan diblokir dan Anda 
harus membuka pemblokiran tersebut dengan kode 
PUK agar kartu SIM dapat digunakan kembali. Jika 
kode ini tidak disertakan bersama kartu SIM, hubungi 
operator kartu SIM smartphone Anda.

Jika smartphone meminta kode kunci, masukkan 
kode tersebut (ditampilkan sebagai *****), lalu tekan 
OK. Kode kunci melindungi smartphone Anda dari 
penggunaan yang tidak sah. Kode awalnya adalah 
12345. Ubah kode, jaga kerahasiaannya dan catat di 
tempat yang aman terpisah dari smartphone. Kode 
kunci dapat terdiri dari 5 hingga 10 digit.

 Catatan: Smartphone Anda 
dilengkapi dengan antena dalam. 
Seperti pada perangkat transmisi radio 
lainnya, jika tidak perlu jangan sentuh 
antena ini saat smartphone aktif. 
Kontak dengan antena akan 
mempengaruhi kualitas panggilan dan 
menyebabkan smartphone beroperasi 
pada level daya yang lebih tinggi 
daripada yang diperlukan. Jangan 
sentuh bagian antena saat 
mengoperasikan smartphone ini agar 

kinerja antena dan masa pakai baterai 
tetap optimal.

Gambar memperlihatkan cara 
menggenggam smartphone yang benar 
saat percakapan telepon berlangsung. 
Bagian antena ditunjukkan dengan 
warna abu-abu.

Mengaktifkan untuk pertama 
kali
Saat Anda mengaktifkan smartphone untuk pertama 
kalinya, Anda akan diminta untuk mengkalibrasi layar 
sentuh dan menetapkan beberapa pengaturan tertentu. 
Berdasarkan jenis kartu SIM yang digunakan, smartphone 
Anda mungkin dapat menambahkan secara otomatis 
pengaturan yang benar untuk browsing Web dan MMS.

Semua pengaturan dapat diubah kapan saja dari aplikasi 
Panel Kontrol atau aplikasi yang sesuai.
1 Saat memulai pengaktifan, smartphone akan 

menjalankan pemeriksaan internal. Setelah 
pemeriksaan internal selesai, Anda kemudian diminta 
untuk mengkalibrasi layar sentuh. Ikuti petunjuk pada 
layar.

2 Jika smartphone meminta kode PIN, masukkan kode 
tersebut (ditampilkan sebagai ****), lalu tekan OK. 
Layar pembuka akan terlihat pada layar.
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3 Agar waktu dan tanggal ditetapkan secara otomatis, 
pilih kotak pilihan Perbaharui otomatis:. Tekan Selesai. 
Jika Anda memilih pilihan P'baharui auto dan layanan 
tersedia, smartphone harus diaktifkan ulang. Jika 
perbaharui otomatis merupakan pilihan standar dan 
layanan tersedia, dialog Pengaturan (lihat langkah 6 di 
bawah) ditampilkan. Ingat, sebagian operator jaringan 
kemungkinan tidak mendukung fitur P'baharui auto.

4 Jika Perbaharui otomatis tidak aktif atau tidak tersedia, 
tentukan kota asal untuk smartphone.

5 Jika Perbaharui otomatis tidak aktif, masukkan tanggal 
dan waktu. Jika Anda tidak ingin melanjutkan 
pengaturan ini, tekan Selesai.

6 Anda dapat mengedit sejumlah pengaturan opsional, 
misalnya pengaturan account e-mail atau data pribadi. 
Pilih pengaturan yang akan diedit dari dalam daftar, 
lalu tekan Buka. Jika Anda tidak ingin mengedit 
pengaturan sekarang juga, tekan Selesai untuk 
mengakhiri pengaturan tersebut.

Menyalin dari kartu SIM ke memori 
smartphone
Jika nama dan nomor telepon sudah disimpan dalam kartu 
SIM, Anda dapat menyalinnya ke memori smartphone.

Untuk mengirim semua kontak, buka aplikasi Kontak, 
tekan , lalu pilih Peralatan > Salin direktori SIM ke 
'Kontak'.... Tekan Salin. Untuk mengirim kontak satu 
per satu, buka aplikasi Kontak, tekan , lalu pilih 
Peralatan > Direktori SIM.... Pilih kontak, kemudian tekan 
Salin ke Kontak.

Elemen tampilan

Gbr. 11 Meja

1 Kolom judul. Menampilkan nama aplikasi dan nama 
grup atau rincian lainnya tentang status aplikasi. 
Tekan untuk mengakses menu atau tekan .

2 Area indikator status. Untuk ikon status, lihat 
“Indikator status” pada halaman 23.
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3 Bar peralatan. Berisi cara pintas untuk aplikasi yang 
sering digunakan atau, dalam sebuah aplikasi, cara 
pintas ke peralatan penting. Pada meja, juga 
menampilkan waktu saat ini. Tekan untuk 
menampilkan tanggal saat ini. Untuk menyembunyikan 
bar peralatan, tekan , lalu pilih Tampilan. Hapus Bar 
peralatan.

4 Tombol gulir. Tekan atau geser untuk menggulir layar.

Smartphone Anda dilengkapi screen saver. Jika tidak 
terdapat aktivitas selama rentang waktu yang telah 
ditentukan, screen saver akan ditampilkan. Untuk 
menonaktifkan screen saver, tekan layar atau tombol apa 
saja. Ingat, Anda tidak dapat mengubah bentuk tampilan 
screen saver. Untuk informasi lebih lanjut, lihat “Tampilan” 
pada halaman 123.

Mencari dan memilih objek
Secara umum ada dua cara untuk mengontrol smartphone 
ini: dengan menekan tombol gulir dan tombol lain pada 
smartphone atau menekan layar dengan menggunakan 
pena stylus yang tersedia. Anda dapat menggabungkan 
kedua metode ini untuk mendapatkan cara yang paling 
sesuai bagi Anda. Untuk menggunakan pena stylus, lihat 
Gbr. “2” pada halaman 13.

Penting: Gunakan hanya pena stylus yang telah 
disetujui oleh Nokia untuk digunakan dengan 
smartphone ini. Penggunaan pena stylus lain 
dapat membatalkan jaminan yang berlaku untuk 
smartphone ini dan mungkin akan merusak layar. 
Hindari goresan pada layar. Jangan gunakan pena 
biasa, pensil atau benda runcing lainnya untuk 
menulis pada layar.

Untuk membuka aplikasi, tekan dua kali ikon aplikasi 
pada Meja, atau gulir ke aplikasi, kemudian tekan 
bagian tengah tombol gulir. Untuk membuka folder, 
file atau lampiran, tekan dua kali, atau gulir, 
kemudian tekan bagian tengah tombol gulir.

Istilah ‘tekan dua kali’ digunakan di sini untuk 
menjelaskan proses penekanan pertama dengan pena 
stylus pada objek adalah untuk memilihnya kemudian 
penekanan sekali lagi untuk membukanya.

Tip: Jika layar sentuh tidak merespon dengan benar, 
Anda mungkin perlu mengkalibrasinya. Gunakan 
tombol gulir untuk membuka aplikasi Panel Kontrol, 
pilih Kalibrasi layar, kemudian ikuti petunjuk 
selanjutnya.

Untuk keluar dari aplikasi dan kembali ke Meja, 
tekan  di kiri layar, atau tekan  di area indikator 
status. Untuk melihat posisi yang tepat, lihat gbr. “11” 
pada halaman 19. Meja merupakan ruang kerja Anda, 
dari sini Anda dapat mengakses semua aplikasi dan 
membuat cara pintas ke beberapa pilihan misalnya 
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dokumen, gambar, atau kartu kontak. Untuk informasi 
lebih lanjut, lihat “Meja” pada halaman 34.

Untuk memilih perintah menu dalam aplikasi, tekan 
, gulir ke perintah kemudian tekan bagian tengah 

tombol gulir untuk memilih perintah. Atau, tekan 
kolom judul (lihat “Elemen tampilan” pada 
halaman 19) pada jendela untuk membuka menu, 
tekan menu, kemudian tekan perintah.

Di sebagian besar aplikasi, beberapa perintah menu 
yang paling penting juga tersedia pada tombol 
perintah di kanan layar.

Tip: Perintah menu dan tombol perintah akan berubah 
sesuai tampilan pada layar. Cari objek atau tekan; 
kemudian pilih perintah menu yang diinginkan atau 
tombol perintah.

Untuk memilih objek satu per satu dalam daftar 
atau file, pilih, tekan , kemudian pilih Edit > 
Ditandai/Tidak ditandai > Ditandai. Kini Anda dapat 
memilih untuk menandai objek lainnya. Tanda centang 
akan muncul di sebelah objek yang dipilih. Untuk 
memilih semua objek dalam daftar, tekan  lalu 
pilih Edit > Ditandai/Tidak ditandai > Ditandai semua. 
Untuk memilih objek secara berurutan, geser pena 
stylus melalui file.

Untuk menampilkan atau menyembunyikan tombol 
perintah atau bar peralatan, tekan , lalu pilih 
Tampilan > Bar perintah atau Bar peralatan. Jika tombol 
perintah tampil dalam warna redup, maka perintah 
tersebut tidak dapat digunakan.

Tombol perintah di sisi kanan, bar peralatan di bagian 
dasar, dan indikator status di sudut kanan atas layar 
akan berubah sesuai aplikasi dan situasi yang aktual.

Untuk mengaktifkan bagian dari dialog, tekan 
bagian yang sesuai. Coba tekan bagian dialog seperti 
kotak teks, bingkai jendela, dan bagian lain dari 
tampilan.

Tip: Jika Anda menulis nomor telepon, alamat e-mail, 
atau alamat web dalam kotak teks atau dokumen, 
Anda dapat menggunakannya sebagai hyperlink. 
Tekan nomor atau alamat, atau letakkan kursor di 
antaranya dengan tombol gulir; sehingga menjadi 
penghubung dengan ikon kecil. Tekan ikon untuk 
memanggil nomor telepon, membuka editor e-mail, 
atau mengunjungi situs web jika Anda memiliki 
sambungan Internet aktif.

Untuk memindahkan objek, tekan dan biarkan pena 
stylus tetap menyentuh layar beberapa saat, kemudian 
pindahkan objek ke lokasi yang baru. Cobalah cara ini 
pada aplikasi Meja.
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Penggunaan dasar smartphone 
Anda

Untuk membuat panggilan, tekan tombol  di 
bagian atas smartphone untuk membuka tampilan 
Penelepon. Anda juga dapat membuka Penelepon 
dengan menekan dua kali aplikasi Telepon pada Meja, 
atau menekan ikon telepon pada bar peralatan, jika 
tersedia. Masukkan nomor telepon dengan 
menggunakan tombol layar pada tampilan Penelepon, 
lalu tekan Panggil. Jika Anda salah memasukkan 
nomor, tekan  untuk menghapus nomor. Mikrofon 
dan lubang suara terdapat di bagian depan 
smartphone (Lihat gbr. “1” pada halaman 12). Untuk 
mengakhiri panggilan, tekan Akhiri, atau tekan .

Untuk menjawab panggilan, tekan Jawab, atau tekan 
 di bagian atas smartphone. Untuk mengetahui 

posisi mikrofon dan lubang suara, lihat gbr. “1” pada 
halaman 12. Untuk menolak panggilan, tekan Tolak, 
atau tekan . Untuk informasi lebih lanjut, lihat 
“Telepon” pada halaman 40.

Untuk menonaktifkan suara smartphone, pilih profil 
Diam. Untuk memilih profil ini, buka aplikasi Profil, 
atau tekan tombol daya  kemudian pilih Diam dari 
daftar.

Untuk menulis teks, tekan kolom atau kotak teks yang 
akan Anda gunakan untuk memasukkan teks. Keyboard 
layar atau jendela pengenal tulisan tangan akan 
ditampilkan. Mulai menulis dengan menekan karakter 

pada keyboard tersebut atau menulis huruf dalam 
kolom input teks. Untuk informasi lebih lanjut, lihat 
“Menulis teks” pada halaman 36.

Untuk mengambil foto atau merekam video, buka 
aplikasi Kamera. Lensa kamera terdapat di bagian 
belakang kamera di atas penutup belakang (lihat gbr. 
“2” pada halaman 13). Untuk beralih antara kamera 
dan modus perekam kamera, tekan gambar yang 
sesuai di bagian kiri layar. Arahkan pada target dengan 
menggunakan tampilan sebagai pembidik gambar; 
tekan bagian tengah tombol gulir, atau tekan Ambil 
untuk mengambil foto. Untuk merekam video, tekan 
Rekam. Foto atau video disimpan pada folder yang 
ditunjukkan di bagian kolom judul. Jika Anda tidak 
ingin menyimpan foto tersebut, tekan Hapus. Untuk 
informasi lebih lanjut, lihat “Gambar” pada 
halaman 87.

Untuk mendengarkan radio, pasang headset yang 
kompatibel ke smartphone. Kabel headset berfungsi 
sebagai antena radio, karena itu biarkan tergantung 
bebas. Buka aplikasi Visual Radio, tekan , lalu pilih 
Peralatan > Pengeras suara yang digunakan > Headset. 
Tekan  untuk mulai mendengarkan radio. Anda 
dapat menggunakan Visual Radio untuk 
mendengarkan siaran radio FM dan siaran khusus 
dengan tampilan visual, jika tersedia. Untuk informasi 
lebih lanjut, lihat “Visual Radio” pada halaman 104.
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Untuk mencari ke semua aplikasi dan file dalam 
smartphone untuk string teks tertentu atau jenis file, 
buka aplikasi Cari, kemudian tekan Cari. Tulis teks 
dalam kolom cari, kemudian tekan Cari. Untuk 
membuat pencarian lebih akurat, tekan Pencarian 
lanjutan, tulis teks dalam kolom cari, tentukan lokasi 
dan rentang waktu pencarian, kemudian tekan OK. 
Tekan objek yang ditemukan untuk membukanya.

Tip: Anda juga dapat mencari string teks di dalam 
aplikasi, jika fungsi ini tersedia sebagai perintah menu. 
Tekan , lalu pilih Edit > Cari....

Untuk membuat folder, buka aplikasi Manajer file. 
Tekan  lalu pilih File > Folder baru.... Beri nama 
untuk folder baru kemudian pilih lokasi. Pada beberapa 
aplikasi Anda dapat membuat folder baru dengan 
terlebih dulu memilih perintah menu Ubah folder di 
dalam menu.

Perintah umum pada beberapa aplikasi
Anda dapat menemukan pilihan berikut di beberapa 
aplikasi:

Untuk menambahkan cara pintas ke suatu pilihan, 
pilih pilihan dalam aplikasi Manajer file atau aplikasi 
lainnya yang menangani file, tekan , lalu pilih 
perintah menu Tambah ke Meja..., jika tersedia. 
Misalnya, pada aplikasi Gambar, pilih Peralatan > 
Tambah ke Meja.... Pilih grup Meja yang akan Anda 
tambahkan cara pintas, kemudian tekan OK.

Untuk mengirim objek, pilih objek, tekan , lalu 
pilih perintah File > Kirim, jika tersedia. Pilih metode 
pengiriman yang sesuai.

Untuk memindahkan (cut and paste) objek, pilih 
objek, tekan , lalu pilih Edit > Potong. Pilih lokasi 
yang akan Anda tambahkan dengan objek, tekan , 
lalu pilih Edit > Tempel.

Untuk menyalin (copy and paste) objek, pilih objek, 
tekan , lalu pilih Edit > Salin. Pilih lokasi yang akan 
Anda tambahkan dengan objek, tekan , lalu pilih 
Edit > Tempel.

Tip: Sejumlah dialog memiliki ikon tanda panah  di 
sudut kiri atas. Tekan ikon untuk memotong atau 
menyalin teks yang dipilih, atau menempelkan teks ke 
kolom yang dipilih.

Untuk menghapus objek, pilih objek, tekan , lalu 
pilih File > Hapus.

Untuk memperbesar atau memperkecil objek 
tampilan, tekan , lalu pilih Tampilan > Perbesar 
atau Perkecil.

Indikator status
Anda dapat membuka aplikasi atau dialog dengan 
menekan beberapa ikon status. Misalnya, tekan  
untuk membuka Kotak masuk dan membaca pesan 
yang diterima. Berikut adalah beberapa ikon status 
yang akan muncul jika menggunakan tema standar:
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 Anda memiliki satu atau beberapa pesan yang belum 
dibaca dalam Kotak masuk.

 Anda menerima satu atau beberapa pesan suara. 
Tekan ikon untuk memanggil kotak suara Anda. Jika Anda 
memiliki dua saluran telepon, angka yang muncul 
menunjukkan saluran telepon yang dipilih.

 Panggilan suara sedang berlangsung. Tekan untuk 
membuka tampilan yang menangani panggilan.

 Mikrofon dalam modus tanpa suara.

 Kontrol volume suara. Tekan selama panggilan untuk 
menampilkan jendela pengaturan volume suara.

 Layar sentuh dan tombol smartphone terkunci. Lihat 
“Kunci tombol dan layar sentuh” pada halaman 27.

 Anda menggunakan profil Diam. Telepon tidak akan 
berdering untuk memberitahu panggilan masuk atau 
pesan kepada Anda. Tekan untuk membuka dialog 
pemilihan profil.

 Jam alarm aktif.

 Semua panggilan Anda dialihkan ke nomor lain. Jika 
Anda memiliki dua saluran telepon, angka yang muncul 
menunjukkan saluran yang menggunakan pengalihan 
panggilan.  menunjukkan bahwa semua panggilan 
dialihkan ke kotak suara. Tekan ikon untuk mengubah 
pengaturan pengalihan panggilan.

 Jika Anda memiliki 2 saluran telepon, angka yang 
muncul menunjukkan saluran telepon yang dipilih. Tekan 
ikon untuk beralih di antara saluran telepon yang tersedia.

 atau  Headset atau loopset terpasang pada 
smartphone.

 Smartphone Anda terhubung ke PC dengan 
menggunakan kabel sambungan.

Level daya baterai
 Daya baterai hampir kosong. Isi daya baterai. 

 Baterai diisi. Saat bar berhenti bergulir dan keempat 
bar ditampilkan, maka baterai telah terisi penuh.

Kekuatan sinyal
 Smartphone dihubungkan ke jaringan nirkabel. Jika 

keempat bar ditampilkan, maka penerimaan sinyal 
nirkabel baik. Jika sinyal lemah, Anda dapat mencoba 
memperbaiki penerimaan dengan memindahkan 
smartphone atau dengan menggunakan modus handsfree.

 Smartphone diaktifkan, namun di luar jangkauan 
jaringan.

 Fungsi telepon pada smartphone ini dinonaktifkan. 
Anda tidak dapat membuat atau menerima panggilan, dan 
Anda juga tidak dapat menerima pesan dengan aplikasi 
komunikasi apapun (SMS, data atau e-mail).
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Indikator sambungan data
 Sambungan Bluetooth. Tekan untuk membuka dialog 

dimana Anda dapat menonaktifkan sambungan Bluetooth. 

 Panggilan data sedang berlangsung. Tekan untuk 
membuka tampilan yang menangani panggilan.

 Panggilan data HSCSD sedang berlangsung. Tekan 
untuk membuka tampilan yang menangani panggilan.

 Sambungan GPRS aktif. Simbol GPRS  ditunjukkan 
saat sambungan GPRS menunggu (ditahan), misalnya, jika 
Anda menerima atau membuat panggilan selama 
sambungan GPRS aktif. Tekan ikon untuk membuka dialog 
Manajer koneksi.
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Informasi umum
Stiker pada paket penjualan 
perangkat
Stiker-stiker di dalam kemasan telepon berisi informasi 
penting tentang masalah yang terkait dengan layanan dan 
dukungan pelanggan. Kemasan telepon juga berisi 
berbagai petunjuk tentang cara menggunakan stiker-stiker 
tersebut.

Kode akses
Penjelasan tentang berbagai kode pengaman yang 
mungkin diperlukan:
• Kode kunci (5 hingga 10 digit): Kode kunci melindungi 

smartphone Anda dari penggunaan yang tidak sah, dan 
disertakan bersama smartphone. Kode awalnya adalah 
12345. Ubah kode, jaga kerahasiaannya dan catat di 
tempat yang aman terpisah dari smartphone Anda.

• Kode PIN dan kode PIN2 (4 hingga 8 digit): Kode PIN 
(Personal Identification Number) melindungi kartu SIM 
Anda dari penggunaan yang tidak sah. Kode PIN 
biasanya disediakan bersama kartu SIM. Jika kode PIN 
yang salah dimasukkan sebanyak tiga kali berturut-
turut, maka kode PIN akan diblokir dan Anda harus 
membuka pemblokiran agar kartu SIM dapat 
digunakan kembali. 

Biasanya kode PIN2 disertakan dengan kartu SIM dan 
diperlukan untuk mengakses sejumlah layanan, seperti 
nomor panggilan tetap.

• Kode PUK dan PUK2 (8 digit): Kode PUK (Personal 
Unblocking Key) diperlukan untuk mengganti kode PIN 
yang terblokir. Kode PUK2 diperlukan untuk mengganti 
kode PIN2 yang terblokir. Jika kode ini tidak disertakan 
bersama kartu SIM, hubungi operator kartu SIM 
smartphone Anda.

• Sandi pembatasan (4 digit): Sandi pembatasan 
diperlukan saat menggunakan layanan Pembatasan 
panggilan. Sandi tersebut dapat diperoleh dari operator 
selular Anda.
Beberapa aplikasi Internet pada smartphone 
menggunakan sandi dan nama pengguna untuk 
perlindungan terhadap penggunaan Internet beserta 
layanannya yang tidak sah. Semua sandi ini dapat 
diubah dalam pengaturan aplikasi Internet.

Manajemen memori
Berbagai fitur pada smartphone akan menggunakan 
memori untuk menyimpan data. Fitur-fitur ini terdiri dari 
video, file musik, permainan, kontak, pesan, gambar dan 
nada dering, kalender dan catatan agenda, dokumen dan 
aplikasi yang di-download. Jumlah memori bebas yang 
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tersedia akan tergantung pada jumlah data yang 
tersimpan dalam memori smartphone.

Anda dapat menggunakan kartu memori sebagai ruang 
penyimpan tambahan. Jika memori smartphone semakin 
sedikit, Anda dapat memindahkan data ke kartu memori. 
Kartu memori bersifat dapat ditulis kembali, sehingga 
Anda dapat berkali-kali menyimpan data pada kartu 
memori, dan menghapus data tersebut bila perlu.

Catatan: Beberapa kartu bersifat hanya dapat dibaca. 
Kartu tersebut berisi data yang telah diinstal 
sebelumnya dan tidak dapat dihapus atau diganti 
dengan data baru. 

Untuk melihat pemakaian memori, buka aplikasi 
Panel Kontrol kemudian pilih Memori. Anda dapat 
melihat jenis data yang Anda miliki dalam memori 
smartphone maupun dalam kartu memori, serta 
kapasitas memori yang dibutuhkan oleh setiap grup 
data.

Membebaskan memori
Menginstal banyak permainan atau menyimpan berbagai 
gambar, file musik atau klip video dapat menghabiskan 
sebagian besar memori yang tersedia. Smartphone akan 
memberikan tanda peringatan jika memori sudah semakin 
rendah. Karena itu, data tambahan tidak dapat disimpan 

sampai Anda menghapus beberapa permainan, gambar, 
atau entri lainnya untuk membebaskan memori. Untuk 
mencegah kekurangan memori, Anda harus menghapus 
atau memindahkan data ke kartu memori secara berkala.

Anda dapat menghapus informasi kontak, catatan 
kalender, permainan, pesan, e-mail, atau data lainnya. 
Buka aplikasi untuk menghapus data yang diinginkan.

Kunci tombol dan layar sentuh
Anda dapat mengunci layar sentuh dan tombol untuk 
mencegah penekanan yang tidak disengaja.

Untuk mengunci layar sentuh dan tombol, tekan 
 kemudian . Saat layar sentuh dan tombol 

terkunci,  akan muncul di bagian indikator status. 
Cara lain untuk mengaktifkan pengaman tombol 
adalah dengan menekan tombol daya  kemudian 
memilih Kunci layar sentuh dan tombol. Untuk 
membuka penguncian, tekan  kemudian .



Hak cipta © 2005 Nokia. Semua hak dilindungi undang-undang.

In
fo

rm
as

i u
m

um

28

Untuk menjawab panggilan saat pengaman tombol 
aktif, tekan . Selama pembicaraan berlangsung, 
telepon dapat dioperasikan seperti biasa. Ketika Anda 
mengakhiri atau menolak panggilan, maka layar 
sentuh dan tombol akan terkunci kembali secara 
otomatis.

Untuk mengaktifkan pengaman tombol otomatis, 
buka aplikasi Panel kontrol kemudian pilih Tampilan. 
Pilih kotak pilihan Kunci tampilan screen saver & tombol:, 
kemudian tekan OK. Layar sentuh dan tombol akan 
terkunci secara otomatis setelah screen saver 
diaktifkan.

Kontrol volume suara
Untuk mengatur tingkat volume suara saat 
panggilan berlangsung, tekan  akan membuka 
pengaturan audio. Tekan  dan , atau tekan  
dan  pada tombol gulir, masing-masing untuk 
memperbesar atau memperkecil tingkat volume suara. 
Anda juga dapat memilih untuk menggunakan fungsi 
pengeras suara atau menghilangkan suara 
smartphone.

Untuk mengatur volume suara saat menggunakan 
headset atau pengeras suara, tekan  dan  pada 
tombol gulir.

PERINGATAN: Dengarkan musik pada volume suara 
yang normal. Mendengarkan musik dengan volume 
suara yang tinggi secara terus-menerus dapat merusak 
pendengaran Anda.

Pengeras suara
Smartphone Anda dilengkapi dengan pengeras suara 
internal untuk penggunaan handsfree (Lihat gbr. 3 pada 
halaman 14). Pengeras suara ini memungkinkan Anda 
berbicara dan mendengarkan ke smartphone dari jarak 
dekat tanpa harus memegang smartphone di dekat 
telinga, misalnya diletakkan di atas meja di dekat Anda. 
Pengeras suara dapat digunakan selama panggilan 
berlangsung, dengan aplikasi suara dan saat melihat 
pesan multimedia.

Untuk mengaktifkan pengeras suara selama 
panggilan berlangsung, tekan . Pengeras suara 
harus diaktifkan tersendiri setiap kali ada panggilan 
telepon, namun aplikasi suara seperti Music player 
selalu menggunakan pengeras suara sesuai standar. 
Untuk menonaktifkan pengeras suara dan kembali 
menggunakan lubang suara, tekan .

PERINGATAN: Jangan dekatkan smartphone ini ke 
telinga Anda selama menggunakan pengeras suara, 
karena volume suara yang keluar mungkin terlalu 
keras.
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Headset
Anda dapat mendengarkan radio dan music player dari 
smartphone dengan menggunakan headset HS-3 yang 
tersedia.

Untuk menghubungkan headset ke smartphone, 
masukkan ujung kabel headset ke konektor Pop-Port™ 
di bagian bawah smartphone. (Lihat gbr. 2 pada 
halaman 13). Kabel headset berfungsi sebagai antena 
radio, karena itu biarkan tergantung bebas.

Untuk menjawab panggilan saat menggunakan 
headset, tekan tombol remote control yang berada di 
bagian mikrofon headset. Untuk mengakhiri panggilan, 
tekan kembali tombol yang sama.

PERINGATAN: Bila menggunakan headset stereo, 
kemampuan Anda untuk mendengar suara di sekitar 
mungkin akan terpengaruh. Jangan gunakan headset 
stereo ini jika dapat membahayakan keselamatan 
Anda.

Menginstal aplikasi dan 
perangkat lunak
Anda dapat menginstal dua jenis aplikasi dan perangkat 
lunak pada smartphone:
• Aplikasi dan perangkat lunak yang dibuat khusus untuk 

Nokia 7710 atau kompatibel dengan sistem 
pengoperasian Symbian. File penginstalan ini memiliki 

ekstensi .SIS. Lihat “Menginstal perangkat lunak” pada 
halaman 29.

• Aplikasi Java J2Micro Edition™ yang kompatibel 
dengan sistem pengoperasian Symbian. File-file ini 
memiliki ekstensi .JAD atau .JAR. Jangan download 
aplikasi PersonalJava™ ke smartphone Anda, karena 
aplikasi tersebut tidak dapat diinstal. Lihat 
“Menginstal aplikasi Java™” pada halaman 30.

File penginstalan dapat dikirim ke smartphone Anda dari 
komputer yang kompatibel, di-download dari Internet 
atau dikirim dalam pesan multimedia, sebagai lampiran 
e-mail, atau melalui Bluetooth.

Penting: Lakukan penginstalan aplikasi hanya 
dari sumber yang menawarkan perlindungan 
memadai terhadap gangguan perangkat lunak.

Saat penginstalan berlangsung, smartphone ini akan 
memeriksa kelengkapan paket yang diinstal. Smartphone 
akan menampilkan informasi tentang pemeriksaan yang 
sedang berlangsung dan Anda diberi pilihan untuk 
melanjutkan atau membatalkan penginstalan tersebut.

Untuk informasi tentang tanda tangan digital dan 
sertifikat, lihat “Manajer sertifikat” pada halaman 121.

Menginstal perangkat lunak
Jika Anda menginstal file yang berisi pembaruan atau 
perbaikan aplikasi yang ada, maka aplikasi yang asli hanya 
dapat diaktifkan kembali jika Anda memiliki file 
penginstalan yang asli atau salinan lengkap dari paket 



Hak cipta © 2005 Nokia. Semua hak dilindungi undang-undang.

In
fo

rm
as

i u
m

um

30

perangkat lunak yang sudah dihapus tersebut. Untuk 
mengaktifkan kembali aplikasi yang asli, hapus terlebih 
dahulu aplikasi tersebut, kemudian instal ulang dari file 
penginstalan yang asli atau dari salinan pendukung.

Untuk menginstal perangkat lunak, cari file 
penginstalan pada memori smartphone atau kartu 
memori, pilih file tersebut kemudian tekan dua kali 
untuk memulai penginstalan. Misalnya, jika Anda 
menerima file penginstalan sebagai lampiran e-mail, 
buka kotak surat, buka e-mail, tekan dua kali file 
penginstalan untuk memulai penginstalan.

Untuk menghapus perangkat lunak, lihat “Manajer 
aplikasi” pada halaman 119.

Tip: Untuk informasi lebih lanjut tentang penginstalan 
perangkat lunak, lihat “Manajer aplikasi” pada 
halaman 119.

Menginstal aplikasi Java™ 
1 Cari file penginstalan pada memori smartphone atau 

kartu memori, pilih file kemudian tekan dua kali untuk 
memulai penginstalan. Misalnya, jika Anda menerima 
file penginstalan sebagai lampiran e-mail, buka kotak 
surat, buka e-mail, tekan dua kali file penginstalan 
untuk memulai penginstalan.

2 Konfirmasikan penginstalan. File .JAR diperlukan untuk 
penginstalan. Jika file tersebut tidak ada, maka 
smartphone akan meminta Anda untuk men-
download-nya. Jika tidak ada jalur akses yang sudah 

ditetapkan, Anda akan diminta untuk memilihnya. 
Untuk men-download file .JAR, Anda harus 
memasukkan nama pengguna dan sandi untuk 
mengakses server. Keduanya diperoleh dari penyedia 
atau produsen aplikasi tersebut. Smartphone ini akan 
memberitahukan Anda bila proses penginstalan 
selesai.
Tip: Saat mengakses Internet, Anda dapat 
men-download file penginstalan dan segera 
menginstalnya. Namun ingat, sambungan akan tetap 
aktif di latar belakang selama penginstalan 
berlangsung.

Pengiriman data
Smartphone ini memiliki kemampuan pengiriman data 
melalui jaringan GSM untuk mengirim pesan multimedia, 
pesan singkat dan e-mail serta untuk membuat 
sambungan dengan komputer remote.

Sambungan data nirkabel dapat dibuat dari berbagai 
posisi di sekitar smartphone Anda beroperasi. Namun 
demikian, sebaiknya pindahkan smartphone ke posisi yang 
dapat memperoleh sinyal selular paling kuat. Jika sinyal 
kuat, maka pengiriman data akan berlangsung efisien. 
Secara umum, Anda tidak dapat mengharapkan kinerja 
yang sama antara komunikasi data nirkabel dan 
komunikasi data melalui kabel, karena karakteristik yang 
melekat pada lingkungan nirkabel.
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Faktor-faktor berikut dapat memperburuk sambungan 
nirkabel dalam bentuk noise, sinyal yang lemah atau 
terputus, kesalahan fungsi pada smartphone, atau 
tampilan yang terdistorsi:

Noise – Gangguan radio yang dihasilkan dari perangkat 
atau peralatan elektronik, atau dari telepon lain akan 
mempengaruhi kualitas pengiriman data nirkabel.

Roaming – Karena pengguna smartphone bergerak dari 
jaringan selular yang satu ke jaringan selular lainnya, 
kekuatan sinyal saluran akan menurun dan pengalihan 
telepon selular memungkinkan penggunaan jaringan 
selular dan frekuensi yang berbeda yang sinyalnya lebih 
kuat. Peralihan jaringan selular juga terjadi meskipun 
pengguna tidak berpindah tempat, ini disebabkan beban 
lalu lintas jaringan yang berubah-ubah. Peralihan seperti 
ini dapat memperlambat pengiriman data. 

Pelepasan listrik statis – Pelepasan muatan elektrostatis 
oleh jari atau konduktor dapat menimbulkan kesalahan 
fungsi pada perangkat listrik. Pelepasan muatan ini dapat 
menimbulkan gangguan pada layar dan ketidakstabilan 
pengoperasian perangkat lunak. Sambungan nirkabel 
dapat menjadi tidak stabil, pengiriman data tidak lengkap 
dan terhenti sama sekali. Untuk mengatasinya, Anda harus 
mengakhiri panggilan yang sedang berlangsung (jika ada), 
menonaktifkan smartphone ini (jika aktif) dan melepas 
baterai. Kemudian pasang kembali baterai dan aktifkan 
sambungan nirkabel yang baru.

Dead spot dan dropout – Dead spot adalah area dimana 
sinyal radio tidak dapat diterima. Penurunan (dropout) 

akan terjadi bila pengguna smartphone ini melewati 
wilayah dengan sinyal radio yang terhalang atau 
berkurang disebabkan oleh kondisi geografis atau 
gedung-gedung tinggi.

Gangguan sinyal – Jarak dan hambatan dapat 
menyebabkan sinyal terganggu. Juga dapat menyebabkan 
sinyal dipantulkan kembali. Kedua situasi tersebut akan 
mengakibatkan hilangnya kekuatan sinyal.

Kekuatan sinyal lemah – Karena jarak atau hambatan, 
kekuatan sinyal radio dari jaringan selular tidak cukup 
kuat atau stabil untuk memberikan sambungan data yang 
dapat diandalkan dalam komunikasi. Karena itu, untuk 
memastikan tersedianya komunikasi terbaik yang paling 
mungkin, pertimbangkan beberapa masalah berikut:
• Sambungan data akan menghasilkan kinerja terbaik 

jika smartphone dalam posisi diam. Tidak dianjurkan 
melakukan komunikasi nirkabel di dalam kendaraan 
yang sedang bergerak.

• Jangan letakkan smartphone ini di atas permukaan 
logam.

• Periksa apakah kekuatan sinyal pada layar smartphone 
ini memadai. Membawa smartphone ini ke sisi lain 
dalam ruangan, terutama ke arah jendela, akan 
menghasilkan sinyal penerimaan yang lebih kuat. Jika 
sinyal selular tidak cukup kuat untuk mendukung 
panggilan suara, maka sambungan data tidak dapat 
dibuat sampai Anda menemukan tempat yang dapat 
menerima sinyal lebih baik.
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Sambungan data

Pangilan data GSMs
Panggilan data GSM memungkinkan kecepatan transmisi 
data hingga 14,4 Kbps. Untuk ketersediaan dan 
berlangganan layanan data, hubungi operator jaringan 
atau operator selular Anda.

Panggilan data berkecepatan tinggi 
(High Speed Circuit Switched Data: 
HSCSD)
HSCSD memungkinkan pengiriman data berkecepatan 
hingga 43,2 Kbps, yaitu empat kali lebih cepat 
dibandingkan kecepatan data standar melalui jaringan 
GSM. HSCSD dapat dibandingkan dengan kecepatan 
modem biasa untuk komunikasi melalui jaringan telepon 
tetap.

Untuk ketersediaan dan berlangganan layanan data 
berkecepatan tinggi, hubungi operator jaringan atau 
operator selular Anda.

Catatan: Mengirim data dalam modus HSCSD 
mungkin akan menghabiskan baterai smartphone 
lebih cepat daripada panggilan suara biasa atau data, 
karena smartphone dapat mengirim data lebih sering 
ke jaringan.

Data paket (General Packet Radio 
Service: GPRS)
GPRS memungkinkan akses tanpa kabel dari telepon 
selular ke jaringan data (layanan jaringan). GPRS 
menggunakan teknologi data paket yang akan 
mengirimkan informasi dalam pengiriman singkat data 
melalui jaringan selular. Manfaat pengiriman data dalam 
paket-paket ini adalah jaringan hanya digunakan saat 
mengirim atau menerima data. Karena GPRS 
menggunakan jaringan secara efisien, maka sambungan 
data dapat dilakukan secara cepat dan memiliki kecepatan 
pengiriman data yang tinggi.

Anda harus berlangganan layanan GPRS. Untuk 
ketersediaan dan berlangganan layanan GPRS, hubungi 
operator jaringan atau operator selular Anda.

(E)GPRS (Enhanced GPRS) mirip dengan GPRS, namun 
kecepatan sambungannya lebih cepat. Untuk informasi 
tentang ketersediaan (E)GPRS dan kecepatan pengiriman 
data, hubungi operator jaringan atau operator selular 
Anda. Ingat, bila Anda memilih GPRS sebagai media 
pengiriman data, maka smartphone akan menggunakan 
(E)GPRS (bukan GPRS) jika pilihan ini tersedia pada 
jaringan.



Hak cipta © 2005 Nokia. Semua hak dilindungi undang-undang.

In
fo

rm
as

i u
m

um

33

Tarif layanan GPRS dan aplikasinya
Pengiriman data apapun melalui GPRS dan (E)GPRS akan 
dikenai biaya pengiriman sesuai tarif operator. Untuk 
informasi lebih lanjut tentang tarif sambungan, hubungi 
operator jaringan atau operator selular Anda.

Jalur akses
Sambungan data menghubungkan smartphone Anda ke 
Internet melalui jalur akses. Smartphone Anda mendukung 
3 jenis sambungan data:
• panggilan data GSM ( ) 
• panggilan data berkecepatan tinggi GSM, atau HSCSD 

( )
• sambungan data paket (GPRS) ( )

Anda harus menetapkan pengaturan jalur akses, jika Anda 
ingin, misalnya, mengirim dan menerima pesan 
multimedia atau e-mail, mengunjungi situs web, 
men-download aplikasi Java™, atau menggunakan 
smartphone ini sebagai modem.

Hubungi operator selular Anda untuk informasi jenis jalur 
akses yang diperlukan oleh layanan yang akan Anda akses. 
Untuk ketersediaan dan berlangganan panggilan data 
GSM, panggilan data berkecepatan tinggi GSM dan 
layanan sambungan GPRS, hubungi operator jaringan atau 
operator selular Anda.
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Meja
Tekan , atau tekan  pada baris status untuk 
membuka Meja. 

Tip: Jika Anda menekan terus tombol ini, maka daftar 
aplikasi yang terakhir kali digunakan akan terbuka dan 
Anda dapat memilih salah satu di antaranya.

Meja merupakan ruang kerja Anda, dari sini Anda dapat 
mengakses semua aplikasi dan membuat cara pintas ke 
beberapa pilihan misalnya dokumen, gambar, aplikasi atau 
kartu kontak.

Jika Anda mengakhiri aplikasi dengan menekan  dan 
beralih ke aplikasi lain, maka smartphone akan menyimpan 
data Anda secara otomatis.

Gbr. 12: Meja

Untuk membuka aplikasi, tekan dua kali pada ikon 
aplikasi. Tekan dan geser tombol gulir di kanan layar 
untuk bergerak ke atas dan ke bawah sepanjang layar.

Untuk menghapus aplikasi, buka Panel kontrol > 
Manajer Aplikasi, pilih paket perangkat lunak yang 
akan dihapus kemudian tekan Hapus. Pada layar akan 
muncul sebuah dialog yang meminta konfirmasi Anda. 
Tekan Hapus.

Untuk menambahkan cara pintas ke pilihan yang 
diinginkan, buka aplikasi yang berisi pilihan yang akan 
Anda tambahkan pada Meja, kemudian pilih pilihan 
tersebut. Tekan , lalu cari perintah menu Tambah ke 
Meja.... Misalnya, pada aplikasi Gambar, pilih Peralatan 
> Tambah ke Meja.... Pilih grup Meja yang akan Anda 
tambahkan cara pintas, kemudian tekan OK.

Untuk menghapus cara pintas atau ikon aplikasi, 
pilih ikon, tekan , lalu pilih Edit > Hapus. Ingat, ikon 
aplikasi tidak dapat dihapus dari grup Semua.

Untuk mengubah susunan ikon, tekan terus dengan 
menggunakan pena stylus pada ikon yang dipilih 
selama beberapa detik kemudian geser ikon ke posisi 
yang baru pada layar.

Untuk memperbesar atau memperkecil ukuran ikon, 
tekan  atau tekan , lalu pilih Tampilan > Perbesar 
atau Perkecil.
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Untuk menambahkan gambar latar belakang, tekan 
, lalu pilih Tampilan > Tetapkan gbr. latar belakang.... 

Pilih gambar, kemudian tekan Sisipkan. Untuk 
personalisasi tampilan lebih lanjut, lihat “Tema” pada 
halaman 133.

Mengelola grup
Anda dapat membagi aplikasi dan cara pintas yang akan 
ditampilkan dalam Meja menjadi beberapa grup terpisah. 
Pemisahan grup yang berbeda akan memudahkan Anda 
dalam mengelola sejumlah aplikasi dan cara pintas. Anda 
dapat memiliki aplikasi atau cara pintas yang sama dalam 
beberapa grup.

Untuk membuat grup baru, tekan , pilih Grup > 
Baru..., kemudian tentukan nama grup yang baru.

Untuk beralih di antara beberapa grup yang 
berbeda, tekan , pilih Lihat grup, kemudian pilih 
grup.

Untuk menambahkan aplikasi atau cara pintas yang 
dipilih ke dalam sebuah grup, tekan , pilih Grup > 
Tambah ke grup..., lalu pilih grup yang akan Anda 
tambahkan dengan aplikasi atau cara pintas.

Untuk menambahkan atau menghapus pilihan 
dalam sebuah grup, tekan , lalu pilih Grup > Edit.... 
Ingat, pilihan ini tidak akan tersedia untuk grup Semua. 
Pilih aplikasi atau cara pintas dari daftar di sisi kiri 

untuk menambahkannya ke dalam grup. Tekan 
Tambah. Untuk menghapus aplikasi atau cara pintas, 
pilih dari daftar di sisi kanan, kemudian tekan Hapus.

Untuk mengubah nama grup, tekan , pilih Grup > 
Atur grup.... Pilih grup yang namanya akan Anda ubah, 
lalu tekan Ubah nama.

Untuk menghapus grup, tekan , pilih Grup > Atur 
grup.... Pilih grup yang akan Anda hapus, lalu tekan 
Hapus. Anda tidak dapat mengubah atau menghapus 
grup Semua.

Siaga aktif
Untuk membuka tampilan siaga aktif, tekan , atau 
sentuh  dalam Meja.

Tampilan ini berisi empat ikon aplikasi yang dapat Anda 
ubah, yakni baris status standar, indikator profil, tanggal, 
dan waktu.

Untuk mengubah foto latar belakang, tekan , 
lalu pilih Tampilan > Tetapkn sbg foto latar belakang.... 
Pilih foto, kemudian tekan Tetapkan.

Untuk memilih aplikasi bagi siaga aktif, tekan , 
lalu pilih Peralatan > Pengaturan. Tekan , lalu pilih 
masing-masing aplikasi dari daftar.
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Menulis teks
Tersedia dua pilihan untuk memasukkan huruf, angka, dan 
karakter khusus. Pengenal tulisan tangan memungkinkan 
Anda menulis karakter secara langsung pada layar dengan 
menggunakan pena stylus. Anda juga dapat menggunakan 
keyboard layar untuk memilih karakter yang akan 
dimasukkan.

Metode input lainnya mungkin akan tersedia dari penyedia 
aplikasi. Smartphone ini dapat menggunakan aplikasi 
metode input tersebut hanya jika sudah diinstal ke memori 
smartphone. Jika diinstal ke kartu memori, smartphone 
tidak akan mendukung aplikasi tersebut.

Untuk menulis teks, tekan pada bidang layar untuk 
menulis teks Anda. Jendela pengenal tulisan tangan 
atau keyboard layar akan ditampilkan. Untuk beralih 
dari pengenal tulisan tangan ke keyboard layar, 
tekan . Untuk beralih ke pengenal tulisan tangan, 
tekan . Mulai menulis.

Penting: Gunakan hanya pena stylus yang telah 
disetujui oleh Nokia untuk digunakan dengan 
smartphone ini. Penggunaan pena stylus lainnya 
dapat membatalkan jaminan yang berlaku untuk 
smartphone ini serta dapat merusak layar sentuh. 
Hindari goresan pada layar. Jangan gunakan pena 
biasa, pensil atau benda tajam lainnya untuk 
menulis pada layar sentuh.

Untuk memindahkan jendela input, tekan dan geser 
.

Untuk menyembunyikan jendela input, tekan .

Untuk mengganti bahasa input, tekan  kemudian 
pilih bahasa dalam daftar.

Pengenal tulisan tangan
Tip: Tekan  pada jendela penulisan tangan untuk 
membuka fungsi bantuan. Layar bantuan akan 
memberikan informasi rinci tentang cara memasukkan 
karakter dan berisi tips penting lainnya.

Gbr. 13 Jendela pengenal tulisan tangan
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Untuk menggunakan pengenal tulisan tangan, tulis 
karakter di jendela tulisan tangan satu per satu dengan 
menggunakan pena stylus.

Tip: Ingat, bidang pada jendela yang Anda tulisi akan 
mempengaruhi pengenalan. Gunakan garis pangkal 
untuk acuan tulisan tangan Anda. 

Untuk beralih antara penulisan huruf besar 
otomatis, huruf besar dan huruf kecil, tekan . 
Untuk penulisan huruf awal sebuah kata, Anda dapat 
memilih antara huruf besar dan huruf kecil. Di 
tengah-tengah kata, Anda dapat memilih antara huruf 
besar dan huruf kecil. Seluruh kalimat setelah tanda ! 
? ¿ ¡ dan . akan ditulis dalam huruf besar secara 
otomatis, kecuali Anda telah menonaktifkan pilihan ini 
pada pengaturan Input Pena Panel Kontrol. 

Ingat, penulisan huruf tergantung pada modus alfabet 
yang dipilih, bukan dari cara Anda menuliskan huruf pada 
layar. Anda dapat menulis huruf besar untuk menghasilkan 
huruf kecil jika sistem lebih mudah mengenali penulisan 
huruf besar. Ingat, Anda juga tidak dapat memilih modus 
AB di awal kata huruf besar otomatis.

Tip: Lihat “Pengaturan input pena” pada halaman 38 
untuk pengaturan huruf besar otomatis lebih lanjut.

Untuk menulis angka, karakter khusus atau tanda 
tulisan tangan, tekan  untuk angka dan  untuk 

karakter khusus. Lihat gambar 14 tentang cara 
memasukkan spasi, menghapus spasi, dll.

Gbr. 14 Gerakan tulisan tangan: 1 - spasi, 2 - hapus spasi, 
3 - baris baru, 4 - tab

Untuk menghapus teks, pilih teks dengan 
menggerakkan pena stylus pada teks. Gambar tanda 
spasi mundur. Lihat gbr. 14.

Untuk membiasakan sistem dengan gaya menulis 
Anda, pilih aplikasi Panel kontrol dan P'aturan input 
pena, kemudian tekan Latihan. Tekan dua kali pada 
unit karakter (huruf besar atau huruf kecil, angka, atau 
karakter khusus) dan pilih setiap karakter untuk dilatih. 
Tekan Melatih. Gambarkan setiap karakter dengan 
cara Anda sendiri kemudian tekan OK. Untuk 
mengubah gaya menulis Anda yang sudah terekam 
oleh sistem, buka kembali dialog Gambar karakter, 
lalu tekan Hapus untuk menghapus gaya yang sudah 
ada. Gambarkan karakter yang baru kemudian tekan 
OK.

Latihlah hanya karakter-karakter yang sulit dikenali oleh 
sistem. Jika Anda mencoba melatih sisem untuk 
mengenali semua karakter, maka smartphone Anda dapat 
menjadi kekurangan memori.
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Keyboard layar
Untuk menggunakan keyboard layar, tekan tombol 
keyboard dengan menggunakan pena stylus.

Gbr. 15 Keyboard layar

1 Tampilan input. Menampilkan karakter yang sedang 
Anda tulis.

2 Backspace (Hapus spasi). Menghapus karakter di kiri 
kursor.

3 Enter (Baris baru). Memulai baris kalimat baru atau 
menambahkan baris baru.

4 Tombol tab. Menambahkan spasi tab atau 
menggerakkan kursor ke baris berikutnya.

5 Caps lock. Mengaktifkan modus huruf besar.
6 Shift (Tombol atas). Memasukkan huruf besar saat 

Anda menulis dalam modus huruf kecil.

7 Space (Spasi). Memasukkan spasi.
Untuk beralih antara huruf besar dan huruf kecil , 
tekan . Untuk mengaktifkan caps lock (huruf 
besar), tekan . Seluruh kalimat setelah tanda ! ? ¿ 
¡. akan ditulis dalam huruf besar secara otomatis, 
kecuali jika Anda telah menonaktifkan pilihan ini pada 
pengaturan Input Pena Panel Kontrol.

Untuk menulis angka atau karakter khusus, tekan 
. Tekan  untuk melihat karakter khusus lainnya.

Tip: Untuk menulis huruf beraksen, jika keyboard 
memiliki tombol dengan hanya aksen di dalamnya, 
pertama-tama tekan aksen kemudian huruf. Untuk 
memilih huruf beraksen, Anda juga dapat menekan , 
jika tersedia. 

Untuk menghapus teks, pilih teks dengan 
menggerakkan pena stylus pada teks. Tekan ikon 
hapus spasi.

Pengaturan input pena
Untuk mengkonfigurasi pengaturan input pena, 
pilih Panel kontrol > P'aturan input pena. Tetapkan 
berikut ini:

Bahasa input: – Pengaturan ini menetapkan bahasa-
karakter khusus, pada tulisan tangan Anda yang akan 
dikenali dan tata letak tombol keyboard layar Anda 
ditampilkan. 
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Pengenalan karakter: – Mengatur kecepatan tulisan 
tangan yang akan dikenali.

Lebar garis: – Mengubah ketebalan penekanan pena 
stylus.

Ukuran papan tombol: – Pilih ukuran keyboard virtual.

Metode input: – Secara standar, smartphone Anda 
memiliki dua metode penulisan teks: keyboard layar 
dan pengenalan tulisan tangan. Anda tidak 
memerlukan pengaturan ini kecuali metode input 
tambahan yang diinstal pada smartphone.

Huruf besar: — Untuk menulis kata dalam huruf besar 
setelah karakter . ! ? ¿ ¡ dengan spasi, pilih Setelah '.', 
'?' atau '!' dengan spasi. Untuk menulis kata dalam huruf 
besar tanpa spasi, pilih Setelah '.', '?' atau '!' . Untuk 
menonaktifkan penulisan huruf besar pilih Tidak.

Tip: Gunakan pengaturan Setelah '.', '?' atau '!' pada 
pesan teks untuk menampilkan lebih banyak teks.
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Telepon
Buka Meja > Telepon.

Mikrofon dan lubang suara terdapat di bagian depan 
smartphone (Lihat gbr. “1” pada halaman 12).

Memanggil
Untuk membuat panggilan dengan menggunakan 
tombol angka, buka aplikasi Telepon, masukkan nomor 
dengan menekan tombol, lalu tekan Panggil. Untuk 
menghapus nomor, tekan . Untuk beralih antara 
tampilan, tekan .

Untuk mengubah orientasi tampilan penelpon atau 
panggilan cepat, tekan , lalu pilih Tampilan > 
Modus lansekap/Modus potret. 

Tip: Anda juga dapat menekan  untuk mengubah 
orientasi.

Untuk panggilan internasional, tambahkan kode awal 
internasional + (tekan dua kali * lalu pilih + dari daftar 
popup) kemudian masukkan kode negara, kode area dan 
nomor telepon.

Jika kartu SIM dikeluarkan atau rusak, Anda hanya dapat 
membuat panggilan darurat. Beberapa jaringan mungkin 
akan meminta kartu SIM yang berlaku dimasukkan dengan 
benar ke dalam smartphone ini untuk membuat panggilan.

Jika panggilan darurat tidak mungkin dibuat dalam cara 
biasa, Anda dapat memasukkan nomor darurat yang sudah 
diprogram di smartphone ini dalam kolom permintaan 
kode, kemudian tekan Panggil.

Untuk membuat panggilan keluar dalam direktori 
Anda:

• Dalam modus lansekap, tekan Kontak di jendela 
penelpon, pilih kontak dalam direktori, kemudian tekan 
Panggil. Jika kontak memiliki lebih dari satu nomor 
telepon, daftar akan menampilkan semua nomor 
telepon kontak. Pilih nomor dari daftar, kemudian 
tekan OK.

• Dalam modus potret, tulis nama kontak pada kolom 
input. Bila Anda melihat kontak yang cocok pada daftar 
di bagian atas kolom input, tekan kontak tersebut 
tersebut, kemudian Panggil. Jika kontak memiliki lebih 
dari satu nomor telepon, maka nomor telepon akan 
terdaftar sebagai kontak lain. Untuk beralih antara 
huruf dan angka, tekan terus tombol #.
Tip: Anda dapat menggunakan nomor telepon dalam 
kotak teks atau dokumen sebagai penghubung. Tekan 
nomor, atau letakkan kursor di antaranya dengan 
tombol gulir; sehingga menjadi penghubung dengan 
ikon kecil. Tekan ikon tersebut untuk memanggil 
nomor telepon.
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Untuk menambahkan nomor dari kolom nomor ke 
Kontak Anda, tekan Tambah ke Kontak, pilih kontak 
atau buat kontak baru, kemudian isi informasi kontak. 
Untuk informasi lebih lanjut, lihat “Kontak” pada 
halaman 68.

Untuk memanggil nomor dari daftar panggilan 
terakhir, tekan Panggilan terakhir pada jendela 
Penelepon. Pilih nomor dari salah satu daftar, 
kemudian tekan Panggil. Untuk menambahkan 
nomor ke Kontak Anda, pilih nomor kemudian tekan 
Tambah ke Kontak.

Untuk menggunakan sambungan cepat, tekan , 
pilih Lihat > Sambungan cepat kemudian tekan nama 
atau nomor yang akan Anda panggil. Sambungan 
cepat adalah cara cepat untuk memanggil nomor-
nomor telepon yang sering digunakan.

Gbr. 16: Sambungan cepat

Untuk menambahkan nomor sambungan cepat, 
buka tampilan sambungan cepat (tekan , pilih 
Lihat > Sambungan cepat). Pilih nomor sambungan 
cepat yang kosong, kemudian tekan Tentukan pada 
dialog yang ditampilkan. Pilih kontak untuk nomor 
yang akan ditetapkan sebagai nomor sambungan 
cepat, lalu tekan Pilih. Jika terdapat beberapa nomor 
telepon, pilih salah satu, kemudian tekan OK.

Untuk beralih antara tampilan Penelepon dan 
Sambungan cepat, tekan .

Untuk memanggil kotak suara Anda, hubungi 
operator jaringan Anda untuk mengetahui nomor 
kotak suara Anda (layanan jaringan). Pada tampilan 
Sambungan cepat, angka 1 menyatakan panggilan ke 
kotak suara standar Anda. Untuk informasi lebih 
lanjut, lihat “Pengaturan kotak suara” pada 
halaman 45.

Untuk mengatur tingkat suara selama panggilan, 
tekan Pengaturan audio. Geser tombol untuk 
mengatur tingkat suara. Pilih Pengeras suara: untuk 
menggunakan speaker handsfree dan mikrofon atau 
Tidak bersuara: untuk menghilangkan suara mikrofon.

Tip: Saat panggilan berlangsung, tekan  untuk 
membuka pengaturan audio. Tekan  dan , atau 
tekan  dan  pada tombol gulir, masing-masing 
untuk memperbesar atau memperkecil tingkat volume 
suara. 
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Untuk membuat panggilan baru selama panggilan 
berlangsung, tekan Panggilan baru. Untuk beralih di 
antara panggilan, tekan Aktifkan atau Tahan. Untuk 
menghubungkan kedua penelepon lain dan Anda 
sendiri keluar dari panggilan tersebut, tekan , 
pilih Pilihan > Transfer. Untuk berbicara kepada kedua 
penelepon secara bersamaan, tekan Konferensi. 
Panggilan konferensi dapat menggabungkan hingga 5 
orang penelepon. Selama panggilan konferensi 
berlangsung, tekan Pilihan konferensi untuk 
mengeluarkan salah satu penelepon atau berbicara 
kepadanya secara pribadi. Panggilan konferensi dan 
transfer panggilan adalah layanan jaringan.

Tip: Untuk informasi tentang memonitor panggilan 
yang diterima, panggilan keluar, lamanya masing-
masing panggilan, lihat “Log” pada halaman 150.

Menjawab
Untuk menjawab panggilan, tekan Jawab atau tekan 

. Untuk menolak panggilan, tekan Tolak atau 
tekan . Untuk mengakhiri panggilan tekan . 
Untuk menghentikan nada dering, tekan Diam. 
Untuk menghilangkan suara nada dering dan 
menjawab dengan pesan standar, lihat “Pengaturan 
lain” pada halaman 45.

Panggilan dengan suara
Anda dapat membuat panggilan telepon dengan 
menyebut tag suara yang sudah ditambahkan ke kartu 
kontak. Kata apa saja dapat dijadikan tag suara. 

Sebelum menggunakan tag suara, ingat bahwa:
• Tag suara tidak tergantung pada bahasa. Tag suara 

tergantung pada suara pembicara.
• Anda harus menyebutkan nama persis seperti saat 

merekamnya. 
• Saat merekam dan menyebutkan tag suara, ucapkan 

dengan suara keras. Jika Anda mengucapkan dengan 
suara terlalu pelan, sistem mungkin tidak mengenali 
tag suara Anda dengan benar.

• Tag suara sensitif terhadap suara di sekitarnya. Rekam 
suara dan gunakanlah di tempat yang tenang.

• Nama yang terlalu pendek tidak diterima. Gunakan 
nama yang panjang dan jangan gunakan nama yang 
mirip untuk nomor-nomor telepon lainnya.
 Catatan: Menggunakan tag suara mungkin sulit 
dilakukan pada lingkungan yang ramai atau dalam 
keadaan darurat. Sebaiknya dalam segala situasi, Anda 
jangan tergantung hanya pada fasilitas panggilan 
suara ini.

Untuk menambahkan tag suara, lihat “Tag suara” 
pada halaman 70.
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Untuk menggunakan panggilan dengan suara, tekan 
terus  atau tombol headset sampai Anda 
mendengar nada tanda mulai atau melihat pesan pada 
layar. Ucapkan tag suara untuk nomor yang akan Anda 
panggil. Untuk mencoba kembali jika tag suara tidak 
dikenali, tekan terus tombol  selama beberapa 
detik. Untuk kembali ke panggilan secara normal, 
tekan sebentar tombol  atau tombol headset, 
kemudian tekan tombol ESC. 

Pengaturan telepon

Pengalihan panggilan (layanan 
jaringan)
Pengalihan panggilan memungkinkan Anda mengarahkan 
panggilan suara yang masuk ke nomor telepon lain. 
Pengalihan panggilan juga sering disebut sebagai 
penerusan panggilan.
1 Tekan , lalu pilih Peralatan > Pengaturan > 

Pengalihan panggilan.... Dialog ditampilkan.
2 Buka halaman Panggilan suara.
3 Tetapkan berikut ini:

Alihkan semua panggilan: – Jika diaktifkan, semua 
panggilan masuk akan dialihkan.

Alihkan bila sibuk: – Jika diaktifkan, panggilan masuk 
akan dialihkan ketika Anda sedang menelepon.
Alihkan bila tidak dijawab: – Jika diaktifkan, panggilan 
masuk akan dialihkan jika Anda tidak menjawabnya 
dalam jangka waktu tertentu.
Alihkan bila di luar jangkauan: – Jika diaktifkan, 
panggilan masuk akan dialihkan saat smartphone ini 
tidak aktif atau berada di luar jangkauan layanan 
jaringan.
Alihkan bila penerima tidak ada: – Dengan sekali tekan, 
pilihan ini akan mengaktifkan Alihkan bila sibuk:, Alihkan 
bila di luar jangkauan: dan Alihkan bila tidak dijawab:.
Pilihan yang tersedia adalah:
Aktifkan – Menampilkan dialog untuk memasukkan 
nomor yang panggilannya akan dialihkan dan – jika 
ada – pilih batas waktu setelah panggilan dialihkan, 
jika tidak dijawab. Tekan  untuk memilih nomor 
kotak suara Anda atau nomor standar lainnya, jika ada. 
Tekan Pilih kontak untuk mencari nomor telepon di 
aplikasi Kontak.
Batalkan – Menonaktifkan pengalihan.
Periksa status – Memeriksa apakah pengalihan 
diaktifkan atau dinonaktifkan.
Untuk membatalkan semua pengalihan panggilan, 
tekan Batalkan semua pengalihan.
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Mengalihkan panggilan data & faks 
(layanan jaringan)
1 Tekan , lalu pilih Peralatan > Pengaturan > 

Pengalihan panggilan....
2 Buka halaman panggilan Data & Faks, kemudian pilih 

salah satu dari pilihan berikut untuk mengalihkan 
semua panggilan data atau faks:
Aktifkan – Menampilkan dialog untuk memasukkan 
nomor yang panggilannya akan Anda alihkan, 
kemudian memilih batas waktu setelah panggilan 
dialihkan, jika tidak dijawab. Anda dapat menekan 
kotak untuk memilih nomor yang ditambahkan 
sebelumnya, jika ada.
Batalkan – Menonaktifkan pengalihan.
Periksa status – Memeriksa apakah pengalihan 
diaktifkan atau dinonaktifkan.

Pembatasan panggilan (layanan 
jaringan)
Pembatasan panggilan memungkinkan Anda membatasi 
panggilan keluar atau panggilan masuk pada smartphone 
Anda. Fungsi ini memerlukan sandi pembatasan dari 
operator selular.
1 Tekan , lalu pilih Peralatan > Pengaturan > 

Pembatasan panggilan.... Dialog ditampilkan.

2 Tetapkan berikut ini:
Semua panggilan masuk: – Bila diaktifkan, panggilan 
tidak dapat diterima.
Panggilan masuk bila di luar negeri: – Bila diaktifkan, 
panggilan tidak dapat diterima saat Anda berada di 
luar negara asal.
Semua panggilan keluar: – Bila diaktifkan, panggilan 
keluar tidak dapat dibuat.
Panggilan internasional: – Bila diaktifkan, panggilan ke 
luar negeri atau wilayah lain tidak dapat dibuat.
Panggilan int. kecuali ke negara asal: – Jika Anda sudah 
mengaktifkan roaming internasional melalui operator 
jaringan, maka Anda tidak dapat membuat panggilan 
internasional saat berada di luar negeri, kecuali ke 
negara asal.
Pilihan yang tersedia adalah:
Aktifkan – Mengaktifkan pembatasan.
Batalkan – Menonaktifkan pembatasan.
Periksa status – Memeriksa apakah pembatasan 
panggilan data diaktifkan atau dinonaktifkan.

3 Masukkan sandi pembatasan, kemudian tekan OK 
untuk mengaktifkan layanan ini.

Jika kartu SIM Anda mendukung layanan saluran 
alternatif, pembatasan panggilan suara hanya diaktifkan 
pada saluran yang dipilih.

Untuk membatalkan semua pembatasan panggilan, 
tekan Batalkan semua pembatasan.
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Untuk informasi tentang pembatasan panggilan data, lihat 
“Pembatasan panggilan data” pada halaman 122.

Pembatasan panggilan dan pengalihan panggilan tidak 
dapat diaktifkan pada saat bersamaan. Selama panggilan 
dibatasi, panggilan tertentu masih dimungkinkan untuk 
nomor darurat resmi yang telah diprogram ke dalam 
smartphone.

Pengaturan kotak suara 
Untuk informasi tentang memanggil kotak suara (layanan 
jaringan), lihat “Memanggil” pada halaman 40.
1 Tekan , lalu pilih Peralatan > Pengaturan > Kotak 

suara....
2 Tentukan nomor kotak suara Anda, dan jika Anda 

memerlukannya, nada DTMF (sandi kotak suara):
Nomor: – Menulis nomor kotak suara yang diperoleh 
dari operator selular Anda.
DTMF: – Menentukan nada DTMF untuk kotak suara. 
Untuk informasi tentang nada DTMF, lihat “Mengirim 
nada DTMF” pada halaman 47.

Jika kartu SIM Anda mendukung layanan saluran 
alternatif, Anda dapat menetapkan pengaturan kotak 
suara untuk kedua saluran tersebut.

Pengaturan lain
Tekan , lalu pilih Peralatan > Pengaturan > Pengaturan 
lain.... Tetapkan berikut ini:

Halaman Panggil
Panggilan tunggu: (layanan jaringan) – Jika Anda 
mengaktifkan layanan panggilan tunggu, jaringan akan 
mengirim pemberitahuan adanya panggilan masuk saat 
Anda sedang berbicara di telepon. Pilihan Periksa status 
akan memeriksa apakah panggilan tunggu diaktifkan atau 
dinonaktifkan.

Kirim nomor ID saya: (layanan jaringan) – Menetapkan 
apakah nomor telepon Anda akan disembunyikan atau 
ditampilkan pada layar telepon orang yang Anda hubungi. 
Pilihan ini dapat diatur oleh operator jaringan atau 
operator selular Anda saat berlangganan (Atur menurut 
jaringan). 

Ringkasan setelah panggilan: – Jika Aktif dipilih, perkiraan 
lamanya panggilan akan ditampilkan setelah panggilan 
selesai.

Panggil ulang otomatis: – Jika Aktif dipilih, kemudian Anda 
memanggil nomor yang sedang sibuk atau tidak 
menjawab, maka smartphone akan memanggil kembali 
nomor tersebut secara otomatis. Nomor akan dipanggil 
ulang maksimum 10 kali.

Tolak dengan pesan: – Jika Anda membuat pilihan Aktif, 
salah satu kotak teks akan terbuka, kemudian Anda dapat 
menulis pesan yang akan dikirim kepada pemanggil 
sebagai balasan, saat suara panggilan telepon masuk 
dinonaktifkan. Untuk mengubah pesan tersebut di lain 
waktu, buat pilihan Edit pesan.
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Saluran yang digunakan: (layanan jaringan) – Jika kartu SIM 
Anda mendukung layanan saluran alternatif, pilih saluran 
yang akan Anda gunakan. 

Blok perubahan saluran: (layanan jaringan) – Jika kartu SIM 
Anda mendukung layanan saluran alternatif, dan pilihan 
ini diaktifkan, Anda tidak dapat mengubah saluran yang 
sedang digunakan. Jika Anda ingin mengubah pengaturan 
ini, Anda harus memasukkan kode PIN2. 

Halaman Jaringan
Pilihan operator: – Memungkinkan Anda mengubah cara 
pemilihan jaringan, dan juga mendaftar ke jaringan lain. 
Pada pilihan jaringan otomatis, smartphone akan memilih 
jaringan yang paling sesuai. Pada pilihan jaringan manual, 
smartphone akan mencari jaringan yang tersedia dan 
jaringan yang ditemukan ditampilkan dalam daftar. Anda 
dapat memilih salah satu jaringan yang akan digunakan. 
Ingat, kemungkinan untuk mengganti jaringan akan 
tergantung pada operator jaringan Anda.

Tampilan info sel: – Pilih Aktif untuk menunjukkan bahwa 
smartphone digunakan dalam Micro Cellular Network. 
Indikator sel MCN ditunjukkan dalam kolom nomor 
telepon. Indikator tidak akan ditampilkan selama 
panggilan.

Halaman Pengaman
Bila fitur pengaman yang membatasi panggilan sedang 
digunakan (seperti pembatasan panggilan, grup pengguna 
tertentu dan panggilan tetap), Anda masih dapat membuat 

panggilan ke nomor darurat yang sudah diprogram ke 
dalam smartphone ini.

Grup pengguna tertentu: – Menentukan kelompok orang 
yang dapat Anda hubungi atau menghubungi Anda. Pilih 
Standar untuk mengaktifkan grup yang disetujui dalam 
operator jaringan. Pilih Aktif untuk mengaktifkan layanan 
jaringan ini. Anda harus memasukkan nomor grup yang 
diperoleh dari jaringan.

Panggilan tetap: – Jika kartu SIM Anda mendukung layanan 
ini, Anda dapat mencegah panggilan ke beberapa nomor 
terbatas yang disimpan dalam kartu SIM. Saat layanan 
panggilan tetap aktif, daftar buku telepon SIM hanya akan 
menampilkan nomor-nomor dalam daftar panggilan 
tetap. Anda masih dapat mengakses direktori Kontak, 
namun tidak dapat memanggil nomor di dalamnya.

Jika Anda ingin mengubah pengaturan ini atau melihat 
nomor tetap, Anda harus memasukkan kode PIN2. Pilih 
Kontak untuk menambahkan, memodifikasi atau 
menghapus nomor.

Anda diminta memasukkan nama dan nomor ke dalam 
daftar panggilan tetap.

Catatan: Panggilan tetap juga akan mempengaruhi 
permintaan layanan (juga dikenal sebagai perintah SS 
dan USSD), misalnya perintah pengaktifan untuk 
layanan jaringan.



Hak cipta © 2005 Nokia. Semua hak dilindungi undang-undang.

Te
le

po
n

47

Mengirim nada DTMF
Nada DTMF (Dual Tone Multi-Frequency) adalah bunyi 
yang Anda dengar saat menekan tombol angka dari 
aplikasi Telepon. Misalnya, nada DTMF memungkinkan 
Anda berkomunikasi dengan kotak suara dan sistem 
telepon yang sudah diprogram komputer.

Anda dapat mengirim nada DTMF ke jaringan untuk, 
misalnya, mengakses layanan telepon otomatis, kotak 
suara atau sistem perbankan.

Anda dapat mengirim nada DTMF secara otomatis jika 
nada DTMF telah ditambahkan ke kolom DTMF dalam kartu 
kontak dari aplikasi Kontak. Anda juga dapat mengirim 
nada DTMF secara manual pada tampilan Penelepon di 
aplikasi Telepon. Metode manual pengiriman nada DTMF 
disarankan jika string nada DTMF pendek.

Untuk mengirim string nada DTMF secara otomatis 
selama panggilan, tekan , lalu pilih Pilihan > Kirim 
DTMF.... Jika terdapat string DTMF untuk panggilan 
aktif dalam Kontak, dialog Kirim DTMF akan 
ditampilkan. Tekan Kirim untuk mengirim nada DTMF 
secara otomatis, atau Masukkan secara manual 
untuk menggunakan tampilan Penelepon. Tampilan 
Penelepon dibuka secara otomatis jika tidak ada string 
DTMF untuk panggilan tersebut dalam Kontak.

Untuk memasukkan nada DTMF secara manual saat 
panggilan berlangsung, tekan Panggilan baru atau 
tekan . Masukkan string DTMF.

Tip: Terdapat 2 karakter khusus yang dapat Anda 
gunakan dengan menekan dua kali * pada keypad:
• p (pause) – Untuk memasukkan jeda tiga detik 

antara setiap digit dalam string nada DTMF. 
Semua digit yang mengikuti tanda jeda adalah 
sebagai nada DTMF.

• w (wait) – Menunda pengiriman digit DTMF 
sampai Anda menekan Kirim. Semua string dikirim 
ke jaringan. Semua digit yang mengikuti tanda 
tunggu adalah sebagai nada DTMF.

Anda dapat menambahkan nada DTMF pada kolom DTMF 
dalam kartu kontak.

Tip untuk penggunaan Telepon yang 
efisien
• Indikator diam  ditampilkan di bagian indikator 

status saat Anda mengaktifkan profil Diam. Penekanan 
indikator ini akan membuka dialog untuk mengubah 
profil. Indikator tidak akan terlihat di bagian indikator 
status jika Anda mengaktifkan selain profil 'Diam'.

• Pada tampilan penanganan panggilan, tekan  
selama panggilan untuk menahan atau mengaktifkan 
panggilan yang ditahan. Saat Anda tidak dalam 
panggilan telepon, tekan  untuk menampilkan 
daftar panggilan keluar terakhir.
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• Pada tampilan sambungan cepat, Anda dapat 
menggeser tombol sambungan cepat dengan pena 
stylus untuk mengaturnya. Tombol pesan suara tetap 
tidak dapat dipindahkan.
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Profil
Buka Meja > Profil.

Melalui Profil Anda dapat menetapkan nada dering dan 
volume suara smartphone untuk berbagai kondisi 
pengoperasian yang berbeda, aktivitas dan grup 
penelepon.

Untuk mengubah profil, pilih profil dari daftar 
kemudian tekan Aktifkan.

Untuk menghapus profil, pilih profil dari daftar, tekan 
, lalu pilih Profil > Hapus. Ingat, profil standar tidak 

dapat dihapus.

Tip: Anda juga dapat mengganti profil dengan 
menekan sebentar tombol daya.

Untuk membuat profil baru, tekan , lalu pilih 
Profil > Baru.... Untuk informasi lebih lanjut tentang 
pengaturan ini, lihat “Mengedit profil” pada 
halaman 50.

Untuk menetapkan masa berlaku profil yang dipilih, 
tekan Atur waktu. Tekan , kemudian gunakan 
tanda panah untuk mengubah waktu. Saat masa 
berakhir tercapai, profil yang digunakan sebelumnya 
diaktifkan kembali. Ingat, untuk alasan keselamatan 
profil Penerbangan tidak dapat diubah.

Untuk menambahkan grup penelepon ke dalam 
profil yang dipilih, tekan Personalisa-si dan Tanda 
untuk. Pilih grup tersebut atau sejumlah grup, 
kemudian tekan OK. Smartphone akan membunyikan 
dering yang dipilih atau nada peringatan hanya untuk 
panggilan atau pesan yang dikirim dari anggota grup 
(jika nomor penelepon dikirim bersama panggilan dan 
smartphone Anda mengenali nomor tersebut). Untuk 
penelepon lainnya digunakan profil Diam.

Untuk menggunakan smartphone tanpa tersambung 
ke jaringan GSM, pilih profil Penerbangan, kemudian 
tekan Aktifkan. Telepon selular GSM dan sinyal radio 
FM ke atau dari smartphone dan sambungan Bluetooth 
akan diblokir, sehingga Anda tetap dapat 
menggunakan perangkat tanpa harus tersambung ke 
jaringan selular. Misalnya, Anda masih bisa 
mendengarkan klip musik atau menulis pesan.

PERINGATAN: Dalam profil Penerbangan, Anda tidak 
dapat membuat atau menerima panggilan, termasuk 
panggilan darurat, atau menggunakan fitur jaringan. 
Untuk membuat panggilan, pertama-tama aktifkan 
fungsi telepon dengan mengganti profil. Jika 
smartphone dalam keadaan terkunci, masukkan kode 
kunci. Jika Anda harus menghubungi nomor darurat 
saat smartphone terkunci dan dalam profil 
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penerbangan, Anda masih dapat memasukkan nomor 
darurat yang telah diprogram dalam smartphone pada 
kolom kode kunci kemudian tekan Panggil. 
Smartphone akan mengkonfirmasi bahwa Anda hendak 
keluar dari profil penerbangan untuk membuat 
panggilan darurat.

PERINGATAN: Jangan aktifkan smartphone ini jika 
terdapat larangan penggunaan telepon selular atau jika 
dapat menimbulkan gangguan atau bahaya.

Mengedit profil
Untuk mengedit profil, pilih profil dalam daftar 
kemudian tekan Personalisa-si. Ingat, tidak semua 
pengaturan untuk setiap profil dapat diubah. Tetapkan 
berikut ini:

Nama profil: Mengubah nama profil.

Nada dering: Tekan  untuk memilih file suara yang akan 
digunakan sebagai nada dering untuk panggilan suara. 
Untuk mendengarkan nada yang dipilih, tekan Nada 
putar. Dengan cara yang sama Anda dapat memilih file 
suara untuk jenis pesan yang berbeda.

Tanda pgl. masuk: Jika Menaik dipilih, volume dering akan 
terdengar mulai dari tingkat satu dan semakin keras 
setingkat demi setingkat sesuai dengan tingkat volume 
suara yang sudah diatur sebelumnya.

Volume dering: Pilih tingkat volume suara dengan menekan 
 atau . Tingkat volume ini juga digunakan untuk 

nada panggilan masuk, pesan dan alarm.

Tanda getar: Mengaktifkan tanda getar pada smartphone 
untuk pesan, alarm dan panggilan suara yang masuk.

Tanda pesan: Untuk mengaktifkan tanda pesan.

Nada tanda pesan teks: Tekan  untuk memilih nada 
sebagai tanda pesan teks yang masuk. Jika Tanda pesan: 
tidak dipilih, pilihan ini tidak akan tersedia.

Nd. tanda multimedia: Tekan  untuk memilih nada 
sebagai tanda pesan multimedia yang masuk. Jika Tanda 
pesan: tidak dipilih, pilihan ini tidak akan tersedia.

Nada tanda e-mail Tekan  untuk memilih nada sebagai 
tanda pesan e-mail yang masuk. Jika Tanda pesan: tidak 
dipilih, pilihan ini tidak akan tersedia.

Nada tombol: Mengatur tingkat volume suara penekanan 
tombol.

Nada layar sentuh: Mengatur tingkat volume suara 
penekanan layar.

Nada peringatan: Smartphone akan membunyikan nada 
pemberitahuan, misalnya saat daya baterai habis.

Untuk menutup dialog dan membatalkan semua 
perubahan yang Anda buat, tekan .
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Pesan
Buka Meja > Pesan.

Dalam aplikasi Pesan, Anda dapat membuat, mengirim, 
menerima, melihat, mengedit dan menyusun berbagai 
jenis pesan: pesan teks, pesan multimedia, pesan e-mail, 
dan pesan pintar yaitu pesan teks khusus yang berisi data. 
Anda juga dapat menerima pesan dan data melalui 
sambungan Bluetooth, menerima pesan layanan WAP, 
pesan area dan mengirim perintah layanan.

Gbr. 17: Pesan

Catatan: Pesan multimedia dapat diterima dan 
ditampilkan hanya pada perangkat yang memiliki fitur 
pesan multimedia atau e-mail yang kompatibel.

Tip: Agar dapat mengirim serta menerima e-mail dan 
pesan multimedia, Anda harus mengkonfigurasikan 
pengaturan jalur akses Internet. Lihat “Membuat 
pengaturan jalur akses Internet” pada halaman 124. 
Berdasarkan jenis kartu SIM yang digunakan, 
smartphone Anda mungkin dapat menambahkan 
secara otomatis pengaturan yang benar untuk 
browsing WWW dan MMS.

Tip: Anda dapat mulai membuat pesan dari berbagai 
aplikasi yang memberikan pilihan Kirim (atau perintah 
menu Kirim). Pilih file (gambar, teks) yang akan 
ditambahkan ke dalam pesan kemudian tekan Kirim.

Tip: Untuk mengirim pesan dari tampilan edit pesan, 
dengan alamat yang benar di kolom Untuk: , tekan  
untuk mengirim pesan.

Untuk melakukan penyesuaian tombol perintah di 
jendela utama, tekan , pilih Tampilan > Tombol bar 
perintah..., pilih perintah yang sesuai untuk 
masing-masing tombol kemudian tekan OK.

Untuk menyusun urutan pesan, tekan , pilih 
Tampilan > Sortir.... Pilih metode penyortiran yang 
diinginkan, kemudian tekan OK.
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Kotak masuk
Ikon-ikon tersebut menunjukkan jenis pesan, prioritas, dan 
lampiran yang ada. Berikut adalah beberapa ikon yang 
dapat Anda lihat:

E-mail baru di kotak surat remote

Pesan teks baru

Pesan multimedia baru

Undangan kalender baru

E-mail belum dibaca

E-mail dengan prioritas utama

E-mail dengan prioritas rendah di kotak 
surat remote

Lampiran

Status Kotak keluar
E-mail dan pesan teks di Kotak keluar dapat memiliki 
status berikut:

Mengirim – Pengiriman pesan sedang berlangsung.

Permintaan – E-mail atau pesan teks hanya akan dikirim 
jika Anda menekan Kirim pada tampilan Kotak keluar.

Menunggu – Pesan teks dalam antrian pengiriman dan 
secepat mungkin akan dikirimkan. Misalnya, pesan dapat 
menunggu saat smartphone diaktifkan, menunggu hingga 
kekuatan sinyal cukup kuat, atau menunggu sampai 

panggilan telepon berakhir. Pada pesan e-mail, Menunggu 
menandakan pesan akan dikirim setelah Anda tersambung 
ke kotak surat remote. 

Gagal – Pesan tidak berhasil terkirim.

Ditunda – Anda menunda pengiriman pesan. Anda dapat 
melanjutkan pengiriman pesan dengan menekan Kirim 
pada tampilan Kotak keluar.

Folder
Saat Anda membuka Pesan, Anda dapat melihat isi folder 
yang terakhir dibuka.

Untuk beralih ke folder lain, tekan  lalu pilih 
Folder. Daftar folder berisi:

Kotak masuk – Berisi pesan yang diterima, kecuali pesan 
area.

Kotak keluar – Folder untuk penyimpanan pesan yang 
menunggu untuk dikirim. Misalnya, pesan-pesan akan 
disimpan sementara di Kotak keluar, ketika smartphone 
Anda sedang berada di luar jangkauan jaringan. Anda juga 
dapat menjadwalkan pengiriman pesan e-mail pada saat 
membuat sambungan yang berikutnya ke kotak surat 
remote. Tekan Tunda pengiriman untuk menunda 
pengiriman dan menahan pesan di Kotak keluar.

Konsep – Berisi pesan konsep yang belum akan dikirim.
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Terkirim – Menyimpan pesan yang telah berhasil terkirim. 
Ingat, pesan atau data yang dikirim melalui sambungan 
Bluetooth tidak akan disimpan dalam folder Terkirim.

 Kotak surat – Jika folder ini dibuka, Anda dapat 
tersambung ke kotak surat remote untuk mengambil pesan 
e-mail yang baru atau melihat secara offline pesan e-mail 
yang didapat sebelumnya. Lihat “Pesan e-mail” pada 
halaman 53.

Untuk menambahkan folder baru, tekan  lalu 
pilih Peralatan > Atur folder.... Tekan Baru, kemudian 
berikan nama untuk folder baru tersebut. Anda dapat 
mengatur pesan-pesan Anda di folder ini.

Untuk mengubah nama atau menghapus folder, 
tekan  kemudian pilih Peralatan > Atur folder.... 
Ingat, Anda tidak dapat menghapus folder-folder 
standar.

Pesan e-mail
Untuk dapat menerima dan mengirim e-mail, Anda harus 
mengatur layanan kotak surat remote. Layanan ini 
mungkin diberikan oleh penyedia layanan Internet, 
operator jaringan atau perusahaan tempat Anda bekerja.

Mengatur kotak surat remote
1 Tekan  pada tampilan utama aplikasi Pesan, 

kemudian pilih Peralatan > Kotak surat baru.... Tekan 
Berikutnya.

2 Tetapkan pengaturan berikut pada halaman wizard 
pengaturan kotak surat:
Nama kotak surat: – Tulis nama kotak surat remote.
Jenis kotak surat: – Pilih protokol e-mail yang 
direkomendasikan oleh operator kotak surat remote 
Anda. Ingat, pengaturan ini hanya dapat dipilih sekali 
dan tidak dapat diubah jika Anda sudah menyimpan 
atau keluar dari pengaturan kotak surat. Tekan 
Berikutnya.
Nama: – Tulis nama Anda.
Nama pengguna: – Tulis nama pengguna yang diberikan 
operator selular kepada Anda. 
Sandi: – Tulis sandi Anda. Jika Anda tidak mengisi 
kolom ini, maka Anda akan diminta untuk mengisi 
sandi saat mencoba tersambung ke kotak surat remote.
Alamat e-mail saya: – Tulis alamat e-mail yang 
diberikan oleh operator selular Anda. Alamat harus 
berisi karakter ‘@’. Jawaban untuk pesan Anda dikirim 
ke alamat ini. Tekan Berikutnya.
Server masuk (POP3): atau Server masuk (IMAP4): – 
Masukkan alamat IP atau nama host komputer yang 
menerima e-mail Anda.
Server keluar (SMTP): – Alamat IP atau nama host 
komputer yang mengirim e-mail Anda Tekan 
Berikutnya.
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3 Setelah Anda selesai menetapkan pilihan ini, tekan 
Selesai untuk kembali ke aplikasi Pesan, atau tekan 
Lanjutan untuk menetapkan pengaturan e-mail 
lanjutan opsional. Untuk informasi lebih lanjut, lihat 
“Pengaturan e-mail lanjutan” pada halaman 54.
Untuk mengedit pengaturan kotak surat remote, 
tekan  lalu pilih Peralatan > Pengaturan pesan > 
E-mail.... Pilih kotak surat yang akan diedit, tekan Edit 
dan buat perubahan seperti telah dijelaskan 
sebelumnya. Ingat, Anda tidak dapat mengedit 
pengaturan kotak surat jika sambungan ke kotak surat 
remote terbuka.

Untuk menetapkan sebuah kotak surat sebagai 
kotak surat standar, tekan  kemudian pilih 
Peralatan > Pengaturan pesan > E-mail.... Pilih kotak 
surat yang akan Anda tetapkan sebagai standar, 
kemudian tekan Atur sbg. standar.

Pengaturan e-mail lanjutan
Setelah Anda selesai mengatur atau mengedit pengaturan 
kotak surat remote pada wizard pengaturan Kotak surat 
(buka aplikasi Pesan, tekan , pilih Peralatan > 
Pengaturan pesan > E-mail...), Anda dapat melanjutkan 
dengan mengkonfigurasi pengaturan kotak surat lanjutan.

Halaman Pengambilan
Ambil: – Menentukan apakah pesan akan diambil dari 
kotak surat remote ketika telah tersambung. Pilihan Pesan 
hanya tersedia jika jenis kotak surat adalah IMAP4.

Batas ukuran e-mail: – Menentukan ukuran maksimum 
untuk pesan yang akan diambil dengan memilih perintah 
menu E-mail > Ambil dan kirim. Ukuran minimum adalah 
1 kB dan maksimum 1000 kB. Jika melebihi batas yang 
telah ditetapkan, maka yang akan diambil hanya judul 
pesan.

Jumlah e-mail untuk dibuka: – Menetapkan jumlah judul 
pesan baru yang akan Anda tampilkan di Kotak masuk. Jika 
Anda mengambil judul baru dan jumlah keseluruhan judul 
di Kotak masuk melampaui batas ini, maka judul yang 
paling lama akan dihapus. Pilihan ini hanya tersedia untuk 
jenis kotak surat IMAP4.

Otentikasi sandi: – Digunakan dengan protokol POP3 untuk 
mengenkripsi pengiriman sandi ke server e-mail remote.

Buka e-mail ke Kotak masuk: – Pilih untuk menerima pesan 
dari account ini ke Kotak masuk Anda. Jika tidak dipilih, 
pesan akan diterima di folder kotak surat terpisah, bukan 
di Kotak masuk Anda.

Halaman Pengiriman
Format e-mail standar: – Jenis surat yang dapat Anda tulis 
dan kirim dari smartphone Anda.
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Kirim e-mail: – Metode pengiriman dari smartphone Anda.

E-mail orisinil dilampirkan di balasan: – Pilih untuk 
menyertakan pesan asli dalam pesan balasan.

Permintaan untuk membaca laporan: – Jika dipilih, Anda 
akan menerima pemberitahuan saat pesan dibuka oleh 
penerima. Anda hanya dapat menerima pesan 
pemberitahuan jika aplikasi e-mail penerima mendukung 
fitur ini.

Halaman server keluar (SMTP)
Otentikasi diperlukan: – Dipilih jika server SMTP (Simple 
Mail Transfer Protocol) memerlukan otentikasi. Beberapa 
server mengharuskan pengguna untuk diotentikasi 
sebelum e-mail dikirim.

Nama pengguna: – Tulis nama pengguna untuk server 
SMTP.

Sandi: – Tulis sandi Anda untuk server SMTP.

Halaman lainnya
Pengaman – Menetapkan protokol keamanan server.

Port e-mail masuk: – Memasukkan nomor port server e-mail 
masuk. Biasanya Anda tidak perlu mengubah nilai standar 
ini.

Port e-mail keluar: – Memasukkan nomor port server e-mail 
keluar. Biasanya Anda tidak perlu mengubah nilai standar 
ini.

Jalur akses digunakan: – Memilih apakah Anda ingin 
terhubung dengan menggunakan jalur akses manapun 
yang tersedia atau memilih jalur akses yang Anda inginkan 
saat tersambung.

Atur sebagai kotak surat standar: – Jika kotak pilihan ini 
dipilih, kotak surat ini akan ditetapkan sebagai kotak surat 
standar.

Pengambilan e-mail dari kotak surat
Tip: Hapus atau pindahkan e-mail secara berkala dari 
smartphone Anda untuk membebaskan ruang memori.

E-mail yang ditujukan kepada Anda tidak secara otomatis 
diterima oleh smartphone Anda, namun ditampung 
sementara di kotak surat remote Anda. Untuk membaca 
e-mail, Anda harus terlebih dahulu tersambung ke kotak 
surat remote, kemudian memilih e-mail yang akan diambil 
ke dalam smartphone Anda. Sambungan ke kotak surat 
remote dibuat melalui panggilan data.

Anda akan menerima semua pesan di folder kotak surat 
remote kecuali jika Anda menetapkan untuk langsung 
menerima pesan di Kotak masuk Anda.

Tip: Untuk informasi tentang menentukan pilihan 
pengambilan e-mail, lihat “Pengaturan e-mail 
lanjutan” pada halaman 54.
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Untuk mengambil e-mail dari kotak surat remote, 
tekan  kemudian pilih E-mail > Ambil dan kirim. Pilih 
perintah yang sesuai untuk menerima e-mail dari 
semua kotak surat atau hanya dari kotak surat yang 
dipilih. Ingat, jika Anda memiliki e-mail di Kotak 
keluar, maka pesan yang ada akan dikirim secara 
bersamaan.

Tip: Jika Anda tidak memasukkan sandi dalam 
pengaturan kotak surat remote, Anda akan diminta 
untuk memasukkannya ketika memulai sambungan ke 
kotak surat remote. Pada dialog yang ditampilkan, tulis 
sandi kemudian tekan OK.

Untuk mengambil isi pesan yang dipilih, tekan , 
lalu pilih E-mail > Ambil isi e-mail.

Untuk mengakhiri sambungan ke kotak surat, tekan 
 kemudian pilih E-mail > Putuskan dari Internet. 

Panggilan data terputus.

Tip: Untuk mengambil isi pesan e-mail yang dipilih, 
tekan pesan. Isi pesan dikirimkan ke smartphone Anda, 
dan jika terdapat pesan baru di kotak surat remote, 
daftar pesan akan diperbarui secara bersamaan.

Membaca dan menjawab e-mail
Untuk membuka Kotak masuk Anda atau folder 
lain, tekan  kemudian pilih Folder > Kotak 
masuk/Kotak keluar/Konsep/Terkirim atau nama kotak 
surat remote, jika ada.

Untuk melihat dulu tampilan pesan yang Anda 
buat, tekan pesan tersebut sekali.

Untuk membuka pesan yang Anda terima, tekan 
pesan tersebut dua kali. Jika pesan berisi penghubung 
(link) Web, Anda dapat membukanya dengan menekan 
penghubung tersebut. 

Untuk mengaktifkan atau menonaktifkan pesan 
pratinjau, tekan , lalu pilih Tampilan > Modus 
pratinjau.

Tip: Anda dapat membuat kartu kontak baru untuk 
pengirim e-mail. Tekan  kemudian pilih Peralatan > 
Tambah ke Kontak....

Untuk membuka lampiran dalam pesan, tekan dua 
kali lampiran. Ingat, lampiran mungkin berisi virus 
atau program jahat. Pastikan selalu untuk hanya 
menerima dari pengirim yang dikenal. Untuk 
menyimpan lampiran, pilih dan tekan Simpan.

Untuk membalas pesan setelah membacanya, tekan 
Balas. Untuk membalas ke semua penerima, tidak 
hanya ke pengirim pesan e-mail, tekan  kemudian 
pilih Pesan > Balas ke semua.

Saat membalas pesan e-mail, pesan HTML akan disertakan 
sebagai lampiran.

Tip: Untuk informasi tentang menentukan pilihan 
pengiriman e-mail, lihat “Pengaturan e-mail lanjutan” 
pada halaman 54.
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Untuk meneruskan pesan e-mail, tekan  
kemudian pilih Pesan > Teruskan.

Untuk menghapus pesan dari Kotak masuk atau 
kotak surat remote, tekan Hapus. Bila perlu, tentukan 
apakah Anda akan menghapus hanya pesan di 
smartphone Anda atau keduanya di smartphone dan 
server e-mail.

Mengirim e-mail
1 Tekan , kemudian pilih Pesan > Buat > E-mail pada 

tampilan utama aplikasi Pesan.
2 Tulis alamat e-mail di kolom Untuk: . Tambahkan tanda 

titik koma (;) untuk memisahkan setiap penerima.
Jika penerima terdapat dalam Kontak, tekan . Pilih 
penerima dari daftar, kemudian tekan Tambah. Tekan 
Selesai setelah semua penerima dipilih.

3 Isi judul dan tulis pesan. Tekan Kirim.
Tip: Anda dapat menggunakan alamat e-mail di kotak 
teks atau dokumen sebagai penghubung. Tekan 
alamat, atau letakkan kursor di antaranya dengan 
tombol gulir; sehingga menjadi penghubung dengan 
ikon kecil. Tekan ikon untuk membuka editor e-mail.

Jika nama yang Anda masukkan memiliki kemiripan 
dengan beberapa nama lainnya, atau memiliki lebih dari 
satu alamat e-mail, pilih nama atau alamat e-mail yang 
benar dari daftar kemudian tekan OK.

Tip: Anda dapat memilih lebih dari satu kontak secara 
bersamaan. Lihat “Perintah umum pada beberapa 
aplikasi” pada halaman 23.

Untuk menampilkan atau menyembunyikan kolom 
Cc: dan Bcc:  pada editor e-mail, tekan  kemudian 
pilih Tampilan > Kolom Cc atau Kolom Bcc. Jika Anda 
menambahkan penerima di kolom Cc:, salinan pesan 
akan dikirim ke penerima tersebut, dan nama 
penerima ini akan terlihat oleh penerima pesan 
lainnya. Jika Anda menambahkan penerima di kolom 
Bcc:, salinan pesan akan dikirim ke penerima tersebut, 
namun nama penerima ini tidak akan terlihat oleh 
penerima pesan lainnya.

Untuk menyimpan, tanpa mengirimkan e-mail yang 
baru saja Anda tulis, tekan Tutup. Pesan akan 
disimpan di folder Konsep. Pesan yang disimpan ini 
akan menggantikan pesan yang sama sebelumnya.

Untuk menghapus semua pesan terkirim secara 
otomatis, buka folder Terkirim, tekan , lalu pilih 
Peralatan > Hapus pesan yang telah dikirim. Tetapkan 
jumlah maksimum pesan yang terdapat dalam folder 
Terkirim atau jumlah batas hari yang diperbolehkan 
sebelum pesan-pesan tersebut dihapus.

Untuk menentukan pilihan pengiriman e-mail, 
tekan Pilihan pengiriman. Ingat, perubahan apapun 
yang Anda buat dalam dialog ini hanya berlaku pada 
e-mail yang hendak dikirim, dan akan mempengaruhi 
format pesan saat dibuka oleh penerima. Misalnya, 
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format akan mempengaruhi kemudahan dalam 
pembacaan karakter pesan. Tetapkan berikut ini:

Prioritas: – Tingkat prioritas perhatian terhadap pesan.

Format e-mail: – Jenis format pesan. Pilih Teks diformat 
(HTML) untuk dapat menggunakan pilihan 
pemformatan teks yang disempurnakan. Pilih Teks plain 
untuk menggunakan format internet biasa, atau Teks 
plain (tidak ada MIME), jika Anda mengetahui bahwa 
sistem penerimaan e-mail tidak dapat menampilkan 
e-mail yang dikirim dalam format Internet biasa.

Permintaan baca laporan: – Pilih jika Anda ingin 
menerima catatan saat penerima membuka e-mail 
Anda.

Kotak surat yg digunakan: – Kotak surat remote yang 
digunakan untuk mengirim pesan ini.

Kirim e-mail: – Menentukan kapan pesan akan dikirim. 
Segera artinya pesan akan langsung dikirim jika Anda 
tersambung ke kotak surat remote. Jika Anda tidak 
tersambung, pengiriman pesan akan mengaktifkan 
sambungan. Pilihan Bila koneksi tersedia artinya e-mail 
akan dikirim lain waktu, saat tersambung ke kotak 
surat remote. Pilihan Permintaan artinya pesan akan 
disimpan di Kotak keluar dengan menekan Kirim. Pesan 
akan dikirim saat Anda memilih pesan di Kotak keluar 
dan menekan Kirim.

Gaya e-mail
Pemformatan teks dan paragraf hanya dapat dibuat jika 
format pilihan pengiriman Format e-mail: untuk e-mail ini 
diatur ke Teks diformat (HTML).

Untuk memformat teks yang dipilih, tekan  
kemudian pilih Format > Huruf.... Bar peralatan di 
bagian bawah layar juga menyediakan alat pengeditan 
teks. Jika bar peralatan tidak terlihat, tekan  
kemudian pilih Tampilan > Bar peralatan.

Untuk meluruskan paragraf yang dipilih, tekan  
kemudian pilih Format > Kesejajaran > Ke kiri, Ke kanan, 
atau Ditengah.

Penjadwalan
Anda dapat menentukan kapan dan berapa kali 
smartphone akan mencoba tersambung ke kotak surat 
remote untuk mengirim dan menerima e-mail.

Untuk menetapkan penjadwalan e-mail, tekan , 
pilih E-mail > Ambil otomatis dan kirim... kemudian 
tekan Edit. Tentukan waktu mulai, waktu berakhir dan 
interval pengiriman dan penerimaan sebagai berikut: 
Tekan , kemudian tekan  dan  untuk 
mengubah waktu. Pilih kolom am/pm yang diperlukan, 
jika Anda menggunakan format waktu 12-jam. Di 
kolom Hari:, sorot hari dalam satu minggu, kapan 
sambungan akan dibuat. Tekan OK.
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Untuk mengaktifkan atau menonaktifkan 
penjadwalan, tekan , pilih E-mail > Ambil otomatis 
dan kirim... kemudian pilih atau hapus sambungan 
untuk mengaktifkan atau menonaktifkan penjadwalan.

Catatan: Jangan biarkan pilihan ini aktif, jika tidak 
diperlukan. Anda akan dikenakan biaya untuk setiap 
sambungan smartphone.

Lampiran e-mail
Anda dapat mengirim dokumen dan pesan yang Anda buat 
di aplikasi lain smartphone ini sebagai lampiran e-mail. 

Penting: Pesan e-mail mungkin berisi virus atau 
dapat merusak perangkat atau PC Anda. Jangan 
buka lampiran jika Anda tidak mempercayai 
pengirimnya.

Untuk menambahkan lampiran e-mail, tekan  
pada editor e-mail kemudian pilih Lampiran > 
Lampirkan file. Cari dan pilih file yang akan Anda 
lampirkan di e-mail.

Tip: Untuk menambahkan kartu kontak Anda sebagai 
lampiran, tekan  kemudian pilih Lampiran > 
Lampirkan 'Kartu kontak saya'.

Untuk melihat lampiran, buka pesan e-mail yang 
diterima atau dikirim yang berisi lampiran, kemudian 
tekan dua kali ikon lampiran di bagian bawah pesan. 
Jika format file lampiran tidak dikenali oleh sistem, 
ikon tanda tanya akan ditampilkan. 

Untuk menyimpan lampiran, buka pesan e-mail yang 
berisi lampiran, pilih lampiran di bagian bawah pesan 
dan tekan Simpan.

Untuk menghapus lampiran saat membuat pesan 
e-mail, pilih lampiran di bagian bawah pesan, 
kemudian tekan  dan pilih Lampiran > Hapus.

Tanda tangan
Untuk membuat tanda tangan account e-mail, 
tekan , pilih E-mail > Tanda tangan..., tekan Edit 
kemudian tulis tanda tangan. Pilih Lampirkan 'Kartu 
kontak saya': untuk menambahkan kartu kontak Anda 
di pesan e-mail yang akan dikirim.

Untuk mengaktifkan atau menonaktifkan tanda 
tangan account e-mail, tekan , pilih E-mail > 
Tanda tangan... kemudian pilih atau hapus tanda 
tangan untuk mengaktifkan atau menonaktifkannya. 
Tanda tangan harus dibuat sebelum dapat digunakan.

Pesan teks
SMS (Short Message Service) memungkinkan Anda 
mengirim dan menerima pesan teks melalui jaringan 
selular digital.

Mengirim pesan teks
1 Tekan Pesan teks baru pada tampilan utama aplikasi 

Pesan.
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2 Tulis nomor telepon di kolom Kepada:. Tambahkan 
tanda titik koma (;) untuk memisahkan setiap 
penerima.
Jika penerima terdapat dalam Kontak, tekan . Pilih 
penerima dan nomor telepon yang akan digunakan dari 
daftar, kemudian tekan Tambah. Tekan Selesai bila 
semua penerima sudah dipilih. Anda juga dapat 
memilih salah satu grup kontak sebagai penerima.

3 Tulis pesan, kemudian tekan Kirim. Ingat, pesan teks 
hanya dapat berisi teks yang tidak diformat, teks 
sederhana. 
Tip: Bila mengirim pesan teks yang berisi karakter 
khusus atau aksen, ingat bahwa tidak semua telepon 
mendukung karakter khusus.

Smartphone Anda mendukung pengiriman pesan teks yang 
melampaui batas normal 160 karakter. Jika pesan Anda 
melebihi 160 karakter, maka pesan tersebut akan dikirim 
sebagai dua atau beberapa rangkaian pesan.

Penghitung karakter di bagian bawah jendela pesan teks 
menunjukkan karakter yang digunakan dalam pesan saat 
itu juga. Jika jumlah karakter melebihi 160 karakter, nilai 
jumlah pesan yang harus dikirim juga akan ditampilkan. 

Jika terdapat karakter khusus dalam pesan Anda, indikator 
mungkin tidak akan menampilkan panjang pesan dengan 
benar. Karakter non-Latin dalam beberapa kelompok 
bahasa atau karakter khusus (Unicode) seperti ë, â, á, ì 
akan mengambil lebih banyak tempat. 

Harap diperhatikan bahwa, pengiriman pesan ke salah 
satu grup kontak atau dalam beberapa bagian mungkin 
lebih mahal dibandingkan jika hanya mengirim satu pesan.

Untuk menghapus semua pesan terkirim secara 
otomatis, buka folder Terkirim, tekan , lalu pilih 
Peralatan > Hapus pesan yang telah dikirim. Tetapkan 
jumlah maksimum pesan yang terdapat dalam folder 
Kotak masuk atau jumlah batas hari yang 
diperbolehkan sebelum pesan-pesan tersebut dihapus.

Untuk menentukan pilihan pengiriman pesan, tekan 
Pilihan pengiriman. Ingat, perubahan apapun yang 
Anda buat dalam dialog ini hanya berlaku pada pesan 
yang hendak Anda kirim. Tetapkan berikut ini:

Halaman umum
Pusat pesan yang digunakan: – Memilih pusat pesan yang 
akan digunakan untuk mengirim pesan teks.

Terima laporan: (layanan jaringan) – Jika dipilih, Anda 
dapat melihat status pesan yang dikirim di aplikasi Log. 
Jika tidak dipilih, hanya status Terkirim yang akan 
ditampilkan di Log.

Kirim pesan: – Menentukan kapan pesan akan dikirim. 
Pilihan Permintaan artinya pesan akan disimpan di Kotak 
keluar dengan menekan Kirim. Pesan akan dikirim saat 
Anda memilih pesan di Kotak keluar dan menekan Kirim.
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Halaman lanjutan
Validitas pesan: (layanan jaringan) - Jika penerima pesan 
tidak dapat dijangkau dalam batas waktu pengiriman, 
pesan akan dihapus dari pusat pesan teks. Ingat, jaringan 
harus mendukung fitur ini. Waktu maksimum adalah 
batasan waktu maksimum yang diperbolehkan oleh 
jaringan.

Balas via pusat yang sama: (layanan jaringan) – Pilih jika 
Anda ingin menggunakan nomor pusat pesan yang sama 
untuk mengirim pesan balasan.

Pesan dikirim sebagai: – Ubah pilihan ini hanya jika Anda 
yakin bahwa pusat pesan Anda dapat mengkonversi pesan 
teks ke dalam format lain. Hubungi operator jaringan 
Anda.

Menerima pesan teks
Pesan teks akan diterima secara otomatis, jika layanan ini 
tersedia dan smartphone diaktifkan serta berada dalam 
jangkauan jaringan.

Saat pesan teks baru masuk, nada pesan akan terdengar - 
kecuali jika smartphone menggunakan profil Diam - dan 
dialog ditampilkan. 

Untuk melihat dulu tampilan pesan, tekan pesan 
tersebut sekali.

Untuk membuka pesan yang Anda terima, tekan 
pesan tersebut dua kali. 

Tip: Untuk membuat kartu kontak untuk pengirim 
pesan teks, tekan  kemudian pilih Peralatan > 
Tambah ke Kontak....

Untuk membalas pesan teks, buka pesan yang asli, 
kemudian tekan Balas. Pilih cara membalas, tulis 
balasan Anda, kemudian tekan Kirim. Pesan asli akan 
disertakan dalam pesan balasan jika Anda memilih 
kotak pilihan Sertakan pesan asli dalam balasan: pada 
pengaturan pesan teks.

Untuk memindahkan, menyalin, atau menghapus 
pesan dari kartu SIM, tekan  kemudian pilih 
Pesan > Pesan dalam kartu SIM.... Pilih pesan, kemudian 
tekan tombol yang sesuai.

Pengaturan pesan teks
Perubahan apapun yang Anda buat pada pengaturan 
pesan teks hanya akan berlaku untuk pesan teks yang 
Anda terima dan kirim.

Tekan  pada tampilan utama Pesan, kemudian pilih 
Peralatan > Pengaturan pesan > Pesan teks.... Tetapkan 
berikut ini:

Halaman Umum
Pusat pesan yang digunakan: – Memilih pusat pesan yang 
akan digunakan untuk mengirim pesan teks.

Terima laporan: (layanan jaringan) – Jika dipilih, Anda 
dapat melihat status pesan yang dikirim di aplikasi Log. 
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Jika tidak dipilih, hanya status Terkirim yang akan 
ditampilkan di Log.

Kirim pesan: – Menentukan kapan pesan akan dikirim. 
Pilihan Dengan permintaan artinya pesan akan disimpan di 
Kotak keluar dengan menekan Kirim pada tampilan editor 
pesan. Pesan akan dikirim saat Anda memilih pesan di 
Kotak keluar dan menekan Kirim.

Halaman Lanjutan
Validitas pesan: – Jika penerima pesan tidak dapat 
dijangkau dalam batas waktu pengiriman, pesan akan 
dihapus dari pusat pesan teks. Ingat, jaringan harus 
mendukung fitur ini. Waktu maksimum adalah batasan 
waktu maksimum yang diperbolehkan oleh jaringan.

Balas via pusat yang sama: (layanan jaringan) – Pilih jika 
Anda ingin menggunakan nomor pusat pesan teks yang 
sama untuk mengirim pesan balasan. 

Orisinil dilampirkan di balasan: – Menetapkan apakah teks 
yang terdapat dalam pesan teks yang diterima akan 
disertakan di pesan balasan.

Koneksi pilihan: – Anda dapat mengirim pesan teks melalui 
jaringan GSM normal atau melalui GPRS, jika didukung 
oleh jaringan.

Untuk menambahkan pusat pesan baru, tekan , 
lalu pilih Peralatan > Pengaturan pesan > Pesan teks.... 
Tekan Pusat pesan, kemudian Baru. Tulis nama dan 
nomor untuk pusat pesan teks. Nomor tersebut 
diperoleh dari operator selular Anda. Pilih kotak pilihan 

Atur sebagai pusat standar: jika Anda ingin selalu 
menggunakan pusat pesan ini untuk pengiriman pesan 
teks.

Layanan pesan teks
Pesan teks dapat dikirim atau diterima meskipun 
panggilan suara atau data sedang berlangsung. Pesan 
dapat dibaca dari berbagai telepon selular yang memiliki 
kemampuan ini. Jika telepon yang akan menerima pesan 
sedang tidak aktif pada saat pengiriman, pusat pesan akan 
terus mengirimkannya sampai batas waktu pengiriman 
yang ditetapkan oleh jaringan tercapai.

Jika Anda ingin mengirim teks yang ditulis atau diedit di 
aplikasi lain, semua objek yang dibenamkan atau 
pemformatan teks akan hilang. Anda juga tidak dapat 
mengirim lampiran dalam pesan teks.

Pesan multimedia
Pesan multimedia dapat berisi teks, gambar, klip video, 
dan/atau klip suara.

Perlindungan hak cipta mungkin membuat beberapa 
gambar, nada dering dan materi lainnya tidak dapat 
disalin, dimodifikasi, dipindahkan atau dialihkan.
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Membuat pesan multimedia
1 Tekan , lalu pilih Pesan > Buat > Pesan multimedia.
2 Tulis nomor telepon penerima di kolom Untuk:. 

Tambahkan tanda titik koma (;) untuk memisahkan 
setiap penerima.
Jika penerima terdapat dalam Kontak, tekan . Pilih 
penerima dari daftar, kemudian tekan Tambah. Tekan 
Selesai setelah semua penerima dipilih.

3 Tulis pesan, kemudian tambahkan objek media. 
Gunakan bar peralatan atau perintah menu Sisipkan 
untuk menambahkan gambar, suara, atau video ke 
dalam pesan Anda. Lihat dibawah ini untuk rincian. Jika 
bar peralatan tidak terlihat, tekan  kemudian pilih 
Tampilan > Bar peralatan.

4 Setelah pesan siap, tekan Kirim.

Gbr. 18: Mengirim pesan multimedia 

Tip: Pesan multimedia dapat terdiri dari beberapa 
halaman. Untuk menambahkan halaman, tekan ikon 
bar peralatan , atau tekan , lalu pilih Sisipkan 
> Ganti halaman. Jika kursor berada di kolom Untuk:, Cc: 
atau Subyek: saat Anda menambahkan halaman, maka 
halaman baru tersebut akan menjadi halaman 
pertama pesan. Jika tidak, maka halaman baru akan 
ditambahkan setelah halaman pada posisi kursor. 
Ingat, setiap halaman hanya dapat berisi satu video 
atau satu klip suara. Namun demikian, Anda dapat 
memiliki beberapa halaman yang berisi klip video atau 
klip suara dalam satu pesan. Ukuran maksimum pesan 
multimedia yang didukung oleh smartphone Anda 
adalah 100 kB. Untuk membatasi isi pesan Anda, lihat 
pengaturan MMS, “Halaman Umum” pada 
halaman 66.

Untuk menambahkan gambar, suara, atau video 
yang sudah ada ke dalam pesan Anda, gunakan bar 
peralatan, atau tekan , lalu pilih Sisipkan > 
Gambar, Lagu atau Klip media. Pilih objek, kemudian 
tekan Sisipkan untuk menambahkannya ke dalam 
pesan. Ingat, jaringan selular biasanya membatasi 
ukuran pesan MMS. Jika foto yang dimasukkan 
melebihi batas ini, smartphone akan menyesuaikannya 
sehingga dapat dikirim sebagai MMS.
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Untuk membuat foto baru, lukisan atau klip suara 
untuk pesan Anda, gunakan bar peralatan, atau tekan 

, lalu pilih Sisipkan > Gambar/klip media baru, Sketsa 
baru atau Klip suara. Aplikasi yang diperlukan 
ditampilkan. Lihat “Mengambil gambar” pada 
halaman 83, “Mengedit gambar” pada halaman 89 
atau “Perekam suara” pada halaman 107 untuk 
rincian. Tekan Sisipkan untuk menambahkan objek ke 
dalam pesan.

Ingat, jika beberapa pilihan menu pada menu Peralatan 
tidak tersedia atau Anda mendapat pesan error saat 
mencoba menambahkan objek multimedia, kemungkinan 
pengaturan Anda terlalu dibatasi. Lihat pengaturan MMS, 
“Halaman Umum” pada halaman 66 untuk rincian.

Untuk mengubah posisi teks pada gambar atau video, 
pilih kolom teks, tekan , lalu pilih Peralatan > 
Susunan halaman > letakkan teks di sebelah kanan atau 
letakkan teks di sebelah kiri. (Tidak tersedia dalam Modus 
pembatasan:.)

Untuk memformat teks, pilih teks dengan meletakkan 
pena stylus pada teks tersebut, tekan , lalu pilih 
Peralatan > Teks format.... Anda juga dapat memilih 
format, sebelum mulai menulis. (Tidak tersedia dalam 
Modus pembatasan:.)

Untuk mengubah warna latar pesan, tekan , lalu 
pilih Peralatan > Atur warna latar.... Tekan kotak warna, 
kemudian pilih warna baru. (Tidak tersedia dalam 
Modus pembatasan:.) 

Untuk memberikan efek tambahan pada objek 
multimedia, pilih objek, tekan , lalu pilih Peralatan 
> Pengaturan transisi.... Anda dapat menetapkan berapa 
lama sebuah objek ditampilkan dan bagaimana objek 
baru akan ditampilkan. (Tidak tersedia dalam Modus 
pembatasan:.)

Tampilan pesan multimedia mungkin akan berbeda-beda, 
tergantung pada perangkat penerimanya.

Untuk menghapus objek multimedia dari pesan, 
pilih objek, tekan , lalu pilih Edit > Hapus. Pilih 
perintah yang sesuai.

Tip: Untuk menambahkan halaman baru ke dalam 
pesan multimedia, tekan  kemudian pilih Sisipkan 
> Ganti halaman. Jika kursor berada di kolom Untuk:, Cc: 
atau Subyek: saat Anda menambahkan halaman, maka 
halaman baru tersebut akan menjadi halaman 
pertama pesan. Atau, halaman baru akan ditambahkan 
setelah halaman pada posisi kursor.

Untuk menghapus halaman, buka halaman, tekan 
, lalu pilih Edit > Hapus > Halaman.

Untuk menentukan pilihan pengiriman pada pesan 
aktif, tekan , lalu pilih Peralatan > Pilihan 
pengiriman.... . Ingat, perubahan apapun yang Anda 
buat dalam dialog ini hanya berlaku pada pesan yang 
akan Anda kirim. Tetapkan berikut ini:
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Terima laporan: – (layanan jaringan) Pilih, jika Anda ingin 
menerima pemberitahuan saat pesan berhasil terkirim ke 
pusat pesan multimedia. 

Validitas pesan: – (layanan jaringan) Jika penerima pesan 
tidak dapat dijangkau dalam batas waktu pengiriman, 
pesan akan dihapus dari pusat pesan multimedia. Ingat, 
jaringan harus mendukung fitur ini. Waktu maksimum 
adalah batasan waktu maksimum yang diperbolehkan oleh 
jaringan.

Untuk melihat pesan sebelum mengirimnya, tekan , 
lalu pilih Pesan > Lihat dulu.

Bar peralatan
Jika bar peralatan tidak terlihat, tekan , kemudian pilih 
Tampilan > Bar peralatan. 

1 Mengambil foto atau merekam video.
2 Merekam klip suara atau memasukkan klip suara yang 

sudah ada.
3 Membuat sketsa gambar.
4 Menyisipkan salah satu gambar.
5 Menambahkan klip musik.
6 Menambahkan klip video.
7 Sisipkan halaman baru.

Menerima pesan multimedia
Pesan multimedia diterima dalam Kotak masuk, dan Anda 
dapat membuka, menjawab atau meneruskannya seperti 
halnya pesan lain.

Anda dapat menerima pesan multimedia berisi objek yang 
tidak didukung oleh smartphone ini, tetapi Anda tidak 
dapat menampilkannya. Namun demikian, Anda tetap 
dapat meneruskan pesan ini ke perangkat lain.

Penting: Objek pesan multimedia mungkin berisi 
virus atau dapat merusak perangkat atau PC 
Anda. Jangan buka lampiran jika Anda tidak 
mempercayai pengirimnya.

Untuk menyimpan objek multimedia yang dipilih, 
tekan , lalu pilih Peralatan > Simpan objek....

Untuk melihat rincian objek, tekan dua kali.

Untuk melihat daftar semua objek dalam pesan, 
tekan , lalu pilih Peralatan > Lihat objek.... Untuk 
menyimpan objek, pilih dan tekan Simpan. Untuk 
memutar objek, pilih dan tekan Buka.

Pengaturan pesan multimedia 
Perubahan apapun yang Anda buat pada pengaturan 
pesan multimedia hanya akan berlaku untuk pesan 
multimedia yang Anda terima dan kirim. Anda mungkin 
menerima pengaturan ini sebagai pesan khusus dari 
operator selular.
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Tekan  pada tampilan utama Pesan, kemudian pilih 
Peralatan > Pengaturan pesan > Pesan multimedia.... 
Tetapkan berikut ini:

Halaman Pengiriman
Jalur akses yang digunakan: – Pilih jalur akses Internet (IAP) 
yang akan digunakan untuk mengirim pesan. Untuk 
membuat IAP, lihat “Membuat pengaturan jalur akses 
Internet” pada halaman 124.

Homepage: – Tulis alamat pusat pesan multimedia.

Terima laporan: – Pilih, jika Anda ingin menerima 
pemberitahuan saat pesan berhasil terkirim ke tujuan yang 
diinginkan. Anda mungkin tidak dapat menerima laporan 
pengiriman pesan multimedia yang dikirim ke alamat 
e-mail.

Kirim pesan: – Anda dapat menentukan kapan pesan akan 
dikirim.

Validitas pesan: – (layanan jaringan) Jika penerima pesan 
tidak dapat dijangkau dalam batas waktu pengiriman, 
pesan akan dihapus dari pusat pesan multimedia. Ingat, 
jaringan harus mendukung fitur ini. Waktu maksimum 
adalah batasan waktu maksimum yang diperbolehkan oleh 
jaringan.

Halaman Pengambilan
Menerima pesan: – Pilih Segera ambil jika Anda ingin 
menerima pesan multimedia. Tunda mengambil jika Anda 
ingin pusat pesan multimedia menyimpan pesan untuk 
diambil di lain waktu. Pilih Tolak pesan jika Anda ingin 

menolak pesan multimedia. Pusat pesan multimedia akan 
menghapus pesan-pesan tersebut. Pilih Hanya dalam 
jaringan lokal, jika Anda tidak ingin menerima pesan 
multimedia saat menjelajah (roaming) di luar jaringan 
lokal. Dalam hal ini, pesan-pesan akan tersimpan pada 
server dan dapat diambil kemudian.

Menerima iklan: – Pilih, jika Anda ingin menerima pesan-
pesan iklan.

Membolehkan psn. anonim: – Pilih, jika Anda ingin tetap 
menerima pesan-pesan dari pengirim yang tidak dikenal.

Untuk menentukan jalur akses Internet, tekan , 
lalu pilih Peralatan > Pengaturan pesan > Pesan 
multimedia.... Tekan Pengaturan internet dan 
Berikutnya. Lihat “Membuat pengaturan jalur akses 
Internet” pada halaman 124 untuk rincian.

Halaman Umum
Modus multimedia – Pilih Modus pembatasan: untuk 
membatasi fitur pesan MMS dan membuat pesan lebih 
kompatibel dengan telepon lain. Pilihan pemformatan teks 
dan multimedia dibatasi. Pilih Modus panduan: untuk 
memungkinkan lebih banyak pilihan dengan peringatan 
saat pilihan dasar terlampaui. Pilih Modus bebas: untuk 
menggunakan rangkaian fitur lengkap dalam pesan MMS.
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Pesan pintar
Smartphone Anda dapat menerima berbagai jenis pesan 
pintar, pesan teks yang berisi data (disebut juga pesan 
Melalui Udara: OTA). Contohnya adalah pesan gambar, 
kartu nama, nada dering, atau entri kalender.

Selain itu, Anda dapat menerima nomor layanan pesan 
teks, nomor kotak suara, pengaturan profil untuk 
sinkronisasi remote, pengaturan jalur akses untuk browser, 
pesan multimedia atau e-mail, pengaturan skrip login jalur 
akses atau pengaturan e-mail sebagai pesan OTA 
(Over-The-Air).

Pesan layanan
Pesan layanan adalah informasi pemberitahuan, misalnya 
berita utama. Informasi tersebut mungkin berisi pesan teks 
atau penghubung. Untuk ketersediaan dan berlangganan, 
hubungi operator selular Anda.
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Kontak
Buka Meja > Kontak.

Anda dapat menggunakan Kontak untuk membuat, 
mengedit dan mengatur semua informasi kontak, seperti 
nomor telepon dan alamat.

Untuk informasi tentang proses sinkronisasi kontak 
dengan aplikasi PC yang kompatibel, lihat Buku Petunjuk 
PC Suite pada CD-ROM kemasan perangkat.

Melihat dan mencari kontak
Untuk melihat kartu kontak, tekan nama dalam 
daftar kontak. Tekan dua kali akan membuka kartu 
kontak untuk mengedit.

Tip: Tekan dua kali nomor telepon di jendela kanan 
untuk memanggil kontak. Dengan cara yang sama, 
Anda dapat mengirim e-mail, yakni dengan menekan 
dua kali alamat e-mail.

Untuk mencari kartu kontak, tekan huruf di baris 
terbawah yang sesuai dengan nama pada kartu yang 
akan Anda lihat. Misalnya, tekan sekali untuk melihat 
kontak dengan huruf awal M, dua kali untuk kontak 
dengan huruf awal N, dan tiga kali untuk kontak 
dengan huruf awal O. Atau, tekan , lalu pilih 
Tampilan > Kolom 'cari' untuk menampilkan kolom cari. 

Tulis nama kontak dalam kolom cari. Saat Anda 
menulis, daftar kontak akan berubah untuk 
menunjukkan kontak yang cocok.

Gbr. 19: Jendela utama kontak dengan kolom cari.

Untuk mengubah urutan susunan kontak, tekan  
kemudian pilih Tampilan > Sortir menurut, lalu pilih 
urutan yang diinginkan.

Membuat dan mengedit kontak
Untuk membuat kartu kontak, tekan Kontak baru, 
tekan kolom kosong lalu masukkan informasi. Lihat 
juga “Kolom kartu kontak” pada halaman 69.

Untuk mengedit kartu kontak, tekan dua kali kontak 
dalam daftar untuk membukanya, edit kartu seperti 
yang diperlukan, kemudian tekan Selesai.
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Untuk menghapus kartu kontak, pilih kontak, tekan 
, lalu pilih Kontak > Hapus. Ingat, kartu Anda 

sendiri tidak dapat dihapus. 

Untuk menambahkan sambungan cepat ke kontak, 
buka kontak dengan menekannya dua kali, lalu tekan 
kolom nomor telepon yang akan ditambahkan 
sambungan cepat. Tekan , pilih Peralatan > 
Tentukan sambungan cepat..., pilih nomor sambungan 
cepat, kemudian tekan Tentukan.

Untuk menetapkan nada dering khusus ke kontak, 
buka kontak dengan menekannya dua kali. Jika kolom 
Nada dering tidak terdapat pada kartu tersebut, tekan 
Tambah kolom, pilih kolom yang sesuai dari daftar, 
lalu tekan OK. Tekan dua kali kolom Nada dering. Pilih 
salah satu nada dering. Tekan Putar untuk 
mendengarkan nada tersebut.

Untuk menyisipkan gambar, buka kontak dengan 
menekannya dua kali, kemudian tekan dua kali posisi 
gambar pada kanan atas. Pilih gambar, lalu tekan 
Tambah untuk menambahkannya tanpa mengedit 
atau Edit untuk membuka gambar dalam editor 
gambar agar Anda dapat mengubahnya. Gunakan pena 
stylus atau tombol gulir untuk memilih bidang gambar 
yang akan dimasukkan. Gunakan bar peralatan untuk 
memperbesar, membalikkan atau memutar gambar, 
atau untuk menambahkan garis tepi berwarna pada 
gambar. Bila Anda puas dengan gambar tersebut, 
tekan Tambah untuk menambahkan gambar ke kartu 

kontak. Untuk menghapus gambar, tekan , lalu 
pilih Gambar > Hapus.

Untuk menampilkan format alamat yang benar dari 
negara atau wilayah asal Anda, tekan , pilih 
Peralatan > Format alamat..., lalu pilih negara atau 
wilayah Anda dari daftar. Pengaturan baru tersebut 
akan berlaku untuk semua kartu jika ditetapkan dari 
tampilan utama atau berlaku hanya untuk kartu yang 
sedang dibuka jika ditetapkan saat Anda mengedit 
sebuah kartu.

Untuk membuat atau mengedit kartu kontak SIM, 
tekan , lalu pilih Peralatan > Direktori SIM.... Tekan 
Baru atau pilih kontak, lalu tekan Edit. Kartu kontak 
SIM adalah kartu yang disimpan hanya dalam kartu 
SIM, bukan dalam memori smartphone.

Panjang nama dan nomor telepon yang dapat Anda 
masukkan sudah ditetapkan oleh kartu SIM. Misalnya, 
beberapa kartu SIM hanya memperbolehkan panjang 
maksimal 14 karakter.

Kolom kartu kontak
Untuk menambahkan kolom lainnya ke kartu 
kontak, buka kartu kontak tersebut, lalu tekan 
Tambah kolom. Pilih kolom yang diinginkan dari 
daftar. Untuk menghapus kolom tertentu, tekan 

, lalu pilih Kontak > Hapus kolom. Perubahan ini 
hanya akan mempengaruhi kartu yang sedang Anda 
ubah.
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Untuk mengubah nama kolom, pilih kolom, tekan 
, lalu pilih Kontak > Ubah nama kolom.... Tulis nama 

yang baru. Jika perintah menu Ubah nama kolom... 
tampil dalam warna redup, berarti Anda tidak dapat 
mengedit kolom tersebut.

Untuk mengubah template kartu kontak, tekan , 
lalu pilih Peralatan > Templet kartu.... Tekan Tambah 
kolom untuk menambahkan kolom baru, atau pilih 
salah satu kolom, lalu tekan Hapus kolom untuk 
menghapusnya. Ingat, tidak semua kolom dapat 
dihapus. Perubahan ini akan mempengaruhi semua 
kartu kontak, kecuali kartu kontak SIM. 

Mengirim kontak
Ingat, informasi kontak hanya dapat dikirim atau diterima 
dari perangkat yang kompatibel.

Untuk mengirim kartu kontak, tekan , lalu pilih 
Kontak > Kirim. Pilih metode pengiriman. Untuk 
mengirim kartu kontak Anda sendiri, pilih kartu 
Anda, lalu tekan Kirim. Pilih jenis pesan. Kartu kontak 
Anda dikirim sebagai kartu nama dalam format vCard. 
Untuk informasi lebih lanjut tentang pilihan 
pengiriman, lihat “Pesan” pada halaman 51 dan 
“Mengirim data melalui Bluetooth” pada halaman 156.

Untuk menyalin kontak ke kartu SIM, tekan , 
lalu pilih Kontak > Salin ke direktori SIM....

Untuk menyalin kontak kartu SIM satu per satu ke 
Kontak, tekan , lalu pilih Peralatan > Direktori 
SIM.... Pilih kontak, kemudian tekan Salin ke Kontak. 
Untuk menyalin semua kontak pada kartu SIM ke 
Kontak, tekan , lalu pilih Peralatan > Salin direktori 
SIM ke 'Kontak'.... Tekan Salin.

Tag suara
Bila Anda melampirkan tag suara ke kartu kontak, Anda 
dapat memanggil kontak tersebut menggunakan tag, 
yakni dengan mengaktifkan panggilan suara dan 
menyebutkan tag suara yang sudah direkam. Untuk 
informasi lebih lanjut, lihat “Panggilan dengan suara” 
pada halaman 42.

Untuk menetapkan tag suara ke kontak, buka 
kontak dengan menekannya dua kali. Tekan , lalu 
pilih Peralatan > Tambah kutipan suara.... Pilih nomor 
telepon yang akan ditambahkan tag suara, lalu tekan 
OK. Tekan Mulai. Setelah nada, ucapkan dengan jelas 
ke dalam mikrofon kata yang akan direkam sebagai 
tag suara. Setelah merekam, smartphone akan 
memutar rekaman tag tersebut lalu menyimpannya.

Untuk melihat daftar tag suara, tekan , lalu pilih 
Peralatan > Kutipan suara.... Daftar akan menampilkan 
semua kontak yang memiliki lampiran tag suara. Anda 
dapat menambahkan tag suara ke maksimal 50 nomor 
telepon.
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Untuk mengedit atau menghapus tag suara, tekan 
, lalu pilih Peralatan > Kutipan suara.... Tekan Ubah 

atau Hapus.

Grup kontak
Anda dapat menyusun kontak ke dalam berbagai grup, 
kemudian menambahkan nada dering untuk setiap grup.

Untuk membuat grup baru, tekan , lalu pilih Grup 
> Baru.... Tulis nama grup.

Untuk beralih di antara grup, tekan , lalu pilih 
Lihat grup. Pilih grup yang akan dilihat.

Untuk menambahkan kontak ke grup, pilih kontak, 
lalu tekan . Pilih Grup > Tambah ke grup..., pilih grup 
dengan menandai kotak pilihan, lalu tekan OK.

Untuk mengubah nama atau menghapus grup, tekan 
, pilih Grup > Atur grup..., pilih grup, kemudian pilih 

perintah yang sesuai. Ingat, Anda tidak dapat 
mengubah nama atau menghapus grup Semua nama 
kontak.

Untuk menambahkan atau mengjhapus anggota 
grup, pilih grup yang akan diubah, tekan , lalu pilih 
Grup > Edit grup.... Pilih kontak dari daftar di sebelah kiri 
untuk menambahkannya ke grup. Tekan Tambah. 
Untuk menghapus anggota grup, pilih kontak dari 
daftar di sebelah kanan kemudian tekan Hapus.

Untuk menambahkan nada dering grup , buka 
aplikasi Profil. Pilih profil yang akan ditetapkan untuk 
grup, lalu tekan Personalisa-si, kemudian Tanda 
untuk. Pilih grup, kemudian tekan OK. Bila anggota 
grup akan memanggil atau mengirim pesan kepada 
Anda, smartphone ini akan membunyikan dering atau 
nada peringatan yang dipilih (jika nomor penelepon 
dikirim bersama panggilan dan smartphone Anda 
mengenali nomor tersebut). Untuk penelepon lainnya 
digunakan profil Diam. Untuk informasi lebih lanjut 
tentang profil, lihat “Profil” pada halaman 49.
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Kalender
Buka Meja > Kalender.

Pada aplikasi Kalender, Anda dapat membuat serta 
memeriksa jadwal aktivitas dan janji. Anda juga dapat 
mengatur alarm untuk semua entri kalender.

Anda dapat melakukan sinkronisasi kalender dengan 
Microsoft Outlook 98/2000/2002/2003, Microsoft Outlook 
Express, Lotus Notes 5.0/6.0 atau Lotus Organizer 5.0/6.0, 
jika smartphone Anda dihubungkan ke PC yang 
kompatibel. Untuk informasi tentang sinkronisasi, lihat 
Buku Petunjuk PC Suite pada CD-ROM.

Tampilan Hari 

Gbr. 20: Tampilan Hari

Jika Anda menggunakan tema standar, tanggal hari ini 
tampil dalam bingkai, tanggal yang berisi jadwal aktivitas 
ditandai dengan huruf tebal dan tanggal yang dipilih 
disorot dalam warna coklat.

Aktivitas pada tanggal yang dipilih akan muncul di jendela 
kanan.

Untuk membuka salah satu tanggal yang terlihat di 
kiri jendela, tekan tanggal tersebut. Untuk berpindah 
ke tahun sebelum atau berikutnya, tekan  atau  di 
sebelah tahun pada bagian atas jendela kiri. Dengan 
cara yang sama Anda juga dapat berpindah ke bulan 
sebelum atau berikutnya, tekan tombol tanda panah di 
sebelah nama bulan pada bagian bawah jendela kiri.

Untuk membuka tanggal tertentu, tekan Ke tanggal, 
kemudian tentukan hari, bulan, dan tahun.

Untuk membuka tanggal sekarang, tekan Ke hari ini.
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Mengelola entri
Untuk membuat entri kalender baru, pilih tanggal 
dalam tampilan hari, kemudian tekan Catatan baru. 
Jika entri aktivitas tersebut untuk sepanjang hari, pilih 
kotak pilihan Catatan sepanjang hari:, kemudian 
tentukan tanggal mulai dan selesai untuk entri 
tersebut. 

Jika entri bukan untuk catatan sepanjang hari, 
tentukan tanggal mulai dan selesainya. Untuk 
memberikan pengingat pada entri, pilih kotak pilihan 
Alarm:. Tentukan hari dan waktu alarm berbunyi. 
Untuk mengulang entri, tekan Ulangi. Tentukan 
frekuensi pengulangan dan tanggal berakhirnya. 
Untuk membuat entri pribadi, sehingga rinciannya 
tidak ditampilkan kepada pengguna PC lain sewaktu 
kalender Anda disinkronisasikan dengan kalender PC 
jaringan, pilih Sinkronisasi:Pribadi. Bila Anda sudah 
menetapkan semua rincian yang diperlukan, tekan 
Selesai.

Untuk mengedit entri, tekan dua kali, kemudian 
masukkan perubahan. Kemudian tekan Selesai.

Untuk mengirim entri kalender, tekan , lalu pilih 
Catatan > Kirim. Pilih metode pengiriman.

Untuk membuat entri sementara, tekan , lalu 
pilih Catatan > Tandai sebagai sementara. Entri 
sementara ditandai dengan warna redup dalam daftar 
entri.

Untuk membuat entri pribadi rahasia agar rincian 
entri tidak terlihat oleh orang lain saat Anda 
melakukan sinkronisasi kalender dengan kalender PC 
jaringan, tekan , lalu pilih Catatan > Tandai sebagai 
pribadi.

Untuk menghapus entri, tekan , lalu pilih Edit > 
Hapus. Untuk menghapus sejumlah entri, tekan , 
lalu pilih Peralatan > Hapus catatan.... Tentukan batas 
waktu untuk entri yang akan dihapus.

Untuk menetapkan pengaturan standar entri, tekan 
, lalu pilih Peralatan > Template catatan.... Pilih jenis 

entri yang biasa Anda gunakan.

Untuk melihat catatan agenda, tekan , lalu pilih 
Tampilan > Catatan agenda.

Untuk mencari entri, tekan , lalu pilih Edit > 
Cari.... Tulis teks pada kolom cari. Anda dapat menekan 
Pilihan, lalu menentukan rentang waktu pencarian. 
Tekan Cari untuk memulai pencarian.
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Tampilan Minggu

Gbr. 21: Tampilan Minggu

Tampilan minggu akan menunjukkan jam yang telah 
ditetapkan untuk minggu yang dipilih dengan bar. Kotak 
waktu yang dipilih tampil dalam bingkai.

Untuk membuka tampilan minggu, tekan , lalu 
pilih Lihat > Minggu, atau tekan .

Untuk memilih kotak waktu, tekan kotak tersebut. 
Tekan kotak waktu dua kali jika Anda ingin 
menambahkan entri baru. Untuk beralih ke minggu 
sebelum atau berikutnya, tekan tanda panah di sudut 
atas tampilan minggu.

Jika kotak waktu berisi entri, maka bidang bagian 
bawah layar akan menunjukkan rincian entri tersebut. 
Jika terdapat lebih dari satu entri dalam satu kotak 
waktu, maka angka di sudut kanan menunjukkan 
jumlah entri pada kotak waktu tersebut. Misalnya, 
1/3 berarti ada tiga entri pada kotak waktu dan Anda 
sedang melihat rincian pertama dari ketiga entri ini.

Untuk melihat semua entri pada kotak waktu yang 
berisi lebih dari satu entri, tekan , atau tekan 
angka entri di sudut kanan bawah.

Ikon
Berikut ini adalah simbol-simbol yang terdapat dalam 
aplikasi Kalender:

 – Entri dengan alarm

 – Aktivitas sepanjang hari

 – Entri berulang

 – Entri dengan catatan
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Agenda
Buka Meja > Agenda.

Melalui aplikasi Agenda, Anda dapat membuat dan 
menyusun daftar tugas.

Untuk membuat tugas baru, tekan Agenda baru. Isi 
kolom. Untuk mengatur pengingat catatan, pilih 
Berlaku sampai: dan Alarm: kemudian tentukan hari dan 
waktu alarmberbunyi. Untuk membuat tugas pribadi, 
sehingga rinciannya tidak ditampilkan kepada 
pengguna PC lain sewaktu kalender Anda 
disinkronisasikan dengan kalender PC jaringan, pilih 
Sinkronisasi:Pribadi. Untuk mengulangi tugas, tekan 
Ulangi. Tetapkan frekuensi pengulangan, dan 
perkiraan tanggal selesai.

Untuk mengedit catatan, tekan dua kali, kemudian 
buat perubahan.

Untuk menandai tugas yang telah selesai, tekan , 
lalu pilih Catatan agenda > Tandai sebagai sudah selesai.

Untuk menghapus catatan agenda, pilih catatan, 
kemudian tekan Hapus. Untuk menghapus sejumlah 
catatan, tekan , lalu pilih Peralatan > Hapus 
catatan agenda.... Tentukan batas waktu untuk entri 
yang akan dihapus.

Untuk menetapkan pengaturan standar untuk 
catatan, tekan , lalu pilih Peralatan > Template 
catatan agenda.... Pilih jenis catatan yang biasa Anda 
gunakan.

Mengelompokkan catatan 
agenda

Untuk menambahkan catatan ke dalam group, pilih 
catatan agenda, lalu tekan . Pilih Grup > Tambah ke 
grup..., pilih grup, lalu tekan OK.

Untuk membuat grup baru, tekan , lalu pilih Grup 
> Baru.... Tulis nama grup.

Untuk beralih di antara grup, tekan , lalu pilih 
Lihat grup. Pilih grup yang akan dilihat.

Untuk mengubah nama atau menghapus grup, tekan 
, pilih Grup > Atur grup..., pilih grup, kemudian pilih 

perintah yang sesuai.
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Ikon
Berikut ini adalah simbol-simbol yang terdapat dalam 
aplikasi Agenda:

 – Catatan agenda

 – Catatan agenda yang sangat penting

 – Catatan agenda yang tidak begitu penting

 – Catatan agenda dengan alarm

 – Catatan agenda yang diulang
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Web
Buka Meja > Web.

Untuk dapat terhubung ke World Wide Web:
• Jaringan selular yang Anda gunakan harus mendukung 

panggilan data atau GPRS.
• Layanan data harus diaktifkan untuk kartu SIM Anda.
• Anda harus mengkonfigurasikan jalur akses Internet 

dan pengaturan sambungan Internet. Untuk informasi 
lebih lanjut, lihat “Pengaturan Internet” pada 
halaman 124.

Gbr. 22: Web

Layanan selular Plug and play
Smartphone Anda mendukung layanan selular plug and 
play, yang misalnya, memungkinkan Anda mendaftar 
berlangganan layanan data dan menerima pengaturan 
yang diperlukan. Ingat, untuk dapat menggunakan fitur ini, 
operator jaringan Anda harus mendukung fitur tersebut. Di 
beberapa jaringan, fitur ini mungkin disediakan tanpa 
berlangganan layanan data.

Saat Anda mencoba terhubung ke World Wide Web namun 
tidak berlangganan layanan data, atau jalur akses Internet 
atau pengaturan sambungan Internet tidak diterima, maka 
smartphone akan meminta Anda untuk mendaftar 
berlangganan layanan ini atau membuat sendiri 
pengaturan. 

Jika Anda memilih untuk mendaftar, Anda akan diarahkan 
ke halaman situs layanan untuk mendapatkan pengaturan, 
(MMS, WAP/GPRS, e-mail dan Internet) dengan mengikuti 
petunjuk yang diberikan.

Berdasarkan jenis kartu SIM yang digunakan, perangkat 
Anda mungkin dapat menambahkan pengaturan yang 
benar secara otomatis untuk browsing WWW dan MMS.
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Menggunakan browser web
Untuk membuka halaman web, tulis alamat web di 
kolom alamat di bagian bawah layar, kemudian tekan 

 atau tekan bagian tengah tombol gulir. Jika Anda 
telah mengatur halaman situs, tekan  untuk 
mengunjungi halaman web tersebut. Jika Anda 
memiliki penunjuk halaman (bookmark) yang akan 
Anda kunjungi, tekan , pilih penunjuk, kemudian 
tekan untuk membuka halaman web. 

Tip: Saat Anda menulis, alamat web yang cocok 
dengan alamat sebelumnya (jika ada) akan 
ditampilkan pada daftar di atas kolom alamat. Tekan 
salah satu alamat dalam daftar tersebut untuk 
memilihnya.

Jika sebelumnya Anda memilih kotak pilihan Tanya sebelum 
sambung: saat mengatur sambungan Internet, dialog yang 
meminta konfirmasi Anda untuk sambungan atau 
mengubah jalur akses akan ditampilkan. Anda dapat 
memilih untuk tidak menampilkan dialog ini saat 
sambungan dibuat. Lihat “Pengaturan sambungan 
Internet” pada halaman 128.

Rentang waktu untuk pembuatan sambungan Internet 
berbeda-beda tergantung konfigurasi dan beban jaringan. 

Beberapa content web seperti animasi atau video mungkin 
akan menggunakan seluruh memori perangkat yang 
tersedia dan mempengaruhi pengoperasian perangkat. 
Untuk kondisi masalah, lihat “Mengatasi masalah” pada 
halaman 166.

Jika halaman web dan komponennya dienkripsi oleh 
protokol pengaman, ikon pengaman  akan muncul 
pada bar alamat.

Untuk menampilkan halaman web memenuhi 
bidang layar, tekan , lalu pilih Tampilan > Layar 
penuh atau tekan . Untuk kembali ke ukuran layar 
normal, tekan  atau pilih .

Untuk mengaktifkan atau menonaktifkan animasi 
flash, tekan , lalu pilih atau hapus Tampilan > 
Aktifkan flash. Menonaktifkan animasi flash dapat 
mempercepat browsing.

Untuk mengatur volume suara, tekan , lalu pilih 
Peralatan > Volume....

Tip: Tekan  untuk menggunakan fungsi 
pembesaran.

Untuk menyimpan halaman web pada smartphone, 
tekan  lalu pilih File > Simpan halaman web.... Anda 
dapat melihat kembali halaman web di lain waktu 
tanpa harus terhubung ke Internet.

Untuk membuka jendela baru, tekan , lalu pilih 
File > Jendela baru. Jumlah jendela yang terbuka akan 
tergantung pada, dan dibatasi oleh, memori yang 
tersedia.

Untuk beralih di antara jendela yang terbuka, tekan 
, atau tekan , pilih Lihat, kemudian pilih jendela 

yang akan Anda buka.
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Untuk menutup jendela tambahan, tekan , lalu 
pilih File > Tutup > Jendela sekarang atau Semua jendela.

Untuk mengakhiri sambungan Internet, tekan , 
lalu pilih File > Putuskan.

Untuk menampilkan halaman web yang sudah 
di-download tanpa mengakses web, tekan , lalu 
pilih File > Browse offline.

Navigasi
Tip: Tekan terus stylus pada halaman Web untuk 
membuka menu yang menunjukkan atau 
menyembunyikan gambar, mengaktifkan atau 
menonaktifkan animasi flash, navigasi, dan berbagai 
fungsi lain. Isi menu ini bervariasi.

Untuk menjelajahi halaman web, tekan tombol dan 
penghubung yang bergaris bawah pada tampilan, 
tekan  atau  untuk mengakses halaman web 
yang terakhir kali dikunjungi,  untuk menampilkan 
kembali halaman web, atau  untuk menghentikan 
proses menampilkan halaman web. Cara lain, gunakan 
perintah dalam menu Kendalikan.

Tip: Anda dapat menggunakan alamat web dalam 
kotak teks atau dokumen sebagai penghubung ke 
halaman web. Tekan alamat, atau letakkan kursor di 
antaranya dengan menggunakan tombol gulir; 
sehingga menjadi penghubung dengan ikon kecil. 
Tekan ikon untuk mengakses situs web jika Anda 
memiliki sambungan Internet aktif.

Tip: Anda memiliki beberapa ikon lain yang dapat 
dilihat pada bar alamat jika tombol perintah 
tersembunyi: tekan , pilih Tampilan, dan pastikan 
Bar perintah tidak dipilih.

Untuk kembali ke halaman situs Anda, tekan  
atau tekan , lalu pilih Kendalikan > Situs. 

Untuk mengatur halaman situs baru, tekan , lalu 
pilih Edit > Atur situs....

Untuk menambahkan penunjuk ke halaman web 
yang sedang ditampilkan, tekan , lalu pilih Edit > 
Tambah penunjuk. Untuk informasi lebih lanjut tentang 
penunjuk situs, lihat “Penunjuk (Bookmark)” pada 
halaman 80.

Untuk membuka halaman cari, tekan , lalu pilih 
Kendalikan > Halaman cari. Untuk menentukan 
halaman cari lihat “Alamat halaman web” pada 
halaman 81.

Untuk menampilkan gambar halaman web, tekan 
, lalu pilih Tampilan > Tampilkan gambar.

Catatan: Karakter teks kemungkinan tidak dapat 
ditampilkan dengan benar pada halaman web yang 
menggunakan bahasa berbeda. Anda bisa saja 
membuat halaman web lebih mudah dibaca dengan 
memilih pengkodean karakter lain. Tekan , lalu 
pilih Peralatan > Penyandian karakter. Pilih jenis bahasa 
yang paling sesuai dengan bahasa halaman web yang 
sedang Anda lihat.



Hak cipta © 2005 Nokia. Semua hak dilindungi undang-undang.

W
eb

80

Penunjuk (Bookmark)
Tampilan Penunjuk berisi daftar penghubung halaman web 
dalam folder yang berhubungan. Anda dapat membuka 
halaman web dengan menekan dua kali penunjuk dalam 
daftar tersebut.

Smartphone Anda mungkin memiliki penunjuk untuk situs 
yang tidak berhubungan dengan Nokia. Nokia tidak 
menjamin atau mendukung situs-situs tersebut. Jika Anda 
memilih untuk mengaksesnya, maka lakukan tindakan 
yang sama untuk pengamanan atau materi situs, seperti 
yang akan Anda lakukan waktu mengakses situs Internet 
manapun.

Untuk melihat semua penunjuk, tekan  pada bar 
alamat, atau tekan , lalu pilih Lihat > Penunjuk.

Untuk mengedit nama atau alamat penunjuk, pilih 
penunjuk, tekan , lalu pilih Penunjuk > Edit....

Untuk menambahkan penunjuk, tekan Tambah 
penunjuk. Tulis nama penunjuk, kemudian tentukan 
alamat web atau lokasi file.

Tip: Jika tombol bar perintah tidak terlihat, tekan , 
lalu pilih Tampilan > Bar perintah.

Untuk pindah ke folder sebelumnya dalam hirarki 
folder, tekan Naik satu tingkat.

Untuk membuat folder baru atau mengubah nama 
folder, tekan , lalu pilih Penunjuk > Folder baru... 
atau Ubah nama folder....

Melihat halaman, memori sementara 
(cache), perangkat lunak pendukung 
(plug-in), riwayat dan rincian 
download
Cache adalah lokasi memori yang digunakan untuk 
menyimpan data sementara. Jika Anda mencoba 
mengakses atau sudah mengakses informasi rahasia yang 
memerlukan sandi, kosongkan cache setelah setiap 
penggunaan. Informasi atau layanan yang telah Anda 
akses akan disimpan dalam cache. 

Untuk mengosongkan cache, tekan , pilih 
Peralatan > Rincian cache, kemudian tekan Hapus.

Untuk melihat informasi tentang halaman yang 
ditampilkan, tekan , lalu pilih Peralatan > Rincian 
halaman.

Untuk melihat informasi tentang halaman yang 
telah Anda kunjungi, tekan , lalu pilih Kendalikan 
> Daftar riwayat.... Anda dapat mengunjungi halaman 
web dengan menekan Buka. Untuk mengosongkan 
daftar riwayat, tekan Hapus semua.

Untuk melihat informasi tentang memori cache, 
tekan , pilih Peralatan > Rincian cache. Memori 
cache adalah lokasi penyimpanan sementara halaman 
web yang Anda kunjungi. Untuk mengosongkan 
cache, tekan Hapus.
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Untuk menampilkan perangkat lunak pendukung 
bagi web browser yang telah diinstal, tekan , lalu 
pilih Peralatan > Rincian sambungan. Plug-in dapat 
menampilkan dokumen yang web browser sendiri tidak 
dapat menampilkannya, seperti klip multimedia. Anda 
dapat mendownload plug-in dari web.

Untuk melihat rincian download yang sedang 
berlangsung, tekan , lalu pilih Kendalikan > 
Download....

Pengaturan browser web
Untuk mengubah pengaturan browser web, tekan 

, lalu pilih Peralatan > Pengaturan.... Sebuah dialog 
dengan empat halaman akan terbuka. Tetapkan 
berikut ini:

Halaman Umum
Ukuran cache maksimum (kB): – Tetapkan jumlah memori 
internal yang akan Anda gunakan sebagai lokasi 
penyimpanan sementara untuk mempercepat akses ke 
halaman web.

Perlihatkan frame: – Beberapa halaman web terbagi dalam 
beberapa frame, yang menyulitkan pembacaan. Hapus 
untuk menonaktifkan frame. Ingat, akan banyak halaman 
yang tidak dapat berfungsi dengan benar, jika Anda 
menonaktifkan frame.

Penyandian karakter standar: – Memilih unit karakter 
standar.

Alamat halaman web
Akhiran alamat web: – Jika Anda menuliskan akhiran URL di 
sini (misalnya: .com, .org, .net) dari alamat web yang 
paling sering dikunjungi, Anda dapat mengabaikannya 
saat menulis alamat dalam kolom alamat URL.

Lokasi situs: – Alamat halaman situs yang Anda gunakan.

Lokasi halaman cari: – Alamat halaman cari yang Anda 
gunakan.

Isi jendela baru: – Halaman web yang akan terbuka saat 
Anda menekan , kemudian pilih File > Jendela baru.

Halaman Plug-in
Aktifkan sambungan – Pilih untuk memperluas 
fungsionalitas browser dengan plug-in. 

Aktifkan JavaScript – Berbagai fungsi JavaScript digunakan 
pada sebagian besar situs web. Untuk menampilkan 
halaman web dengan benar, pilih pilihan ini.

Halaman pribadi
Memperbolehkan pengarahan-ulang otomatis: – Pilih untuk 
mengaktifkan pengarahan-ulang secara otomatis ke 
alamat web baru, jika Anda mencoba untuk membuka 
halaman lama dengan perintah pengarahan-ulang.

Aktifkan jendela pop-up: – Pilih untuk membuka secara 
otomatis semua jendela popup yang tidak diminta.
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Terima cookie: – Umumnya halaman web menyimpan data 
pada smartphone Anda dalam file-file yang disebut 
‘cookie’. Gunakan pengaturan ini untuk menetapkan 
apakah akan menerima cookie, dan jika Anda 
menerimanya, apakah Anda memerlukan pemberitahuan 
sebelum cookie disimpan atau langsung menerimanya.

Semakin lama cookie yang tersimpan akan semakin 
banyak, dan dapat mengambil sejumlah besar kapasitas 
memori perangkat Anda. Anda dapat meluangkan ruang 
memori dengan menghapus cookie yang tersimpan di 
dalamnya. Untuk menghapus cookie, tekan , lalu pilih 
Peralatan > Hapus cookie. Tekan Hapus.
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Kamera 
Anda dapat mengambil gambar dan video dengan Kamera. 
Anda dapat melihat dan mengubah gambar dengan 
Gambar, kemudian mengirim gambar-gambar Anda 
sebagai pesan multimedia. Video dapat dilihat dan dikirim 
sebagai pesan multimedia melalui aplikasi RealPlayer.

Untuk beralih antara kamera dan modus perekam 
kamera, tekan gambar yang sesuai di bagian kiri layar.

Untuk membuka aplikasi Kamera, tekan dua kali 
Kamera dalam Meja, atau tekan Ke Kamera dalam 
aplikasi Gambar.

Untuk membuka aplikasi Gambar, tekan Ke Gambar 
dalam modus kamera atau tekan dua kali Gambar 
dalam Meja.

Untuk membuka RealPlayer, tekan Ke RealPlayer 
dalam modus perekam kamera.

Untuk membuka Kamera dalam RealPlayer, tekan Ke 
Kamera.

Modus kamera
Lensa kamera berada di bagian belakang smartphone. 
Layar berfungsi sebagai pembidik gambar.

Multimedia smartphone Nokia 7710 mendukung 
pengambilan gambar Megapiksel (1152 x 864 piksel) dan 

ukuran video QCIF (176 x 144 piksel). Resolusi gambar 
dalam buku petunjuk ini mungkin tampil berbeda.

Mengambil gambar
Untuk mengambil gambar, arahkan pada subjek 
Anda, kemudian tekan bagian tengah tombol gulir, 
atau tekan Ambil. Jika pengaturan Pratinjau aktif, 
Anda dapat melihat gambar untuk menentukan 
apakah akan menyimpannya atau tidak. Untuk 
menyimpan gambar, tekan Simpan. Foto akan 
tersimpan dalam folder yang ditampilkan pada area 
kecil di layar. Untuk mengirim gambar sebagai 
lampiran pesan e-mail, pesan multimedia, atau untuk 
menggunakan sambungan Bluetooth, tekan Kirim. 
Untuk membuang gambar tanpa menyimpannya, 
tekan Hapus

Gbr. 23: Mengambil gambar
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Tip: Di sudut kanan atas pembidik gambar, Anda dapat 
melihat jumlah gambar yang masih dapat diambil 
dengan memori yang tersedia. Tanda bintang 
menunjukkan tingkat kualitas gambar. Tekan bidang 
tersebut untuk membuka pengaturan Kamera.

Untuk memperkecil atau memperbesar subjek 
sebelum pengambilan gambar, tekan Perbesar atau 
Perkecil, atau tekan  dan  pada tombol gulir.

Modus Perekam kamera
Untuk beralih ke modus Perekam kamera, tekan ikon 
di kiri layar.

Untuk merekam video, arahkan pada subjek Anda, 
lalu tekan bagian tengah tombol gulir, atau tekan 
Rekam. Untuk berhenti, tekan Berhenti.

Waktu rekaman maksimal adalah satu jam untuk setiap 
klip.

Tip: Di sudut kanan atas pembidik gambar, Anda dapat 
melihat tingkat kualitas video yang dipilih dan sisa 
waktu untuk merekam dengan memori yang tersedia. 
Tekan bidang tersebut untuk membuka pengaturan 
Kamera.

Pengaturan kamera
Untuk mengedit pengaturan kamera, tekan , lalu 
pilih Peralatan > Pengaturan.... Tetapkan berikut ini:

Halaman umum
Pengaturan ini akan mempengaruhi pengambilan gambar 
dan perekaman video.

Kontras: – Mengatur kontras gambar atau video seperti 
yang diinginkan. Pengaturan ini akan mempengaruhi 
gambar pada pembidik gambar dan gambar yang diambil.

Terangnya: – Mengatur kecerahan gambar atau video 
seperti yang diinginkan. Pengaturan ini akan 
mempengaruhi gambar pada pembidik gambar dan 
gambar yang diambil.

Memori digunakan: – Memilih memori internal atau kartu 
memori sebagai tempat penyimpanan gambar dan video.

Halaman gambar
Kualitas gambar: - Ditunjukkan dengan tanda bintang pada 
sudut pembidik gambar. Semakin baik kualitas video, 
semakin banyak memori yang digunakan oleh gambar.
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Nama gambar standar: – Menetapkan nama untuk gambar 
yang diambil. Sesuai standar, gambar akan dinamai dalam 
format ‘Gambar’. Misalnya, jika Anda menetapkan ‘Beach’ 
sebagai nama standar, Kamera akan memberi nama 
‘Beach’ ke semua gambar yang diambil, ‘Beach(01)’, 
‘Beach(02)’ dan seterusnya, sampai Anda mengubah 
kembali pengaturan.

Lihat dulu sebelum menyimpan: – Jika pilihan ini dipilih, 
Anda dapat melihat gambar yang sudah diambil dan 
memutuskan untuk menyimpannya atau tidak. Jika pilihan 
ini tidak dipilih, semua gambar yang Anda ambil akan 
disimpan secara otomatis tanpa kesempatan untuk 
melihatnya dulu.

Halaman video
Kualitas: - Ditunjukkan dengan tanda bintang pada sudut 
pembidik gambar. Semakin baik kualitas video, semakin 
banyak memori yang digunakan untuk menyimpan file 
video.

Nama video standar: – Menetapkan nama untuk video yang 
diambil. Sesuai standar, video akan dinamai sebagai 
'videobaru’. Misalnya, jika Anda menetapkan ‘Beach’ 
sebagai nama standar, maka video selanjutnya akan 
dinamai sebagai ‘Beach(01)’, ‘Beach(02)’ dan seterusnya, 
sampai Anda mengubah kembali pengaturan.

Tips untuk mengambil foto yang 
bagus
Berikut adalah beberapa tips untuk memperoleh hasil 
terbaik dari kamera smartphone.

Kualitas gambar
Gunakan kualitas gambar yang diinginkan. Kamera ini 
memiliki tiga modus kualitas gambar (Biasa, Normal dan 
Tinggi). Gunakan pengaturan Tinggi untuk memastikan 
bahwa kamera akan menghasilkan kualitas gambar terbaik 
yang tersedia. Namun ingat, kualitas gambar yang lebih 
baik akan memerlukan tempat penyimpanan yang lebih 
besar. Untuk lampiran MMS dan e-mail, sebaiknya 
gunakan pengaturan Normal atau Biasa. Anda dapat 
menetapkan kualitas dalam Peralatan > Pengaturan..., 
kemudian tingkat kualitas ditunjukkan di sudut kanan atas 
pada pembidik gambar.

Latar belakang
Gunakan latar belakang sederhana. Untuk potret dan 
gambar lain dengan orang sebagai subjek, hindarkan 
pengambilan di depan latar belakang yang berantakan dan 
padat, karena dapat mengurangi fokus subjek tersebut. 
Pindahkan posisi kamera atau subjek, bila kondisi di atas 
tidak dapat dihindari. 
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Efek kedalaman
Saat mengambil gambar panorama dan pemandangan, 
Anda dapat menambahkan efek kedalaman pada gambar, 
yakni dengan menempatkan objek ke dalam latar depan. 
Namun ingat, objek latar depan yang terlalu dekat ke 
kamera akan menjadi buram.

Kondisi cahaya
Mengatur sumber, jumlah dan arah cahaya dapat 
mengubah foto secara dramatis. Berikut adalah beberapa 
kondisi cahaya yang umum:
• Sumber cahaya di belakang subjek. Cobalah hindari 

memotret subjek Anda di depan sumber cahaya yang 
kuat. Jika sumber cahaya berada di belakang subjek 
atau terlihat pada layar, gambar yang dihasilkan 
mungkin memiliki kontras yang lemah, mungkin terlalu 
gelap dan mungkin berisi efek cahaya yang tidak 
dikehendaki.

• Cahaya samping pada subjek. Cahaya kuat dari 
samping akan memberikan efek dramatis namun 
mungkin menjadi terlalu terang sehingga menimbulkan 
terlalu banyak kontras. 

• Sumber cahaya di depan subjek. Kondisi ini biasanya 
dapat digunakan kecuali jika cahaya matahari yang 
terlalu kuat membuat orang yang difoto memicingkan 
matanya. Kontras juga dapat terlalu tinggi.

• Pencahayaan optimal terdapat dalam kondisi dengan 
cahaya lembut yang redup, misalnya, pada saat hari 
berawan dan cerah sebagian atau pada hari cerah di 
bawah bayangan pohon. 
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Gambar
Gunakan Gambar untuk melihat dan memodifikasi gambar. 
Anda dapat mengambil foto melalui Kamera, menampilkan 
dan memodifikasinya dengan Gambar, kemudian mengirim 
gambar Anda sebagai pesan multimedia. Anda juga dapat 
mengedit foto yang diambil melalui kamera, atau 
membuat gambar sketsa baru, yang berisi teks dan bentuk 
geometris.

Untuk membuka aplikasi Gambar, tekan dua kali 
Gambar pada Meja, atau tekan Ke Gambar dalam 
aplikasi Kamera.

Untuk membuka aplikasi Kamera, tekan Ke Kamera 
dalam aplikasi Gambar.

Aplikasi Gambar mendukung beberapa format file berikut: 
JPEG, GIF 87a/89a, GIF animasi, TIFF/F, PNG, BMP dan 
WBMP. Aplikasi Gambar tidak secara otomatis mendukung 
semua variasi format file.

Aplikasi Gambar terbagi dalam tiga tampilan yang 
berlainan, masing-masing memiliki perintah yang berbeda:
• Pada tampilan daftar Anda dapat menyalin, 

memindahkan, menghapus, dan mengirim gambar yang 
tersimpan dalam smartphone ini. Anda juga dapat 
membuat gambar sketsa baru. Gambar tersebut dapat 
ditampilkan sebagai gambar kecil (thumbnail) atau 
daftar nama file. Tekan  untuk beralih antara 
thumbnail dan daftar.

• Pada layar penampil, yang akan terbuka saat Anda 
menekan dua kali salah satu gambar dalam tampilan 
daftar, Anda dapat melihat gambar tersebut.

• Pada tampilan editor yang akan terbuka bila Anda 
menekan  lalu memilih Gambar > Buka untuk 
mengedit dalam layar penampil gambar, Anda dapat 
memodifikasi dan mengubah gambar.

Melihat gambar
Untuk membuka gambar yang akan ditampilkan, 
tekan dua kali pada gambar dalam daftar. Gambar 
akan ditampilkan dalam layar penampil gambar.

Untuk membuka gambar berikutnya atau 
sebelumnya yang akan ditampilkan, tekan , lalu 
pilih Gambar > Berikutnya atau Sebelumnya, atau tekan 
tombol gulir kiri atau kanan.

Untuk memperbesar atau memperkecil gambar yang 
ditampilkan, tekan , lalu pilih Tampilan > Rasio 
Pembesaran. Pilih tingkat pembesaran yang diinginkan.
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Mengatur gambar dan folder
Untuk melihat informasi rinci tentang gambar, pilih 
gambar, tekan  lalu pilih Peralatan > Rincian. 
Informasi berikut ditampilkan:

Nama: – Nama gambar. Anda dapat mengubah nama dasar 
standar dalam aplikasi Kamera: tekan  lalu pilih 
Peralatan > Pengaturan.... Edit nama dalam kolom Nama 
gambar standar:.

Jenis: – Format file gambar. Jika format gambar tidak 
didukung, pesan Tidak dikenal akan muncul di layar.

Ukuran: – ukuran file dalam byte (B).

Tanggal: dan Waktu: – Waktu gambar dimodifikasi terakhir.

Lebar: dan Tinggi: – Resolusi gambar dalam piksel.

Tip: Resolusi adalah besaran yang menyatakan tingkat 
ketajaman dan kejernihan gambar. Resolusi adalah 
jumlah titik-titik (piksel) pada gambar atau tampilan. 
Semakin banyak piksel, semakin jelas gambar tersebut. 
Resolusi biasanya diukur dalam piksel, misalnya 
640x480=300 kilopiksel (kpix)=0,3 megapiksel (Mpix).

Dilindungi: – Menunjukkan bahwa gambar dilindungi 
secara teknis.

Hanya dibaca: – Jika Anda mencentang kotak pilihan ini, 
gambar tidak akan dapat dimodifikasi.

Untuk mengirim gambar, tekan Kirim, lalu pilih 
metode pengiriman yang sesuai.

Perlindungan hak cipta mungkin membuat beberapa 
gambar, nada dering dan materi lainnya tidak dapat 
disalin, dimodifikasi, dipindahkan atau dialihkan.

Untuk menambahkan gambar pada kartu kontak, 
tekan , pilih Peralatan > Tambah ke kontak.... Pada 
tampilan yang terbuka, gunakan pena stylus atau 
tombol gulir untuk memilih bidang gambar yang akan 
dimasukkan. Gunakan bar peralatan untuk 
memperbesar, membalikkan, atau memutar gambar, 
atau menambahkan garis tepi. Jika Anda cukup puas 
dengan tampilan gambar tersebut, tekan Tambah, 
kemudian pilih kartu kontak yang akan ditambahkan 
gambar.

Untuk menetapkan foto sebagai wallpaper, tekan 
, lalu pilih Peralatan > Tetapkan foto. Jika perlu, 

potong foto menggunakan stylus.

Untuk mengubah format file, tekan  pada 
tampilan editor, lalu pilih Pilihan > Ubah format.... Pilih 
format file baru dan pilihan lainnya, jika tersedia.

Untuk mengubah nama gambar, tekan , lalu pilih 
Gambar > Ubah nama.... Tulis nama baru untuk gambar 
tersebut.

Untuk menghapus gambar, tekan , lalu pilih 
Gambar > Hapus.

Perintah berikut ini hanya akan tersedia dalam tampilan 
daftar:
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Untuk memindahkan gambar ke folder lain, tekan 
, lalu pilih Edit > Pindahkan ke folder.... Cari folder 

target atau tekan Baru untuk membuat folder baru.

Untuk membuat salinan gambar, tekan , lalu pilih 
Edit > Duplikat. Ingat, Anda harus selalu membuat 
salinan gambar untuk pengeditan dan edit pada 
salinan sehingga Anda tetap memiliki gambar aslinya.

Untuk melihat isi folder lain, tekan , lalu pilih 
Gambar > Ubah folder.... Cari folder target atau tekan 
Baru untuk membuat folder baru.

Untuk melihat gambar dalam tampilan daftar atau 
thumbnail, tekan , atau tekan , pilih Tampilan > 
Lihat > Gambar Kecil atau Daftar.

Lihat “Perintah umum pada beberapa aplikasi” pada 
halaman 23 untuk informasi lebih lanjut tentang cara 
memilih gambar, membuat folder, dan menambahkan cara 
pintas ke Meja.

Pengaturan gambar
Untuk menetapkan pengaturan, tekan , lalu pilih 
Peralatan > Pengaturan.... Tetapkan berikut ini:

Buka gambar di modus layar penuh: – Jika dipilih, setiap 
gambar yang Anda buka akan ditampilkan dalam modus 
layar penuh. Untuk kembali ke tampilan normal, tekan 
pada layar.

Nama sketsa standar: – Menulis nama yang akan digunakan 
sebagai dasar untuk nama file sketsa. Misalnya, jika Anda 
menulis ’Drawing’, maka nama standar untuk sketsa 
berikutnya adalah Drawing01, Drawing02, Drawing03, 
dan seterusnya, sampai Anda mengubah kembali 
pengaturan.

Fitur khusus pada beberapa 
format gambar

Untuk mengubah halaman dari sebuah gambar 
TIFF/F multihalaman, tekan  kemudian pilih 
Peralatan > Halaman > Berikutnya/Sebelumnya. Gambar 
TIFF/F multihalaman tidak dapat diedit.

Untuk menampilkan GIF animasi, Anda dapat 
menampilkan animasi yang bergerak satu putaran 
secara terus-menerus sampai Anda menutup aplikasi 
Gambar atau memilih gambar lainnya. Anda tidak 
dapat mengedit gambar tersebut namun dapat 
memperbesar atau memperkecil atau 
menampilkannya dalam modus layar penuh.

Mengedit gambar
Andd dapat mengedit gambar berformat JPEG, GIF, BMP, 
TIFF/F, PNG atau WBMP, atau membuat gambar baru. 
Ingat, Anda tidak dapat mengedit gambar TIFF/F 
multihalaman.



Hak cipta © 2005 Nokia. Semua hak dilindungi undang-undang.

Ga
m

ba
r

90

Gbr. 24: Mengedit gambar

Untuk mengedit salinan gambar yang sedang Anda 
lihat, tekan  kemudian pilih Gambar > Buka untuk 
mengedit. Untuk informasi lebih lanjut tentang 
memodifikasi gambar, lihat “Peralatan menggambar” 
pada halaman 90 dan “Transformasi” pada 
halaman 91.

Untuk membuat sketsa baru, tekan , lalu pilih 
Gambar > Buat sketsa. Perintah ini tidak tersedia ketika 
sedang menampilkan gambar. Mulailah menggambar 
pada bidang yang kosong. Pilih peralatan menggambar 
dari bar peralatan. Untuk menyimpan sketsa, tekan 
Selesai. Sketsa yang disimpan akan dicantumkan 
dalam tampilan daftar aplikasi Gambar.

Peralatan menggambar
Bar peralatan menyediakan cara pintas untuk membuka 
peralatan menggambar yang terpenting. Peralatan yang 
sama juga tersedia sebagai perintah menu: tekan , lalu 
pilih Peralatan > Peralatan sketsa.

Untuk menampilkan atau menyembunyikan bar 
peralatan, tekan , lalu pilih Tampilan > Bar 
peralatan.

Ikon bar peralatan:

 – Mengambar garis dengan tangan.

 – Mengambar garis lurus.

 – Menghapus.

 – Memilih bidang gambar. Semua perubahan hanya 
akan terlihat pada bidang yang dipilih. Untuk menghapus 
bidang yang dipilih, tekan .

 – Menggambar segiempat.

 – Menggambar elips atau lingkaran.

 – Memasukkan teks. Untuk memformat teks, tekan 
Huruf.

 – Memilih lebar garis peralatan dan warna.

Untuk menggambar bidang persegi, tekan , lalu 
pilih Peralatan > Peralatan sketsa > Bujur sangkar dengan 
isi.

Untuk menggambar bidang elips atau lingkaran, 
tekan , lalu pilih Peralatan > Peralatan sketsa > 
Lonjong dengan isi.

Untuk membatalkan perubahan, tekan Batalkan; 
atau tekan , lalu pilih Edit > Batalkan / Batalkan 
semua.
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Transformasi
Untuk membuat latar belakang pada bidang 
transparan, tekan , lalu pilih Pilihan > Buat 
transparan.

Untuk memutar gambar, tekan , lalu pilih Pilihan 
> Putar > Ke kanan atau Ke kiri. Gambar akan berputar 
90 derajat sesuai arah yang dipilih.

Untuk membalik gambar, tekan , lalu pilih Pilihan 
> Balik > Secara horizontal atau Secara vertikal.

Untuk menyesuaikan ukuran gambar, tekan , lalu 
pilih Pilihan > Atur ukuran.... Pilih salah satu ukuran 
yang tersedia, atau pilih salah satu pilihan custom 
untuk menentukan sendiri ukuran yang diinginkan.

Untuk menampilkan bidang kanvas yang lebih 
besar, tekan , lalu pilih Pilihan > Perbesar area 
gambar.... Pilih bidang putih pada kanvas yang baru, 
kemudian tentukan nilai perbesaran dalam piksel.

Untuk memotong gambar, tekan , lalu pilih 
Pilihan > Potong. Gambar akan terpotong secara 
otomatis dengan menghapus semua bidang putih yang 
berlebihan di sekitar gambar. Jika tidak terdapat 
bidang putih yang mengelilingi gambar, perintah akan 
dinonaktifkan.
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RealPlayer
Buka Meja > RealPlayer atau tekan Ke RealPlayer dalam 
Kamera (modus Perekam kamera).

Gbr. 25: RealPlayer

Melalui aplikasi RealPlayer Anda dapat menonton klip 
video yang direkam dengan perekam kamera smartphone 
atau dikirim ke smartphone Anda dari PC yang kompatibel, 
Web, e-mail, atau kartu memori. Anda juga dapat 
menonton video stream dari Internet atau mendengarkan 
audio stream. 

Saat menggunakan streaming video dan fitur lainnya 
melalui jaringan GPRS, perlu diingat bahwa pengiriman 
data melalui GPRS akan dikenakan biaya sesuai tarif 
pengiriman data operator.

RealPlayer mendukung beberapa format file berikut: .RAM, 
.RM, .3GP dan .MP4.

RealPlayer tidak selalu mendukung semua jenis format file. 
RealPlayer hanya membuka penghubung rtsp, bukan 
penghubung http.

Memutar video
Untuk memulai pemutaran video yang baru saja 
Anda rekam dengan menggunakan perekam kamera 
smartphone, tekan Ke RealPlayer pada Kamera, pilih 
video yang baru saja Anda rekam kemudian tekan 
Buka.

Untuk memulai pemutaran klip video, buka 
RealPlayer, pilih file dari daftar, kemudian tekan Buka.

Ingat, klip video berkualitas rendah dapat menyebabkan 
efek tampilan yang tidak dikehendaki saat diputar pada 
smartphone ini.

Tip: Anda dapat mulai menonton video dengan cara 
berikut:

• Tekan dua kali file video dalam aplikasi Manajer File 
atau dari tampilan daftar.

• Tekan dua kali cara pintas ke file video yang telah Anda 
buat pada Meja.
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• Buka lampiran video yang dikirim melalui e-mail atau 
pesan multimedia.

• Tekan penghubung streaming video di browser web.
Untuk menghentikan pemutaran video, tekan .

Untuk memulai pemutaran streaming video, klik 
penghubung streaming di browser Web atau, dari 
RealPlayer, buka file .RAM yang berisi penghubung 
untuk memulai streaming. Sebelum memulai 
pemutaran streaming video atau audio, pastikan 
pengaturan sudah benar. Untuk informasi lebih lanjut, 
lihat “Pengaturan RealPlayer” pada halaman 130.

Tip: Anda juga dapat mengatur RealPlayer dari menu. 
Tekan , pilih Pilihan dan perintah menu yang sesuai.

Untuk mengatur volume suara, tekan dan geser bar 
volume di kanan atas layar, atau tekan  dan  
pada tombol gulir.

Untuk meredam suara, tekan ikon speaker di dekat 
bar volume.

Untuk mempercepat pemutaran atau memutar 
ulang klip video, tekan dan geser .

Untuk menghentikan sebentar tampilan video, tekan 
. Tekan kembali untuk melanjutkan pemutaran.

Ingat, jika Anda membuka menu saat menonton video, 
tampilan video akan terhenti.

Untuk menonton video dalam layar penuh, tekan 
pada layar. Untuk kembali ke layar normal, tekan layar 
sekali lagi.

Untuk selalu membuka video dalam modus layar 
penuh, tekan , pilih Peralatan > Pengaturan..., lalu 
pilih Buka klip di modus layar penuh.

Untuk menyimpan penghubung ke streaming video 
atau audio, tekan , lalu pilih Klip media > Simpan 
link....

Mengelola video
Tampilan daftar RealPlayer memperlihatkan daftar dari 
semua video dan penghubung streaming yang disimpan. 
Nama folder ditunjukkan di kolom judul. Misalnya, pada 
tampilan ini Anda dapat melihat video pada smartphone, 
membuka video untuk memutarnya, mengubah nama 
video, dan menyusun video ke dalam folder.

Untuk memindahkan video ke folder lain, tekan 
, lalu pilih Edit > Pindahkan ke folder.... Pilih folder 

target.

Untuk membuka folder lain, tekan , lalu pilih Klip 
media > Ubah folder..., atau Folder terakhir untuk 
membuka salah satu dari 6 folder yang telah 
digunakan.

Untuk menghapus video tertentu dari smartphone, 
tekan , lalu pilih Klip media > Hapus.

Untuk menghapus beberapa video dari smartphone, 
teakn , lalu pilih Edit > Ditandai/Tidak ditandai > 
Ditandai. Pilih video yang akan dihapus, untuk 
menandainya tekan , lalu pilih Edit > Hapus.
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Untuk menyusun urutan video, tekan , lalu pilih 
Tampilan > Sortir. Anda dapat menyusun urutan file 
dalam daftar berdasarkan nama, tanggal, atau ukuran 
file.

Untuk melihat informasi rinci tentang video, tekan 
 kemudian pilih Peralatan > Rincian.

Untuk mengirim video, tekan Kirim, lalu pilih metode 
pengiriman.

Perlindungan hak cipta mungkin membuat beberapa 
gambar, nada dering dan materi lainnya tidak dapat 
disalin, dimodifikasi, dipindahkan atau dialihkan.
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Nokia Audio Manager
Nokia Audio Manager merupakan bagian dari Nokia PC 
Suite. Melalui Nokia PC Suite, Anda dapat mengedit, 
menyimpan, dan melakukan sinkronisasi data smartphone 
Anda dengan sistem PC berbasis Microsoft Windows. 
Untuk informasi lebih lanjut tentang PC Suite dan 
petunjuk penginstalan, lihat Buku Petunjuk Nokia PC Suite 
yang terdapat pada CD-ROM yang diberikan bersama 
smartphone Anda, “Nokia PC Suite” pada halaman 159, 
dan petunjuk online untuk Nokia PC Suite.

Melalui Nokia Audio Manager, Anda dapat membuat dan 
mengelola file musik digital pada PC yang kompatibel, 
kemudian memindahkannya ke telepon yang kompatibel.

Selain itu, melalui Nokia Audio Manager Anda juga dapat:
• Memutar CD audio.
• Menyimpan album lagu CD ke format .aac.
• Memutar album lagu .aac, .mp3, dan .mp4.
• Membuat, mengedit, dan memutar daftar putar .m3u.
• Menyusun album lagu dan daftar putar dalam Nokia 

Audio Manager Music Studio.
• Mengirim lagu .aac, mp3, dan mp4 dari Music Studio ke 

telepon Nokia yang kompatibel.
• Mengirim daftar putar dari Music Studio ke telepon 

Nokia yang kompatibel.
• Dalam modus Pemutar Kecil, putar lagu pada Music 

Studio aktif atau jendela CD Player.

Nokia Audio Manager diatur di sekitar Music Studio, 
tempat kerja desktop yang dapat digunakan untuk 
mengatur dan menyalin lagu ke telepon Anda. Musik dapat 
disimpan dalam studio dari salah satu folder Windows.

CD Player berguna untuk menyimpan file audio CD dalam 
format digital .aac, kemudian Anda dapat menambahkan 
ke Music Studio dan mengirimnya ke telepon Nokia yang 
kompatibel.

Anda dapat membuat Nokia Audio Manager menjadi 
pemutar musik standar untuk semua jenis file yang 
didukung.

Untuk informasi lebih lanjut tentang fitur lain pada Nokia 
Audio Manager, lihat petunjuk online Nokia PC Suite.

Catatan: Jangan sambungkan smartphone ke PC 
sebelum Anda menginstal perangkat lunak Nokia PC 
Suite dari CD-ROM yang disertakan dalam smartphone 
ini.

Menampilkan Nokia Audio 
Manager
Anda dapat menampilkan aplikasi Nokia PC Suite dari 
jendela utama PC Suite dengan mengklik ikon. 
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1 Untuk menampilkan jendela PC Suite, lakukan salah 
satu hal berikut:
• Pada taskbar Windows, klik ikon Nokia PC Suite.
• Pada desktop komputer Anda, klik dua kali pada ikon 

Nokia PC Suite.
• Dalam menu Windows Start, klik Programs > Nokia PC 

Suite.
2 Klik ikon Transfer music.

Tip: Anda dapat mengakses petunjuk Nokia PC Suite 
dari jendela utama menu Help. Item Pesan Pengaturan 
dalam menu Petunjuk akan menghubungkan Anda ke 
halaman Web agar dapat meminta pengaturan untuk 
fitur pesan dan browsing smartphone Nokia Anda, 
seperti WAP/GPRS, pesan multimedia dan pengaturan 
Internet.

Mengirim lagu ke smartphone 
Anda
Melalui Nokia Audio Manager, Anda dapat mengirim 
album lagu ke smartphone Anda dari CD. Pertama-tama, 
simpan musik dari CD ke PC, kemudian kirim lagu dari 
Audio Manager ke smartphone ini.

Tip: Melalui sambungan kabel USB (DKU-2), Anda 
dapat mengirim file besar, seperti file musik, antara 
smartphone ini dengan PC secara lebih cepat 
dibandingkan dengan sambungan Bluetooth.

Untuk mengirim musik dari CD ke PC yang 
kompatibel:

1 Masukkan CD musik ke dalam drive CD pada PC Anda.
2 Pada jendela utama Nokia PC Suite, klik Transfer Musik 

untuk menampilkan Nokia Audio Manager.
3 Klik Pemutar CD, lalu pilih lagu yang akan ditransfer ke 

smartphone Anda.
4 klik Simpan trek. File tersebut akan tersimpan di PC 

Anda dalam format file .aac.
Untuk mentransfer musik dari PC yang kompatibel 
ke smartphone Anda:

1 Klik Studio Musik untuk melihat lagu yang tersimpan.
2 Jika tidak ada lagu yang terlihat, klik File > Cari. Klik 

Browse ,
kemudian Mulai cari. Lihat “Mencari lagu pada hard 
disk” pada halaman 97 untuk rincian.

3 Pilih lagu, kemudian klik Edit > Trek atau Daftar putar 
untuk mengubah judul lagu dan nama artis.

4 Sambung smartphone Anda ke PC. Nokia Audio 
Manager akan mendeteksi smartphone secara 
otomatis, kemudian jendela Mobile Phone akan 
menunjukkan album lagu yang disimpan sebelumnya 
pada smartphone ini.

5 Pada jendela Mobile Phone, klik kanan telepon atau 
folder kartu memori yang akan dikirimkan musik, lalu 
pilih Buat Folder. Berikan nama pada folder (misalnya, 
Musik).
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6 Pilih folder telepon yang akan dikirimkan musik.
7 Dalam Studio Musik, pilih lagu yang akan dikirim ke 

smartphone, kemudian klik Transfer ke telepon. Bila 
pengiriman selesai, file akan mucul dalam daftar.
Album lagu tersebut sekarang tersimpan dalam 
smartphone ini dan Anda dapat mendengarnya.
Tip: Jika Anda memiliki kartu memori pada 
smartphone ini, simpan musik dalam kartu memori 
untuk menghemat ruang memori smartphone Anda.

Mengedit informasi tentang lagu 
CD
Anda dapat mengedit judul lagu pada jendela CD Player. 
Judul baru tersebut akan digunakan sebagai nama file 
setiap kali Anda menyimpan lagu. Jika Anda telah 
menyimpan lagu, tambahkan lagu ini ke Music Studio, 
kemudian edit judulnya di sini.

Untuk mengubah judul pada lagu CD, lakukan salah 
satu hal berikut:

• Klik dua kali pada judul lagu, kemudian masukkan 
nama judul baru.

• Klik kanan pada judul lagu, lalu pilih Modifikasi judul 
dari menu pop-up.

Mencari lagu pada hard disk 
Anda dapat memindai hard disk dan drive CD Anda untuk 
file musik yang didukung dan mengimpornya ke Music 
Studio.
1 Klik File > Cari. Kotak dialog Cari disk musik muncul di 

layar.
2 Klik Browse... untuk memilih drive dan folder yang akan 

dipindai untuk lagu.
3 Pilih jenis file untuk mencari: file audio .mp3, .mp4, 

atau .aac; atau file daftar putar .m3u.
4 Klik Mulai cari. Lagu akan ditambahkan secara otomatis 

ke jendela Studio Musik.
5 Klik Batal atau cari drive atau folder lain.

Menambah lagu ke Music Studio
Anda harus menambahkan lagu ke jendela Studio Musik 
sebelum Anda memfungsikannya. Menambah album lagu 
ke Studio Musik tidak akan menambahkannya secara 
otomatis ke daftar putar.

Untuk menambahkan album lagu ke Music Studio, 
lakukan salah satu hal berikut:

• Pada jendela Studio Musik, klik Tambah. Cari folder 
Windows untuk file musik yang didukung oleh Nokia 
Audio Manager. Klik dua kali pada file atau sorot file, 
lalu pilih Buka.
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• Klik File > Cari. Tetapkan kriteria pencarian, lalu pilih 
Mulai cari. Lagu dan daftar putar akan ditambahkan 
secara otomatis ke Studio Musik.

• Dari Windows Explorer, geser file yang didukung oleh 
Nokia Audio Manager ke jendela Studio Musik.

Nokia Audio Manager akan mengambil album lagu secara 
otomatis ke jendela Music Studio setelah Anda 
menyimpan lagu dari CD ke folder pada PC. Jika Anda ingin 
membatalkan pilihan ini, pilih Pilihan > Preferensi > Lain-
lain,, kemudian hapus Tambahkan trek yang disimpan ke 
Studio Musik secara otomatis.

Mengedit informasi tentang lagu
Data lagu untuk setiap lagu berisi informasi umum, 
termasuk judul lagu, nama artis, durasi, ukuran, dan 
jenisnya. Anda hanya dapat mengedit judul lagu dan nama 
artisnya.
1 Klik kanan pada judul lagu, lalu pilih Edit... dari menu 

pop-up.
2 Dalam dialog Edit Trek , masukkan atau edit informasi 

tentang lagu.
3 Klik Simpan. 

Daftar putar

Membuat daftar putar
Nokia Audio Manager berguna untuk mengatur album 
lagu sebagai daftar putar. Anda dapat membuat dan 
bekerja dengan daftar putar dalam jendela Music Studio.
1 Pilih lagu dalam Studio Musik yang akan ditambah ke 

daftar putar baru.
2 Klik Edit > Buat Daftar Putar Baru.
3 Dalam kotak dialog Simpan sebagai, pilih folder 

Windows yang menyimpan daftar putar, kemudian 
masukkan nama daftar putar.

Menambahkan lagu ke daftar putar
Untuk menambah lagu ke daftar putar, lakukan 
salah satu hal berikut:

• Pilih lagu dalam jendela Studio Musik, kemudian buat 
daftar putar baru.

• Salin atau hapus lagu ke clipboard, kemudian sisipkan 
ke daftar putar yang ada.

• Geser dan lepas lagu tersebut ke daftar putar yang 
ditampilkan di jendela Studio Musik.

• Geser dan lepas lagu tersebut dari Windows Explorer 
ke daftar putar Studio Musik yang ditampilkan.
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Untuk menyalin lagu ke daftar putar, pada jendela 
Studio Musik, lakukan salah satu hal berikut:

1 Pilih, kemudian klik kanan lagu yang akan ditambahkan 
ke daftar putar.

2 Dari menu pop-up, pilih Salin.
3 Klik kanan pada daftar putar yang akan ditambahkan 

lagu, lalu pilih Tempel.

Menambah daftar putar ke Music 
Studio
Anda dapat mengelompokkan dan menyimpan lagu-lagu 
sebagai daftar putar. Bila daftar putar disimpan ke Music 
Studio, maka Anda dapat memutar, mengedit, menyimpan, 
atau menghapusnya.

Untuk menambah daftar putar ke Music Studio, 
lakukan salah satu hal berikut:

• Klik Edit > Buat Daftar Putar Baru. Jika lagu disorot dalam 
Studio Musik, maka lagu tersebut akan ditambahkan 
secara otomatis ke daftar putar baru. Pilih folder 
Windows yang akan digunakan untuk menyimpan 
daftar putar baru, masukkan nama daftar putar, 
kemudian klik Simpan.

• Pada jendela Studio Musik, klik Tambah. Cari melalui 
folder Windows untuk file musik yang didukung oleh 
Nokia Audio Manager. Klik dua kali pada file atau file 
yang disorot, kemudian klik Buka.

Untuk informasi lebih lanjut tentang Nokia Audio 
Manager, lihat petunjuk online PC Suite.

Mengedit informasi tentang daftar 
putar
Setiap daftar putar berisi nama daftar putar. Anda dapat 
mengedit dan menyimpan informasi ini. Pada jendela 
Music Studio, klik kanan pada nama daftar putar, lalu pilih 
Edit...
1 Dalam kotak dialog Edit Daftar Putar, masukkan atau 

edit judul daftar putar.
2 Klik Simpan.

Mencari daftar putar dalam hard disk
Anda dapat memindai hard disk dan drive CD Anda untuk 
daftar putar yang didukung dan mengimpornya ke Music 
Studio.
1 Klik File > Cari. Kotak dialog Cari disk musik muncul di 

layar.
2 Klik tombol Browse... untuk memilih drive dan folder 

yang akan memindai daftar putar.
3 Pilih jenis file untuk mencari (file daftar putar *.m3u).
4 Pilih Mulai cari. Daftar putar akan ditambahkan secara 

otomatis ke jendela Music Studio.
5 Pilih Batal atau cari drive atau folder lain.
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Menghapus album lagu dan 
daftar putar dari telepon

Untuk menghapus file musik dan daftar putar dari 
telepon:

1 Sambung telepon ke PC. Jika Nokia Audio Manager 
sudah berjalan, maka akan mendeteksi sambungan 
telepon secara otomatis.

2 Pada jendela Ponsel, Anda dapat melihat jenis telepon 
yang tersambung dan konten musik yang terakhir 
tersimpan dalam telepon ini.

3 Sorot lagu dan daftar putar pada telepon. Klik Hapus di 
bagian bawah jendela Mobile Phone. Atau, klik kanan 
lagu atau daftar putar, lalu pilih Hapus. Untuk 
menghapus semua lagu dari telepon, klik kanan pada 
jendela Mobile Phone, lalu pilih Hapus semua.
Untuk menghapus lagu dari daftar putar yang 
ditampilkan:

1 Untuk menampilkan daftar putar pada jendela Music 
Studio, klik tanda tambah [+] yang terdapat di sebelah 
nama daftar putar.

2 Pilih lagu yang akan dihapus dari daftar putar.
3 Klik kanan pada lagu yang dipilih, lalu pilih Hapus dari 

menu pop-up.
Anda juga dapat menggeser dan melepas lagu dari 
daftar putar ke daftar lagu Music Studio.
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Music player
Buka Meja > Music player.

Melalui aplikasi Music player, Anda dapat mendengarkan 
file musik dan audio yang tersimpan dalam smartphone ini 
atau kartu memori. Music player mendukung format file 
berikut: MP3, WAV, MIDI, AAC, AMR, AU, RMF, dan M3U. 
Music player tidak selalu mendukung semua jenis format 
file di atas. Anda dapat membuat dan mengedit daftar lagu 
menggunakan MusicPlayer pada Nokia Audio Manager. 
Nokia Audio Manager merupakan bagian dari Nokia PC 
Suite.

Gbr. 26: Music player

Untuk informasi tentang mentransfer lagu musik ke 
smartphone serta mengatur lagu dan daftar lagu, lihat 
“Nokia Audio Manager” pada halaman 95.

Anda dapat mendengarkan musik dengan menggunakan 
pengeras suara internal atau headset yang kompatibel, dan 

sambil menikmati musik Anda dapat menggunakan 
aplikasi lainnya pada smartphone ini.

Musik merupakan hak cipta yang dilindungi oleh 
perjanjian internasional dan undang-undang hak cipta 
nasional. Menyalin atau menggandakan musik harus 
dengan lisensi dan seizin pemiliknya. Di beberapa negara, 
undang-undang setempat melarang penggandaan 
material yang hak ciptanya dilindungi. Pastikan ketentuan 
hukum yang berlaku di negara Anda untuk penggunaan 
materi demikian.

Tombol Music player
 – Tekan untuk memutar lagu yang dipilih.

 – Tekan untuk menghentikan lagu yang sedang 
diputar.

 – Tekan untuk menghentikan dan melanjutkan lagu 
yang sedang diputar.

 – Tekan dan geser untuk mengatur volume 
suara.

 – Tekan dan geser tombol untuk memilih bagian 
tertentu dari lagu yang sedang diputar. Indikator waktu di 
atas tombol geser akan berubah.
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Tip: Anda juga dapat mengatur Music player dari 
menu. Tekan , pilih Pilihan dan perintah menu yang 
sesuai.

Memutar musik
Untuk memutar lagu, tekan dua kali pada lagu yang 
dipilih, atau pilih kemudian tekan .

Tip: Anda juga dapat mengaktifkan Music player 
dengan menekan dua kali file suara yang kompatibel 
dari Manajer file atau aplikasi Pesan, atau dengan 
membuka cara pintas Meja.

Untuk memutar lagu secara berurutan, tekan , 
lalu pilih Pilihan > Pilihan pemutaran > Normal. Pilih 
lagu, lalu tekan  untuk memutarnya.

Untuk memutar lagu secara acak, tekan , lalu 
pilih Pilihan > Pilihan pemutaran > Acak.

Untuk memutar hanya satu lagu yang dipilih, tekan 
, lalu pilih Pilihan > Pilihan pemutaran > Putar lagu 

terpilih. Untuk mengulang lagu tersebut, tekan , 
lalu pilih Pilihan > Pilihan pemutaran > Ulangi. Lagu 
yang dipilih akan terus diputar sampai Anda 
membatalkan perintah menu Ulangi. Untuk beralih ke 
lagu berikutnya, tekan , lalu pilih Pilihan > Lagu 
berikutnya.

Untuk mengatur volume suara, tekan dan geser bar 
volume di kanan atas layar, atau tekan  dan  
pada tombol gulir.

PERINGATAN: Dengarkan musik pada volume suara 
yang normal. Mendengarkan musik dengan volume 
suara yang tinggi secara terus-menerus dapat merusak 
pendengaran Anda.

Untuk meredam suara, tekan ikon speaker di dekat 
bar volume.

Mengatur lagu
Untuk menambah lagu ke dalam daftar lagu, tekan 

, lalu pilih Lagu > Tambah ke daftar lagu....

Untuk menghapus lagu dari daftar lagu, tekan , 
lalu pilih Lagu > Hapus dari daftar lagu.

Untuk memindahkan lagu ke folder lain, tekan , 
lalu pilih Edit > Pindahkan ke folder.... Pilih folder target.

Tip: Untuk memilih beberapa lagu, tekan nomor lagu 
yang akan dipilih, kemudian pilih , lalu pilih Edit > 
Tandai/Hapus Tandai > Tandai. Tekan untuk menandai 
pilihan tersisa yang akan Anda pilih.

Untuk menambahkan cara pintas lagu ke Meja, 
tekan , lalu pilih Peralatan > Tambah ke Meja....

Untuk menghapus lagu dari smartphone, tekan , 
lalu pilih Lagu > Hapus lagu.

Untuk menyusun urutan lagu, tekan , lalu pilih 
Tampilan > Sortir. Anda dapat menyusun urutan file 
dalam daftar berdasarkan nama, tanggal, atau ukuran 
file.
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Untuk melihat informasi rinci tentang sebuah lagu, 
tekan  kemudian pilih Peralatan > Rincian.

Untuk mengirim lagu, tekan , lalu pilih Lagu > 
Kirim, kemudian pilih metode pengiriman.

Perlindungan hak cipta mungkin membuat beberapa 
gambar, nada dering dan materi lainnya tidak dapat 
disalin, dimodifikasi, ditransfer atau dialihkan.

Untuk menetapkan lagu sebagai nada dering, pilih 
lagu, kemudian tekan , lalu pilih Peralatan > 
Tetapkan sebagai nada dering. 

Untuk menyimpan lagu yang dikirim melalui pesan 
multimedia, buka lampiran Pesan, tekan , lalu pilih 
Simpan. 

Daftar lagu
Untuk membuat daftar lagu baru, tekan , lalu 
pilih Lagu > Daftar lagu baru....

Untuk membuka daftar lagu, tekan , lalu pilih 
Lagu > Ubah daftar lagu..., atau Daftar lagu terakhir untuk 
membuka salah satu dari enam daftar lagu terakhir.

Tampilan daftar lagu
Untuk mengubah nama daftar lagu, tekan , lalu 
pilih Daftar lagu > Ubah nama....

Untuk menambah lagu ke daftar lagu, tekan , 
lalu pilih Daftar lagu > Tambah ke daftar lagu.... Buka 
lokasi lagu, pilih lagu, kemudian tekan Tambah.

Untuk menghapus daftar lagu, tekan , lalu pilih 
Daftar lagu > Hapus daftar lagu.
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Visual Radio
Buka Meja > Visual Radio.

Anda dapat menggunakan aplikasi Visual Radio™ sebagai 
radio FM biasa dengan pencarian otomatis dan saluran 
preset, atau dengan informasi visual paralel pada layar, 
jika Anda memilih stasiun yang memberikan layanan 
Visual Radio. Layanan Visual Radio menggunakan GPRS 
(layanan jaringan). Anda dapat menggunakan aplikasi 
lainnya pada smartphone sambil mendengarkan radio FM.

Gbr. 27: Visual Radio

Untuk dapat menggunakan layanan Visual Radio, 
persyaratan berikut ini harus dipenuhi:

• Stasiun radio yang Anda dengarkan dan operator 
jaringan Anda harus mendukung layanan ini.

• Smartphone harus diaktifkan.

• Smartphone harus menggunakan kartu SIM yang 
berlaku.

• Jalur akses Internet harus ditentukan untuk akses ke 
server radio visual operator.

• Saluran preset radio harus memiliki ID layanan 
Visual Radio yang bena dan layanan Visual Radio 
diaktifkan. Lihat “Saluran preset” pada halaman 105 
untuk rincian.

Jika Anda tidak memiliki akses ke layanan Visual Radio, 
operator dan stasiun radio di area Anda tidak dapat 
mendukung Visual Radio. Layanan Visual Radio mungkin 
tidak tersedia di semua area dan negara.

Radio menggunakan kabel headset sebagai antena. 
Headset yang kompatibel harus tersambung ke 
smartphone ini agar radio berfungsi dengan benar.

Anda dapat seperti biasa menjawab panggilan masuk 
sambil mendengarkan radio. Radio akan dimatikan saat 
terdapat panggilan aktif. Setelah panggilan berakhir, Anda 
harus menghidupkan kembali radio secara manual.

Mendengarkan radio
Ingat, kualitas siaran radio tergantung pada jangkauan 
stasiun radio. 
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Untuk menghidupkan atau mematikan radio, 
hubungkan headset kompatibel ke smartphone 
kemudian tekan  pada Visual Radio.

Tip: Anda juga dapat mengatur radio dari menu. Tekan 
, pilih Radio dan perintah menu yang diinginkan.

Untuk mendengarkan radio melalui headset atau 
pengeras suara, pastikan headset terhubung ke 
smartphone, tekan , lalu pilih Peralatan > Pengeras 
suara yang digunakan > Headset atau Pengeras suara. 
Kabel headset berfungsi sebagai antena radio, karena 
itu biarkan tergantung bebas.

Untuk mengatur volume suara, tekan dan geser 
, atau tekan  dan .

Untuk mencari saluran radio secara manual, tekan 
 atau .

Untuk mencari saluran radio secara otomatis, tekan 
 atau . Pencarian akan berhenti bila saluran 

radio sudah ditemukan.

Untuk melihat saluran yang tersedia berdasarkan 
lokasi, tekan , lalu pilih Peralatan > Direktori 
saluran.... Pilih lokasi dan stasiun radio. Visual Radio 
akan menangkap siaran dari stasiun radio tersebut 
secara otomatis. Untuk menyimpan saluran preset ke 
dalam daftar saluran preset, tekan Simpan. Lihat 
“Saluran preset” pada halaman 105 untuk rincian. 
Untuk melihat rincian stasiun, misalnya ID layanan 
visual, tekan Rincian.

Untuk memilih antara modus output stereo atau 
mono, tekan  kemudian pilih Peralatan > Suara > 
Stereo atau Mono.

Melihat isi
Untuk melihat isi visual yang tersedia, pilih saluran 
preset, kemudian tekan . Untuk mengakhiri 
tampilan isi visual, tekan . Ingat, Anda harus 
memiliki ID layanan visual yang benar dan layanan 
Visual Radio diaktifkan. Lihat “Saluran preset” di 
bawah ini untuk rincian.

Saluran preset
Anda dapat menyimpan hingga 20 saluran radio ke Visual 
Radio.

Untuk menyimpan saluran, tekan  dan  untuk 
menerima siaran stasiun radio. Tekan , lalu pilih 
Saluran > Simpan.... Pilih slot saluran, kemudian tulis 
nama saluran preset. Ubah frekuensi, bila perlu. Jika 
stasiun menyediakan isi visual, masukkan ID layanan 
Visual Radio, kemudian pilih kotak pilihan Aktifkan 
layanan visual: untuk mengaktifkan isi visual.

Tip: Untuk menemukan ID layanan visual dari sebuah 
saluran, tekan , lalu pilih Peralatan > Direktori 
saluran.... Pilih stasiun radio, lalu tekan Rincian.

Untuk mendengarkan saluran preset, tekan saluran 
dalam tampilan daftar.
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Untuk mengedit saluran preset, tekan , lalu pilih 
Saluran > Edit....

Untuk menyusun kembali saluran preset, pilih 
saluran, tekan , lalu pilih Saluran > Susun kembali.... 
Pilih slot saluran dalam daftar. Tekan bagian tengah 
tombol gulir untuk mengkonfirmasi perubahan 
susunan.

Untuk menghapus saluran preset, tekan , lalu 
pilih Saluran > Hapus.

Tip: Bila menggunakan headset yang kompatibel, 
tekan tombol headset untuk mencari saluran radio 
atau saluran yang sudah disimpan berikutnya, jika 
Anda memilih daftar saluran yang disimpan.

Pengaturan Visual Radio
Untuk mengubah pengaturan, tekan , lalu pilih 
Peralatan > Pengaturan.... Tetapkan berikut ini:

Lay. visual mulai-otom.: – Jika dipilih, layanan Visual Radio 
akan diaktifkan secara otomatis saat Anda menekan 
saluran preset yang menyediakan layanan visual.

Jalur akses: – Memilih jalur akses yang digunakan untuk 
sambungan data. Untuk informasi lebih lanjut, lihat 
“Membuat pengaturan jalur akses Internet” pada 
halaman 124. Ingat, Anda tidak memerlukan jalur akses ini 
jika Visual Radio hanya digunakan sebagai radio FM biasa.



Hak cipta © 2005 Nokia. Semua hak dilindungi undang-undang.

Pe
re

ka
m

 s
ua

ra

107

Perekam suara
Buka Meja > Perekam suara.

Melalui aplikasi Perekam suara Anda dapat merekam 
memo suara. Anda juga dapat mendengarkan rekaman 
pribadi dan file suara lainnya atau memasukkan klip suara 
ke dalam pesan multimedia. 

Panjang maksimum rekaman akan tergantung pada 
kapasitas memori yang tersedia.

Anda dapat membuka file yang disimpan dalam format 
file: WAV, AMR.

Merekam dan memutar rekaman
Untuk mulai merekam, tekan . Angka yang 
ditampilkan menunjukkan waktu yang telah 
berlangsung. Untuk berhenti merekam, tekan .

Tip: Tekan  untuk mulai dan berhenti merekam 
dengan cepat.

Untuk memutar klip suara yang dipilih, tekan .

Untuk menghentikan sebentar pemutaran klip 
suara, tekan . Tekan kembali untuk melanjutkan 
pemutaran.

Untuk mengatur volume suara, tekan dan geser bar 
volume di kanan atas layar, atau tekan  dan  
pada tombol gulir.

Untuk mempercepat pemutaran atau memutar 
ulang klip suara , tekan dan geser .

Untuk mengakhiri pemutaran, tekan .

Tip: Anda juga dapat mengatur Perekam video dari 
menu. Tekan , pilih Pilihan dan perintah menu yang 
sesuai.

Mengelola klip suara
Untuk mengirim klip suara, tekan , lalu pilih Klip 
suara > Kirim, kemudian pilih metode pengiriman.

Untuk menyusun urutan daftar klip suara, tekan 
, lalu pilih Tampilan > Sortir. Anda dapat menyusun 

urutan file suara dalam daftar berdasarkan nama, 
tanggal atau ukuran file.

Untuk mengubah nama atau menghapus klip suara 
yang dipilih, tekan , pilih Klip suara, kemudian 
perintah yang sesuai.

Untuk membuka folder lain, tekan , lalu pilih Klip 
suara > Ubah folder....

Untuk menambahkan cara pintas klip suara ke Meja, 
tekan , lalu pilih Peralatan > Tambah ke Meja....

Untuk melihat informasi rinci sebuah klip suara, 
tekan , lalu pilih Peralatan > Rincian.
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Pengaturan perekam suara
Untuk mengedit pengaturan Perekam suara, tekan 

, lalu pilih Peralatan > Pengaturan.... Tetapkan 
berikut ini:

Nama klip: – Menulis nama yang akan digunakan sebagai 
dasar untuk nama klip suara. Misalnya, jika Anda menulis 
“Suara”, maka nama standar untuk klip suara berikutnya 
adalah Suara(01), Suara(02), Suara(03) dan seterusnya.

Format klip: – Memilih format file standar untuk 
penyimpanan klip suara.
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Dokumen
Buka Meja > Dokumen.

Anda dapat menggunakan aplikasi Dokumen untuk 
membuat dokumen baru dan mengedit dokumen teks yang 
sudah ada. Anda dapat memasukkan dan menampilkan 
gambar dan file lain dalam dokumen. Anda juga dapat 
mengirim dan menerima dokumen sebagai pesan singkat, 
MMS, lampiran e-mail, atau melalui teknologi Bluetooth.

Anda dapat membuka, mengedit, dan menyimpan 
dokumen yang dibuat dalam Microsoft Word untuk 
Windows versi 97 atau versi yang lebih baru. Ingat, tidak 
semua fitur dan pemformatan dokumen asli akan 
didukung. Dokumen asli harus tidak dikunci dengan sandi. 
Dokumen yang dibuat dengan Microsoft Word versi 
lainnya hanya dapat ditampilkan.

Bekerja dengan dokumen
Untuk membuat, membuka atau mengubah nama 
dokumen, tekan  kemudian pilih perintah yang 
sesuai dalam menu Dokumen.

Untuk memasukkan karakter khusus, tekan  lalu 
pilih Sisipkan > Karakter khusus.... Pilih karakter atau 
simbol yang akan Anda masukkan, kemudian tekan OK.

Untuk memasukkan tanggal ke dalam dokumen, 
tekan  lalu pilih Sisipkan > Tanggal.

Untuk membatalkan kesalahan, tekan  kemudian 
pilih Edit > Batalkan.

Untuk menampilkan atau menyembunyikan 
penanda teks, tekan  kemudian pilih Peralatan > 
Memformat tanda.... Pilih penanda yang akan 
ditampilkan dalam dokumen, kemudian tekan OK.

Untuk menghitung kata, tekan  kemudian pilih 
Peralatan > Hitung kata....

Untuk mengunci dokumen dari pengeditan, tekan 
 dalam tampilan daftar kemudian pilih Peralatan > 

Rincian. Pilih kotak pilihan Hanya dibaca:, kemudian 
tekan OK. Kini dokumen dapat ditampilkan namun 
tidak dapat diedit.

Untuk mengirim dokumen, tekan Kirim, pilih metode 
pengiriman kemudian tekan OK.

Untuk melihat struktur dokumen, tekan  
kemudian pilih Tampilan > Tampilan sketsa....
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Tip: Jika Anda menulis nomor telepon, alamat e-mail, 
atau alamat web dalam dokumen, Anda dapat 
menggunakannya sebagai hyperlink. Tekan nomor atau 
alamat, atau letakkan kursor di antaranya dengan 
tombol gulir; sehingga menjadi penghubung dengan 
ikon kecil. Tekan ikon untuk memanggil nomor telepon, 
membuka editor e-mail, atau mengunjungi situs web 
jika Anda memiliki sambungan Internet aktif.

Mengedit jenis paragraf
Jenis paragraf adalah kumpulan karakteristik 
pemformatan untuk mempercepat dan memudahkan 
pengeditan tampilan teks.
1 Tekan  kemudian pilih Format > Gaya....
2 Pilih jenis paragraf yang akan diedit kemudian tekan 

Edit. Tekan Baru untuk membuat jenis paragraf baru.
3 Beri nama untuk jenis paragraf baru dan pilih level 

outline. Level 0 berarti teks dengan jenis ini tidak 
ditunjukkan dalam tampilan outline.

4 Tekan Format, pilih file yang akan diedit, kemudian 
tekan Format sekali lagi untuk memulai pengeditan. 
Anda dapat mengubah pilihan berikut:

Huruf – Anda dapat mengganti jenis font, ukuran dan 
warna. Anda juga dapat menambahkan pemformatan 
huruf tebal (bold), miring (italic), garis bawah 
(underline), dan tanda coret (strikethrough). Anda 
dapat menurunkan atau menaikkan penulisan teks 
dengan memilih pemformatan superscript atau 
subscript. Untuk melihat efek perubahan, tekan Lihat 
dulu.
Paragraf – Anda dapat mengubah bagian tepi paragraf 
dengan kelurusan yang berbeda. Anda dapat 
mengubah spasi antara baris teks, jarak penulisan 
paragraf, dan menambahkan tab stop untuk mengatur 
posisi teks pada halaman.
Batas – Anda dapat menambahkan batas halaman dan 
memilih jenis serta warnanya.
Bullet – Anda dapat memilih salah satu dari empat 
jenis bullet, serta menentukan ukuran, warna dan jarak 
penempatan bullet.

5 Tekan OK setelah Anda selesai mengedit pilihan format 
paragraf.

6 Tekan Tutup untuk keluar dari dialog.
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Lembar
Buka Meja > Lembar.

Pada aplikasi Lembar Anda dapat bekerja dan menyimpan 
data dalam sebuah file yang disebut buku kerja. Setiap 
buku kerja berisi sedikitnya satu lembar kerja. Buku kerja 
juga dapat berisi grafik; lembar grafik adalah lembar yang 
berisi grafik yang dibuat berdasarkan data dari lembar 
kerja.

Aplikasi Lembar dapat membuka dokumen yang dibuat 
dengan Microsoft Excel 97 untuk Windows atau versi 
diatasnya. Ingat, tidak semua fitur dan pemformatan 
dokumen asli akan didukung. Jumlah maksimum karakter 
dalam sebuah sel adalah 256, dan sel yang berisi karakter 
melebihi maksimum akan diperpendek saat format file 
disesuaikan.

Buku kerja
Untuk mengunci lembar kerja dari pengeditan, tekan 

 dalam tampilan daftar kemudian pilih Peralatan > 
Rincian. Pilih kotak pilihan Hanya dibaca:, kemudian 
tekan OK. Kini buku kerja dapat ditampilkan namun 
tidak dapat diedit.

Untuk membuat, membuka atau mengubah nama 
buku kerja, tekan  kemudian pilih perintah yang 
sesuai di menu Buku kerja.

Menangani lembar kerja
Untuk membuat duplikat lembar kerja, tekan 
Lembar kerja / Grafik. Pilih lembar, kemudian tekan 
Duplikat.

Untuk mengubah nama lembar kerja, tekan Lembar 
kerja / Grafik. Pilih lembar, kemudian tekan Ubah 
nama. Tulis nama baru, kemudian tekan OK.

Untuk memilih sel yang telah Anda beri nama, tekan 
 lalu pilih Edit > Ditandai/ Tidak ditandai. Pilih Area 

yang dinamai untuk menentukan cakupan, lalu dan 
pilih dari daftar untuk sel yang Anda inginkan, 
kemudian tekan OK.

Agar baris tetap terlihat saat menggulir halaman, 
pilih baris di bawah area yang Anda inginkan untuk 
tetap terlihat. Agar kolom tetap dapat terlihat, pilih 
kolom di kanan area yang Anda inginkan untuk tetap 
terlihat. Kemudian tekan  pada baris peralatan, 
atau tekan  lalu pilih Tampilan > Tetapkan garis.

Untuk membuka sel tertentu atau area yang 
dinamai, tekan Ke. Tentukan sel atau area yang 
dinamai untuk Anda buka, kemudian tekan OK.
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Tip: Anda dapat memasukkan sejumlah sel dengan 
menggunakan ikon bar peralatan . Pilih sel untuk 
menambahkan jumlah, kemudian tekan . Formula 
yang disarankan terlihat di area formula pada bagian 
atas lembar kerja. Anda dapat mengubah formula yang 
disarankan dengan mengeditnya dalam area formula, 
atau menerimanya dengan keluar dari sel tersebut.

Memformat lembar kerja
Pertama, pilih sel atau sejumlah sel yang akan Anda 
format.

Untuk format font, tekan  lalu pilih Format > 
Huruf. Anda dapat mengubah jenis font, ukuran, dan 
warnanya. Anda juga dapat menambahkan 
pemformatan huruf tebal (bold), miring (italic), garis 
bawah (underline), dan tanda coret (strikethrough). 
Anda dapat menurunkan atau menaikkan penulisan 
teks dengan memilih pemformatan superscript atau 
subscript. Untuk melihat efek perubahan, tekan Lihat 
dulu.

Untuk mengubah format angka, tekan  lalu pilih 
Format > Nomor. Misalnya, Anda dapat menentukan 
penulisan tanggal, waktu, atau mata uang.

Untuk meluruskan isi sel, tekan  lalu pilih Format 
> Kesejajaran. Jika Anda memilih Satukan teks ke dalam 
sel:, tinggi baris dari sel yang dipilih akan disesuaikan 
untuk menampilkan seluruh isi sel.

Untuk mengatur tinggi baris atau lebar kolom, geser 
batas di bawah permulaan baris atau di kanan 
permulaan kolom sampai ukuran baris/kolom sesuai 
dengan keinginan Anda. Untuk menentukan tinggi 
atau lebar yang tepat, tekan  lalu pilih Format > 
Tinggi baris atau Lebar kolom. Tentukan tinggi atau 
lebar, kemudian tekan OK.

Untuk format batas sel, tekan  lalu pilih Format > 
Batas. Anda dapat menambahkan pembatas di setiap 
sisi sel. Pilih gaya dan warna pembatas, kemudian 
tekan OK.

Untuk mengubah warna latar belakang sel, tekan 
 lalu pilih Format > Warna latar belakang. Pilih 

warna. kemudian tekan OK.

Untuk menampilkan atau menyembunyikan garis 
bantu, nilai nol, dan judul, tekan  lalu pilih 
Peralatan > Pengaturan. Pilih objek yang akan Anda 
perlihatkan dalam lembar kerja, kemudian tekan OK.

Lembar grafik
Untuk format grafik secara rinci, tekan  lalu 
pilih Format. Pilih objek yang akan Anda edit. Pilihan 
pengaturan akan berbeda-beda, tergantung pada jenis 
grafik.
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Tip: Anda dapat membuka beberapa dialog 
pengaturan dengan menekan objek yang sesuai dalam 
grafik. Misalnya, dialog Pengaturan X-axis akan 
terbuka jika Anda menekan dua kali sumbu-X dalam 
grafik.

Huruf – Anda dapat mengganti jenis font, ukuran dan 
warna. Anda juga dapat menambahkan pemformatan 
huruf tebal (bold), miring (italic), garis bawah (underline), 
dan tanda coret (strikethrough). Anda dapat menurunkan 
atau menaikkan penulisan teks dengan memilih 
pemformatan superscript atau subscript. Untuk melihat 
efek perubahan, tekan Lihat dulu.

Grafik – Anda dapat memilih jenis grafik, membuat grafik 
tiga dimensi, dan mengubah warna latar dan sumbu. Anda 
juga dapat mengganti judul grafik, serta nama sumbu X 
dan sumbu Y.

X-axis – Anda dapat memilih jenis label dan menulis 
cakupan data, menampilkan atau menyembunyikan garis 
sumbu, dan menambahkan penunjuk. Anda juga dapat 
memasukkan nomor kategori pertemuan garis sumbu, dan 
mengubah jumlah penunjuk per kategori.

Y-axis – Anda dapat menetapkan apakah nilai-nilai akan 
ditampilkan dalam grafik, menentukan nilai tertinggi dan 
terendah yang akan ditampilkan, dan menetapkan posisi 
pertemuan garis sumbu. Anda juga dapat menggunakan 
skala logaritma, mengubah interval jarak untuk tampilan 
penunjuk, dan mengubah format angka.

Legenda – Anda dapat menambahkan kotak untuk 
keterangan dari masing-masing warna yang digunakan 
pada grafik, dan menentukan posisi kotak tersebut.

Kotak-kotak – Anda dapat memilih apakah sumbu mayor 
dan minor ditampilkan dengan garis bantu.

Seri – Anda dapat menambahkan kelompok data baru ke 
grafik atau mengedit kelompok data yang sudah ada. Anda 
dapat menentukan apakah kelompok data tersebut akan 
ditampilkan dalam grafik atau tidak, mengubah cakupan 
data dari kelompok data tersebut, memilih jenis label dan 
memasukkan cakupan data. Anda juga dapat memilih 
warna untuk kelompok data yang akan ditampilkan pada 
grafik. Ingat, diagram lingkaran hanya dapat memiliki satu 
kelompok data.

Untuk membuat duplikat lembar grafik, tekan 
Lembar kerja / Grafik. Pilih grafik, kemudian tekan 
Duplikat.

Untuk mengubah nama lembar grafik, tekan Lembar 
kerja / Grafik. Pilih grafik, kemudian tekan Ubah 
nama. Tulis nama baru, kemudian tekan OK.
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Presentasi
Buka Meja > Presentasi.

Anda dapat membuka dan melihat presentasi yang dibuat 
dengan Microsoft PowerPoint 97 atau versi di atasnya. 
Ingat, tidak semua fitur dan pemformatan dokumen asli 
akan didukung. Anda dapat mengirim dan menerima 
presentasi melalui e-mail atau teknologi Bluetooth.

Tampilan daftar memperlihatkan semua presentasi dalam 
folder yang dipilih. Nama folder ditunjukkan di kolom 
judul. Pada tampilan ini Anda dapat menyusun presentasi 
tanpa membuka file sebenarnya. Misalnya, dengan 
menggunakan perintah bar menu Anda dapat 
memindahkan atau menyalin presentasi.

Tip: Untuk informasi lebih lanjut tentang perintah 
yang tersedia, lihat “Perintah umum pada beberapa 
aplikasi” pada halaman 23.

Untuk membuka presentasi, tekan dua kali presentasi 
dalam daftar. Jika file terdapat dalam folder lain, tekan 

 lalu pilih Presentasi > Ubah folder.... Pilih folder 
penyimpan presentasi tersebut. Ingat, Anda hanya dapat 
membuka satu presentasi untuk sekali buka.

Untuk beralih antara slide, gunakan tombol 
Berikutnya dan Sebelumnya. Untuk pindah secara 
langsung ke slide tertentu, tekan  lalu pilih 
Presentasi > Ke slide. Pilih slide dalam daftar, lalu tekan 
OK.

Untuk menampilkan slide dalam modus layar penuh, 
tekan  kemudian pilih Tampilan > Layar penuh. 
Untuk kembali ke tampilan standar, tekan  lalu 
pilih Tampilan, kemudian hapus pilihan Layar penuh.

Untuk melihat catatan tambahan dalam presentasi, 
tekan  kemudian pilih Lihat > Catatan. Untuk 
kembali ke tampilan slide standar, tekan  
kemudian pilih Lihat > Slide.

Untuk mendapatkan gambaran umum presentasi, 
tekan  kemudian pilih Lihat > Sketsa. Untuk 
membuka slide yang dipilih dalam tampilan slide 
standar, tekan Tampilan slide atau tekan dua kali judul 
slide.

Untuk menyalin teks dari slide yang ditampilkan, 
tekan  kemudian pilih Edit > Salin teks. Teks 
kemudian disalin ke papan klip. Pada tampilan 
Catatan, isi catatan juga akan disalin. Untuk menyalin 
seluruh teks presentasi, tekan  kemudian pilih 
Lihat > Sketsa. Kemudian tekan  sekali lagi dan pilih 
Edit > Salin semua teks. Seluruh teks pada slide dan 
catatan disalin ke papan klip. Untuk menyalin semua 
teks slide, pilih Salin semua teks dari slide, dan untuk 
menyalin semua teks dalam catatan, pilih Salin semua 
teks dari catatan. Ingat, sebagian peformatan mungkin 
akan hilang.
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Jam
Buka Meja > Jam.

Untuk mengatur tanggal dan waktu saat ini, tekan 
Tanggal dan waktu. Pilih kotak pilihan Perbaharui 
otomatis tanggal & waktu: jika Anda ingin agar jaringan 
memperbarui tanggal dan waktu secara otomatis ke 
smartphone Anda. Ingat, fitur ini merupakan layanan 
jaringan. Atau, tekan , kemudian tekan tanda 
panah untuk mengubah waktu. Tekan  untuk 
mengatur tanggal. Untuk menggunakan perbedaan 
waktu siang hari, pilih kotak pilihan Terapkan zona 
perbedaan waktu:.

Lihat juga “Pengaturan regional” pada halaman 131.

Untuk beralih antara jenis jam analog dan digital, 
tekan permukaan jam.

Untuk menampilkan hanya kota asal dalam 
tampilan Waktu, tekan  lalu pilih Tampilan. 
Kosongkan pilihan Kota tujuan. 

Untuk beralih antara tampilan Waktu dan Alarm, 
tekan  lalu pilih Lihat > Alarm atau Waktu.

Gbr. 28: Jam

Alarm
Untuk mengatur alarm, tekan Pengaturan alarm. 
Tulis teks yang akan muncul di layar bila bunyi alarm 
berhenti. Tekan , kemudian tekan  dan  
untuk mengatur waktu alarm. Tekan OK. Tetapkan 
seberapa sering alarm akan diulang, lalu tekan OK.

Jika waktu alarm tiba saat smartphone ini nonaktif, maka 
smartphone akan aktif dengan sendirinya dan 
mengeluarkan nada alarm.
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Untuk menonaktifkan dan menghapus alarm yang 
berbunyi, tekan Berhenti. Jika smartphone ini 
nonaktif saat alarm berbunyi, smartphone akan 
menanyakan apakah Anda akan mengaktifkannya. 
Tekan Batalkan untuk menonaktifkan smartphone 
atau Aktifkan untuk mengaktifkannya. Jangan tekan 
Aktifkan bila penggunaan telepon selular dapat 
menimbulkan gangguan atau bahaya.

Untuk menunda alarm yang sedang berbunyi selama 
10 menit, tekan Tunda. Jika smartphone ini nonaktif 
saat alarm berbunyi, smartphone akan nonaktif 
dengan sendirinya kemudian aktif kembali setelah 10 
menit.

Untuk menghilangkan suara alarm yang sedang 
berbunyi, tekan Tidak bersuara. Alarm akan terdiam, 
namun pemberitahuan akan tetap muncul di layar. 

Untuk menghapus alarm, tekan  kemudian tekan 
Lihat > Alarm. Pilih alarm yang akan dihapus, kemudian 
tekan Hapus alarm.

Untuk mengedit alarm, tekan  kemudian tekan 
Lihat > Alarm. Tekan dua kali alarm yang akan diedit.

Untuk menonaktifkan atau mengaktifkan alarm, 
tekan  kemudian tekan Lihat > Alarm. Pilih alarm 
yang akan dinonaktifkan atau diaktifkan, lalu tekan 
Aktifkan/ Nonaktifkan.

Kota dan negara
Untuk mengubah kota dalam tampilan Waktu, pilih 
jendela kiri untuk mengubah kota sekarang atau 
jendela kanan untuk mengubah kota tujuan. Tekan 
Ubah kota, geser bar gulir untuk mencari daftar, atau 
masukkan nama kota dalam kotak cari di bawah 
daftar. Daftar akan berubah untuk menampilkan 
kemungkinan yang sesuai saat Anda memasukkan 
lebih banyak karakter ke dalam kolom cari. Pilih kota, 
kemudian tekan OK. Jika kota tersebut tidak terdapat 
dalam daftar, tekan Kota baru untuk 
menambahkannya ke daftar.

Untuk menambahkan kota, negara atau wilayah 
baru, tekan  lalu pilih Kota atau Negara/Wilayah > 
Baru....

Untuk mengedit kota, negara atau wilayah pilihan 
saat ini, tekan  lalu pilih Kota atau Negara/Wilayah 
> Edit....

Untuk menyalin kode panggilan kota pilihan, tekan 
 lalu tekan Peralatan > Salin kode panggilan.
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Kalkulator
Smartphone ini dilengkapi dengan aplikasi kalkulator 
untuk perhitungan dasar.

Catatan: Kalkulator ini memiliki keterbatasan dan 
dirancang untuk perhitungan dasar.

Gbr. 29: Kalkulator

Untuk menghitung, tekan tombol pada layar.

Kalkulator akan menghitungkan sesuai dengan fungsi yang 
dimasukkan, sekalipun terdapat perbedaan tingkatan 
antara berbagai jenis operator. Anda tidak dapat 
menggunakan tanda kurung untuk mengubah urutan 
penghitungan. 

Tip: Untuk menggunakan simbol persentase, x% sama 
dengan x/100.

Untuk menghapus angka dalam kolom input, tekan 
.

Dari kolom input, Anda tidak dapat menghapus simbol 
peng hitungan yang sudah dimasukkan. Jika Anda 
memasukkan dua symbol operator secara berurutan, maka 
simbol yang terakhir akan menggantikan simbol 
sebelumnya. Atau, Anda dapat menggunakan backspace 
(mundur) untuk menghapus karakter nilai terkahir dalam 
kolom input saat mengedit perhitungan. 

Untuk beralih antara tampilan kalkulator biasa dan 
tampilan kalkulator till roll, tekan  lalu pilih Lihat 
> Normal atau Till roll. Kalkulator till roll akan 
menampilkan seluruh input sebelumnya.

Untuk menghapus seluruh till roll, tekan  lalu 
pilih Edit > Hapus till roll.

Untuk membalikkan posisi tombol dan kolom input, 
tekan  lalu pilih Tampilan > Balik tata letak.

Menggunakan memori kalkulator
Anda dapat menyimpan satu nilai angka ke dalam memori 
kalkulator dan kemudian mengambilnya, lalu 
menambahkan atau mengurangi nilai ke/dari nilai ini pada 
memori tersebut. Bila nilai angka selain angka nol (0) 
sudah disimpan dalam memori, huruf M akan muncul di 
kiri atas kolom input. Menyimpan nol (0) sama seperti 
menghapus memori.
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Berikut adalah perintah memori:
MR – Memanggil nilai dalam memori ke kolom input.
M+ – Menambahkan nilai dalam kolom input ke nilai 
dalam memori.
M- – Mengurangi nilai dalam kolom input dari nilai dalam 
memori.
MS – Menyimpan nilai saat ini ke dalam memori.

Fungsi konstan
Fungsi konstan dapat digunakan untuk menyimpan 
sementara nilai yang ditambahkan, dikurangi, dikalikan 
atau dibagi secara konstan. 

Untuk menggunakan konstan tertentu, masukkan 
nilai yang akan digunakan sebagai konstan, kemudian 
tekan simbol operator dua kali. Huruf K akan muncul 
dalam baris perhitungan bila nilai konstan sudah 
tersimpan. Masukkan nilai baru, kemudian tekan 
simbol sama dengan (=) untuk menghitung.

Misalnya: Masukkan nilai 2 dalam kalkulator. Tekan 
dua kali simbol tambah (+). Nilai konstan 2 disimpan. 
Masukkan nilai 5, kemudian tekan simbol sama dengan 
(=). Jumlah (7) muncul di layar. Masukkan nilai 10,2 
kemudian tekan =. Jumlah (12,2) muncul di layar.
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Panel kontrol
Buka Meja > Panel kontrol.

Pada Panel kontrol, Anda dapat menetapkan dan 
mengubah berbagai pengaturan smartphone ini. 
Mengubah pengaturan ini akan mempengaruhi 
pengoperasian pada smartphone Anda atas beberapa 
aplikasi.

Untuk kembali ke pengaturan awal, tekan , lalu 
pilih Kembalikan pengaturan orisinil. Tekan Kembalikan 
untuk konfirmasi.

Manajer aplikasi
Buka Meja > Panel kontrol > Manajer Aplikasi.

Melalui aplikasi Manajer apl., Anda dapat melihat rincian 
tentang aplikasi yang diinstal atau menghapusnya dari 
perangkat ini. Anda juga dapat menentukan pengaturan 
penginstalan.

Anda tidak dapat menginstal aplikasi pada Manajer 
aplikasi. Untuk informasi tentang menginstal perangkat 
lunak, lihat “Menginstal perangkat lunak” pada 
halaman 29.

Bila Anda membuka Manajer aplikasi, halaman Aplikasi 
terpasang akan mendaftarkan semua paket perangkat 
lunak yang sudah diinstal, beserta nama, nomor versi, jenis 
dan ukurannya.

Gbr. 30 Manajer Aplikasi

Untuk menampilkan rincian tentang paket 
smartphone lunak yang diinstal, tekan Rincian.

Untuk menghapus paket perangkat lunak yang 
diinstal pada smartphone Anda, pilih paket perangkat 
lunak yang akan dihapus, kemudian tekan Hapus. Pada 
layar akan muncul sebuah dialog yang meminta 
konfirmasi Anda. Tekan Hapus.

Beberapa paket perangkat lunak akan memperbarui 
perangkat lunak yang ada, dan setelah penginstalan maka 
Anda hanya dapat menghapus seluruh paket perangkat 
lunak, bukan pembaruannya.
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Jika Anda menghapus perangkat lunak, Anda hanya dapat 
menginstalnya kembali menggunakan file paket perangkat 
lunak yang asli, atau dengan mengembalikan salinan data 
cadangan lengkap berisi paket perangkat lunak yang telah 
dihapus tersebut. Jika Anda menghapus paket perangkat 
lunak, maka Anda tidak dapat lagi membuka dokumen 
yang dibuat dengan perangkat lunak tersebut. Jika paket 
perangkat lunak yang lain tergantung pada paket 
perangkat lunak yang Anda hapus, maka paket tersebut 
juga tidak dapat berfungsi lagi. Untuk informasi lebih 
lanjut, lihat dokumentasi paket perangkat lunak yang 
diinstal.

Untuk melihat daftar perangkat lunak yang sudah 
diinstal dan dihapus, buka halaman Log instalasi. 
Daftar ini akan menampilkan perangkat lunak yang 
sudah diinstal dan dihapus beserta waktunya. Jika 
Anda mengalami masalah dengan perangkat ini 
setelah menginstal paket perangkat lunak, Anda dapat 
menggunakan daftar tersebut untuk mencari paket 
perangkat lunak yang mungkin menimbulkan masalah. 
Informasi pada daftar ini juga dapat membantu Anda 
mengenali masalah yang disebabkan oleh paket 
perangkat lunak yang tidak kompatibel terhadap satu 
sama lain.

Untuk mengkonfigurasikan pengaturan 
penginstalan, buka halaman Pilihan. Pada halaman ini, 
Anda dapat memilih pilihan yang berkaitan dengan 
penginstalan perangkat lunak. Tetapkan berikut ini:

Hapus file setelah instalasi: – Jika dipilih, file penginstalan 
paket perangkat lunak akan dihapus dari smartphone ini 
setelah penginstalan. Jika Anda mendownload paket 
perangkat lunak dari browser Web, maka hal ini akan 
membantu mengurangi jumlah kapasitas ruang 
penyimpanan yang diperlukan. Jika Anda ingin 
menyimpan file paket perangkat lunak untuk penginstalan 
ulang di lain waktu, atur pilihan ini ke Tidak, atau pastikan 
Anda memiliki salinan file paket perangkat lunak pada PC 
yang kompatibel atau CD-ROM.

Bahasa instalasi standar: – Jika paket perangkat lunak berisi 
beberapa versi bahasa yang berbeda untuk perangkat 
lunak tersebut, maka versi bahasa yang sudah dipilih akan 
diinstal.

Instalasi perangkat lunak: – Menetapkan jenis penginstalan 
SIS yang diperbolehkan. Pilih Aktif untuk memperbolehkan 
semua penginstalan, Hanya yang ditandai untuk hanya 
memperbolehkan penginstalan file SIS dengan tanda 
tangan atau sertifikat yang berlaku, atau Tidak aktif untuk 
melarang semua penginstalan SIS.

Bluetooth
Buka Meja > Panel kontrol > Bluetooth.

Lihat “Sambungan Bluetooth” pada halaman 155.
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Manajer sertifikat
Buka Meja > Panel kontrol > Manajer sertifikat.

Dengan aplikasi Manajer sertifikat, Anda dapat mengatur 
sertifikat digital yang akan digunakan saat mengakses 
situs web, server e-mail, dan waktu penginstalan 
perangkat lunak. Sertifikat digital dapat digunakan untuk:
• mengakses ke bank secara online atau ke situs lain atau 

server remote untuk aktivitas yang melibatkan 
pengiriman informasi rahasia

• mengurangi risiko terinfeksi virus atau perangkat lunak 
jahat, dan memeriksa keaslian perangkat lunak ketika 
Anda mendownload dan menginstalnya

Penting: Ingat, sekalipun penggunaan sertifikat 
akan sangat mengurangi risiko pada sambungan 
remote dan penginstalan perangkat lunak, namun 
sertifikat tersebut harus digunakan secara benar 
agar Anda dapat memperoleh manfaat 
pengamanan canggih ini. Keberadaan sertifikat 
tidak menawarkan perlindungan dengan 
sendirinya, manajer sertifikat harus berisi 
sertifikat yang benar, asli, atau terpercaya untuk 
pengamanan canggih yang tersedia. Sertifikat 
berlaku untuk jangka waktu terbatas. Jika pesan 
"Sertifikat kadaluwarsa” atau “Sertifikat belum 
berlaku” muncul di layar, sekalipun sertifikat 
tersebut seharusnya masih berlaku, periksa 
kebenaran tanggal dan waktu pada smartphone 
Anda.

Sebelum mengubah pengaturan sertifikat, Anda harus 
yakin benar terhadap pemilik sertifikat dan bahwa 
sertifikat tersebut benar-benar milik pihak yang namanya 
tercantum dalam daftar.

Gbr. 31: Manajer sertifikat

Untuk melihat rincian sertifikat, klik dua kali 
sertifikat tersebut. Untuk menghapus sertifikat, 
tekan Hapus.

Untuk menetapkan penggunaan sertifikat, klik dua 
kali sertifikat kemudian tekan Percaya pengaturan. 
Tetapkan berikut ini:

Instalasi SIS: – Pilih kotak pilihan ini, jika Anda ingin 
agar sertifikat ini dapat memeriksa keaslian perangkat 
lunak SIS yang baru.

Instalasi aplikasi: – Pilih kotak pilihan ini, jika Anda 
ingin agar sertifikat ini dapat memeriksa keaslian 
perangkat lunak java yang baru.



Hak cipta © 2005 Nokia. Semua hak dilindungi undang-undang.

Pa
ne

l k
on

tr
ol

122

Web dan e-mail: – Pilih kotak periksa ini, jika Anda ingin 
agar sertifikat ini dapat memeriksa situs web dan 
server e-mail.

Memeriksa keaslian sertifikat
1 Pilih sertifikat, lalu tekan Rincian. Rincian sertifikat 

akan ditampilkan.
2 Kolom Diterbitkan ke: akan mengidentifikasi pemilik 

sertifikat ini. Pastikan ini merupakan nama dari pihak 
yang Anda yakini memiliki sertifikat tersebut.

3 Lihat seluruh dialog sampai Anda menemukan kolom 
Sidik jari:, yang akan mengidentifikasi sertifikat secara 
tepat. Hubungi bagian bantuan atau layanan 
pelanggan dari pemilik sertifikat (lihat langkah 2 di 
atas) dan mintalah sidik jari MD5 untuk sertifikat 
tersebut. Membandingkan sidik jari dengan sidik jari 
yang terdapat dalam dialog. Jika sesuai, maka sertifikat 
tersebut asli.

Gunakan prosedur otentikasi ini untuk memeriksa semua 
sertifikat baru.

Pembatasan panggilan data
Buka Meja > Panel kontrol > P'batasan pgl. data.

Anda dapat menghalangi atau membolehkan jenis 
panggilan data berikut ini:

Semua panggilan masuk: – Bila diaktifkan, panggilan data 
tidak dapat diterima.

Panggilan masuk bila di luar negeri: – Bila diaktifkan, 
panggilan data tidak dapat diterima saat Anda berada di 
luar negara asal.

Semua panggilan keluar: – Bila diaktifkan, panggilan data 
tidak dapat dibuat.

Panggilan internasional: – Bila diaktifkan, panggilan data ke 
luar negeri atau wilayah lain tidak dapat dibuat.

Panggilan internasional kecuali ke negara asal: – Jika Anda 
sudah mengaktifkan roaming internasional melalui 
operator jaringan, maka Anda tidak dapat membuat 
panggilan data internasional saat berada di luar negeri, 
kecuali ke negara asal.

Pilihan yang tersedia adalah:

Aktifkan – Mengaktifkan pembatasan.

Batalkan – Menonaktifkan pembatasan.

Periksa status – Memeriksa apakah pembatasan panggilan 
data diaktifkan atau dinonaktifkan.

Untuk mengubah pengaturan ini, Anda memerlukan sandi 
pembatasan dari operator selular.

Untuk membatalkan semua pembatasan panggilan 
data, tekan Batalkan semua pembatasan.
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Tanggal dan waktu
Buka Meja > Panel kontrol > Tanggal dan waktu.

Untuk mengatur waktu dan tanggal yang aktual, 
ketik waktu dan tanggal langsung pada kolom yang 
sesuai, atau tekan  dan . Tekan tanda panah 
kecil untuk mengubah waktu dan tanggal.

Agar jaringan dapat memperbarui tanggal dan 
waktu secara otomatis pada smartphone Anda, pilih 
Perbaharui otomatis tanggal & waktu:. Fitur ini 
merupakan layanan jaringan. Ingat, pengaturan ini 
mungkin akan menyebabkan beberapa alarm tidak 
berlaku lagi, jika waktu alarm ditetapkan antara waktu 
lampau dan waktu yang diperbarui. 

Untuk menggunakan perbedaan waktu siang hari, 
pilih Terapkan zona perbedaan waktu:.

Tampilan
Buka Meja > Panel kontrol > Tampilan.

Gbr. 32: Layar

Untuk mengubah kecerahan tampilan, tekan  
atau .

Untuk mengatur berapa lama kecerahan tampilan 
akan berkurang agar menghemat daya jika layar 
tidak disentuh, pilih rentang waktu kecerahan yang 
diinginkan.

Tip: Memilih tingkat kecerahan yang rendah dan 
rentang waktu yang pendek akan menghemat daya 
baterai dan mengoptimalkan waktu pengoperasian 
smartphone.

Untuk mengatur berapa lama sebelum screen saver 
diaktifkan jika layar tidak disentuh, pilih batas waktu 
yang diinginkan untuk pilihan Batas waktu screen saver:. 
Ingat, Anda tidak dapat mengubah bentuk tampilan 
screen saver.

Untuk mengatur penguncian tombol dan layar 
sentuh otomatis , pilih kotak pilihan Kunci tampilan 
screen saver & tombol:. Layar sentuh dan tombol akan 
terkunci secara otomatis saat screen saver diaktifkan. 
Untuk informasi lebih lanjut, lihat “Kunci tombol dan 
layar sentuh” pada halaman 27.

Perangkat tambahan
Buka Meja > Panel kontrol > Fitur tambahan.

Di sini Anda dapat menetapkan beberapa pengaturan 
headset dan loopset yang digunakan pada smartphone. 
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Untuk mengubah karakteristik perangkat 
tambahan, tekan Edit kemudian tetapkan pilihan 
berikut:

Profil standar: – Pilih profil yang akan diaktifkan, saat 
Anda memasang headset atau loopset pada 
smartphone.

Jawab otomatis: – Menetapkan apakah Anda ingin agar 
smartphone menjawab panggilan masuk secara 
otomatis setelah 5 detik dengan headset atau loopset 
terpasang pada smartphone.

Pengaturan Internet
Buka Meja > Panel kontrol > Pengaturan internet.

Untuk tersambung ke Internet:
• jaringan nirkabel yang Anda gunakan harus 

mendukung panggilan data atau GPRS
• layanan data harus diaktifkan untuk kartu SIM Anda
• Anda harus memiliki jalur akses Internet dari penyedia 

layanan Internet (ISP)
• Anda harus mengkonfigurasikan pengaturan Internet 

yang diperlukan

Membuat pengaturan jalur akses 
Internet
Berdasarkan jenis kartu SIM yang digunakan, smartphone 
Anda mungkin dapat menambahkan secara otomatis 

pengaturan yang benar untuk browsing WWW dan MMS. 
Beberapa penyedia layanan Internet mungkin 
menyediakan kemudahan dalam mengkonfigurasi 
pengaturan jalur akses Internet dalam bentuk pesan yang 
dikirim kepada Anda. Cara ini akan mengurangi sejumlah 
pengaturan yang harus Anda masukkan sendiri, atau 
meminimalkan pengaturan yang diperlukan. Untuk 
informasi lebih lanjut, lihat “Layanan selular Plug and 
play” pada halaman 77.

Nilai yang tepat untuk pengaturan tersebut biasanya 
diberikan oleh penyedia layanan Anda. Ikuti petunjuk yang 
diberikan oleh operator selular Anda dengan sangat hati-
hati.

Ingat, pengiriman data apapun melalui GPRS akan dikenai 
biaya pengiriman sesuai tarif operator.

Untuk mengatur jalur akses Internet, tekan Jalur 
akses baru. Untuk mengedit jalur akses Internet yang 
ada, tekan Jalur akses. Tetapkan isian pada kolom 
berikut di halaman wizard pengaturan Internet:

Nama koneksi: – Menetapkan nama sambungan.

Media data: – Memilih jenis sambungan data. Untuk 
informasi lebih lanjut tentang jenis sambungan data, 
lihat “Sambungan data” pada halaman 32.

Tergantung sambungan data yang Anda pilih, 
beberapa kolom pengaturan akan tersedia di halaman 
berikut pada wizard.



Hak cipta © 2005 Nokia. Semua hak dilindungi undang-undang.

Pa
ne

l k
on

tr
ol

125

Rincian tentang panggilan data GSM
Nomor dial-up: — Nomor telepon modem untuk jalur akses.

Rincian tentang GPRS
Jenis jaringan: – Memilih versi protokol Internet yang akan 
Anda gunakan.

Jalur akses pengambilan otomatis: – Jika operator jaringan 
Anda mendukung fitur ini, nama jalur akses dapat 
diperoleh secara otomatis dari jaringan. Jalur akses 
diperlukan untuk membuat sambungan ke jaringan GPRS.

Nama jalur akses: – Jika Anda tidak menggunakan Jalur akses 
pengambilan otomatis:, tentukan nama untuk jalur akses 
tersebut. Nama jalur akses dapat diperoleh dari operator 
jaringan atau operator selular Anda.

Rincian tentang login
Minta sandi setiap login: – Pilih ini jika harus memasukkan 
sandi baru setiap kali Anda mengakses server, atau jika 
tidak ingin menyimpan sandi pada smartphone.

Nama pengguna: – Ketik nama pengguna jika diminta oleh 
operator selular. Nama pengguna diperlukan untuk 
membuat sambungan data, dan biasanya diberikan oleh 
operator selular. Penulisan huruf besar dan huruf kecil 
pada nama pengguna harus diperhatikan.

Sandi: – Sandi mungkin diperlukan untuk membuat 
sambungan data, dan biasanya diberikan oleh operator 
selular. Penulisan huruf besar dan huruf kecil pada sandi 
harus diperhatikan.

Rincian tentang VPN
Ingat, Anda harus memiliki paling sedikit satu jalur akses 
internet dan sedikitnya satu VPN pengaman yang terinstal 
sebelum Anda dapat menetapkan jalur akses VPN.  Untuk 
informasi tentang menginstal pengaman VPN, lihat 
“Menjalankan server pengamanan VPN” pada 
halaman 140.

Jalur akses internet: — Pilih jalur akses yang akan digunakan 
untuk akses VPN Anda.

Kebijaksanaan VPN: — Pilih pengamanan VPN yang akan 
digunakan untuk akses VPN Anda.

Pengaturan Internet lanjutan
Setelah Anda selesai mengatur atau mengubah 
pengaturan akses Internet melalui wizard pengaturan 
Internet (Panel kontrol > Pengaturan internet > Jalur akses 
baru), Anda dapat melanjutkan dengan mengkonfigurasi 
pengaturan lanjutan. Halaman dan pilihan yang tersedia 
tergantung pada apakah Anda telah memilih data paket 
(GPRS), panggilan data GSM atau sambungan VPN.

Halaman panggilan data
Jenis panggilan: – Menetapkan jenis panggilan data GSM. 
Pilihan yang tersedia adalah Normal dan Data kcpt. tinggi 
(Hy GSM).

Agar dapat menggunakan Data kcpt. tinggi (Hy GSM), 
operator selular harus mendukung fitur ini, dan jika perlu, 
mengaktifkannya untuk kartu SIM Anda.
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Jenis modem: – Analog, ISDN V.110 atau ISDN V.120 
menentukan apakah smartphone akan menggunakan 
sambungan analog atau digital. Pengaturan ini akan 
tergantung pada operator jaringan GSM dan penyedia 
layanan Internet, karena beberapa jaringan GSM tidak 
mendukung sambungan ISDN jenis tertentu. Untuk 
informasi lebih lanjut, hubungi penyedia layanan Internet 
Anda. Jika sambungan ISDN tersedia, maka pembuatan 
sambungan akan menjadi lebih cepat daripada metode 
analog.

Kecepatan data maksimum: – Pilihan ini memungkinkan 
Anda membatasi kecepatan sambungan maksimum bila 
data berkecepatan tinggi digunakan. Semakin tinggi 
kecepatan data yang digunakan akan semakin mahal biaya 
yang dibebankan, tergantung tarif yang ditetapkan oleh 
penyedia layanan jaringan.

Kecepatan ini menggambarkan kecepatan maksimum yang 
akan digunakan oleh sambungan Anda. Selama 
sambungan berlangsung, kecepatan pengoperasian dapat 
berkurang, tergantung pada kondisi jaringan.

Inisialisasi modem: – Anda dapat mengontrol smartphone 
ini melalui perintah AT modem. Jika diminta, masukkan 
karakter yang sudah ditentukan oleh operator selular 
jaringan GSM atau penyedia layanan Internet Anda.

Halaman proxy
Anda dapat menggunakan proxy untuk mempercepat 
akses ke Internet. Ingat, beberapa penyedia layanan 
Internet juga memerlukan penggunaan proxy Web. 

Hubungi penyedia layanan Internet Anda untuk 
menetapkan rincian proxy.

Jika sambungan Internet ke intranet perusahaan Anda 
sudah dibuat, namun Anda tidak dapat membuka halaman 
Web dari Internet biasa, mungkin Anda harus membuat 
sambungan server proxy untuk membuka halaman Web di 
luar intranet perusahaan Anda.

Protokol: – Memilih jenis protokol proxy. Anda dapat 
menetapkan pengaturan proxy untuk masing-masing 
protokol.

Gunakan proxy: – Untuk menggunakan server proxy, 
lakukan pilihan ini.

Alamat server proxy: – Alamat IP server proxy, atau nama 
domain. Contoh nama domain adalah: perusahaan.com 
dan organisasi.org.

Nomor port: – Nomor port proxy. Nomor port berkaitan 
dengan protokol. Nomor port yang biasa digunakan adalah 
8000 dan 8080, namun berbeda-beda untuk setiap server 
proxy.

Jangan gunakan proxy untuk: – Tetapkan di sini domain yang 
tidak diperlukan oleh proxy HTTP atau HTTPS. Dalam 
daftar, pisahkan nama domain dengan tanda titik koma.

Halaman alamat IP
Ingat, kedua protokol (IPv4 dan IPv6) akan memerlukan 
pengaturan yang sedikit berbeda.
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Pengambilan auto alamat IP: – Jika dipilih, alamat IP akan 
diperoleh secara otomatis dari server. Pengaturan ini juga 
disebut sebagai ‘alamat IP dinamis’.

Alamat IP: – Alamat IP pada smartphone ini. Jika alamat IP 
diperoleh secara otomatis, maka Anda tidak perlu 
memasukkan rincian di sini.

Alamat DNS: – Jika Anda melakukan pilihan Pengambilan 
otomatis untuk protokol IPv4, maka alamat DNS (Domain 
Name Server) akan diperoleh secara otomatis dari server. 
Nilai yang sesuai untuk protokol IPv6 adalah Gunakan yang 
terkenal. DNS adalah fitur Internet yang 
menginterpretasikan nama domain seperti www.nokia.com 
ke dalam alamat IPv4 seperti 192.100.124.195, atau alamat 
IPv6 misalnya 3ffe:2650:a640:1c2:341:c39:14.

Alamat DNS primer: – Alamat IP untuk server DNS primer. 
Jika alamat IP diperoleh secara otomatis, maka Anda tidak 
perlu memasukkan rincian di sini.

Alamat DNS sekunder: – Alamat IP untuk server DNS 
sekunder.

Halaman skrip login
Gunakan skrip login: – Jika dipilih, Anda dapat membuat 
atau mengimpor skrip login dalam format teks biasa. Anda 
dapat mengedit skrip dalam kolom yang ditampilkan di 
dasar layar.

Tampilkan post-dial terminal: – Jika dipilih, jendela terminal 
akan terlihat pada layar selama sambungan data 
berlangsung.

Tip: Penyedia layanan Internet Anda dapat 
menyediakan skrip yang diperlukan.

Tip: Skrip biasanya tidak diperlukan ketika Anda 
membuat sambungan. Untuk mengetahui apakah 
Anda memerlukan skrip, hubungi penyedia layanan 
Internet Anda.

Halaman lainnya
Bolehkan login teks biasa: – Jika dipilih, sandi untuk 
sambungan dapat dikirim dalam bentuk teks biasa. Untuk 
pengamanan yang optimal, hapus pilihan ini. Beberapa 
penyedia layanan Internet mengharuskan pilihan ini dipilih.

Gunakan kompresi PPP: – Pilihan ini akan mempercepat 
pengiriman data, jika didukung oleh server PPP remote. 
Jika Anda mengalami masalah saat membuat sambungan, 
cobalah untuk tidak mencentang kotak pilihan ini. 
Hubungi penyedia layanan Internet Anda untuk 
memperoleh petunjuk.

Jenis panggilan ulang: – Tanyakan kepada penyedia layanan 
Internet Anda untuk pengaturan benar yang akan 
digunakan. Pengaturan ini tergantung pada konfigurasi 
penyedia layanan.

Nomor panggilan ulang: – Masukkan nomor telepon data 
smartphone Anda yang akan digunakan oleh server 
panggilan balik. Biasanya, nomor ini merupakan nomor 
telepon panggilan data dari smartphone Anda.
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Pengaturan sambungan Internet
Untuk mengkonfigurasikan pengaturan sambungan 
Internet, isi kolom berikut:

Umum
Jalur akses pilihan: – Pilih jalur akses untuk menyambung ke 
Internet.

Tanya sebelum sambung: – Jika memilih ini, sebuah dialog 
akan muncul setiap kali Anda menyambung ke Internet, 
meminta Anda untuk mengkonfirmasikan sambungan atau 
mengubah jalur akses.

Panggilan data
Putuskan bila tidak digunakan dalam: – Pilih batas waktu 
sebelum panggilan data diakhiri secara otomatis jika 
sambungan tersebut tidak digunakan.

Beberapa sambungan Internet mungkin akan muncul tidak 
aktif, namun sambungan tersebut masih akan mengirim 
dan menerima data di latar belakang. Sambungan ini 
dapat menunda batas waktu penonaktifan yang sudah 
ditentukan di sini, dan karena itu menunda pemutusan 
sambungan.

Pengaturan panggilan data akan mempengaruhi semua 
jalur akses yang menggunakan panggilan data dan 
panggilan data berkecepatan tinggi. Untuk informasi lebih 
lanjut tentang sambungan data, lihat “Sambungan data” 
pada halaman 32.

GPRS
Putuskan bila tdk d'gnakan dlm: – Pilih batas waktu sebelum 
panggilan GPRS diatur ke modus siaga, jika sambungan 
tersebut tidak digunakan.

Koneksi GPRS: – Pilih Jika ada untuk mempertahankan 
sambungan GPRS dalam modus peringatan dan untuk 
mengaktifkan pengiriman data paket dengan cepat saat 
diperlukan. Jika Anda memilih Jika diperlukan, maka 
smartphone akan menggunakan sambungan GPRS hanya 
jika Anda menjalankan aplikasi atau aktivitas yang 
memerlukan sambungan ini. Ingat, jika tidak ada layanan 
GPRS yang terjangkau dan Anda sudah memilih pilihan 
Jika ada, maka smartphone ini akan secara berkala 
mencoba membuat sambungan GPRS.

Pengaturan GPRS akan mempengaruhi semua jalur akses 
yang menggunakan sambungan GPRS.

Memori 
Buka Meja > Panel kontrol > Memori.

Anda dapat melihat jumlah memori yang belum terpakai 
dan kebutuhan jumlah memori dari setiap objek di 
smartphone Anda dan kartu memori.

Tip: Untuk menghemat ruang memori pada 
smartphone, Anda harus menghapus atau mengirim 
data ke kartu memori atau PC secara berkala.

Untuk informasi lebih lanjut, lihat “Manajemen memori” 
pada halaman 26.
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Pengaturan Tampilan saya
Buka Meja > Panel kontrol > P'aturan tamp. saya.

Biasanya Anda akan menekan  tombol atau menyentuh 
 ikon untuk kembali ke Meja. Melalui pengaturan 

Tampilan saya, Anda dapat mengatur smartphone ini agar 
penekanan berganti untuk  membuka Meja atau 
aplikasi favorit Anda.

Untuk memilih aplikasi yang akan terbuka bila Anda 
menekan tombol Meja dalam Meja, tekan , lalu 
pilih aplikasi tersebut dari daftar.

Pengaturan input pena
Buka Meja > Panel kontrol > P'aturan input pena.

Lihat “Pengaturan input pena” pada halaman 38.

Pengaturan posisi
Buka Meja > Panel kontrol > Pengaturan posisi.

Beberapa jaringan mengizinkan pengguna lain untuk 
mengetahui posisi smartphone Anda (layanan jaringan). 
Layanan dan pengaturan ini hanya dapat digunakan jika 
Anda menginstal aplikasi yang mendukung layanan ini.

Tetapkan berikut ini:

Prioritas
Pada halaman prioritas Anda dapat menetapkan prioritas 
untuk masing-masing metode penetapan posisi yang 
berbeda

Untuk mengubah prioritas dari sebuah metode 
lokasi, tekan  lalu pilih metode yang akan Anda 
gunakan untuk menentukan posisi tersebut.

Rincian
Pada halaman Rincian, Anda dapat melihat informasi 
tentang metode dan mengubah biayanya.

Anda dapat melihat informasi berikut: 

Metode: – Pilih metode pencarian posisi yang sesuai.

Waktu posisi rata-rata: – Waktu rata-rata yang diperlukan 
dalam proses penentuan posisi.

Tingkat: – Perkiraan biaya untuk metode yang digunakan.

Penggunaan baterai: – Perkiraan kebutuhan daya baterai 
untuk metode yang digunakan.

Akurasi: – Akurasi horizontal untuk metode yang 
digunakan.

Untuk mengubah biaya metode yang digunakan, 
tekan Edit kemudian tekan  untuk memilih metode. 
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Pengaturan pribadi
Buka Meja > Panel kontrol > Pengaturan pribadi.

Halaman umum
Pengaturan pada halaman ini akan menggantikan semua 
pengaturan secara individu. Tetapkan berikut ini:

P'aturan permintaan: – Menetapkan pengaturan pribadi 
secara global. Pilih Pakai peraturan individu untuk 
menggunakan pengaturan yang telah ditetapkan pada 
masing-masing kontak dan layanan di halaman Individu. 
Pilih Konfirmasi dulu yang diperlukan untuk menyetujui 
semua permintaan lokasi tanpa memperhatikan 
pengaturan pada halaman Individu. Pilih Selalu diterima 
atau Selalu ditolak untuk menyetujui atau menolak 
permintaan lokasi tanpa memperhatikan pengaturan pada 
halaman Individu.

Berlaku sampai: – Menetapkan batas waktu untuk 
penerimaan atau penolakan, jika dapat ditentukan. Pada 
saat batas waktu tiba, tingkat privasi akan beralih ke Pakai 
peraturan individu.

Beritahu bila terkirim: – Menetapkan pengaturan 
pemberitahuan secara global. Pilihan ini hanya akan 
tersedia, jika Anda telah menetapkan Selalu diterima 
sebagai aturan verifikasi.

Halaman individu
Pada halaman Individu, Anda dapat menetapkan 
pengaturan pribadi untuk kontak atau layanan yang 
spesifik.

Halaman ini berisi daftar kontak dan layanan yang 
memiliki pengaturan pribadi yang spesifik. Jika kontak 
atau layanan tertentu meminta lokasi, maka Anda dapat 
menambahkannya dalam daftar pribadi. Anda hanya dapat 
menambahkan kontak ke dalam daftar yang terdapat pada 
dialog ini.

Untuk menambahkan kontak, tekan Tambah, pilih 
kontak dalam daftar kemudian tekan Tutup. Tetapkan 
pengaturan pribadi secara individu. Pilihan ini mirip 
dengan yang ditetapkan pada halaman Global. Tekan 
Tutup untuk melanjutkan.

Untuk mengedit kontak, tekan Edit, kemudian ubah 
masing-masing pengaturan pribadi. Pilihan ini mirip 
dengan yang ditetapkan pada halaman Global. Tekan 
Tutup untuk melanjutkan.

Untuk informasi lebih lanjut tentang pemilihan kontak, 
lihat “Melihat dan mencari kontak” pada halaman 68.

Pengaturan RealPlayer
Buka Meja > Panel kontrol > P'aturan RealPlayer.

Tetapkan berikut ini:
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Jaringan
Kecepatan data: – Memilih kecepatan sambungan. Ingat, 
pilihan Sangat cepat dan Lambat dapat mempengaruhi 
kualitas tampilan video.

Batas waktu koneksi: – Memilih rentang waktu dalam 
hitungan detik sebelum sambungan diputus, setelah 
proses penyambungan tidak berhasil.

Batas waktu server: – Jika server tidak dapat mengirim data 
yang diperlukan dan terjadi pengumpulan data sementara, 
maka Anda harus menetapkan batas waktu koneksi server.

Jarak port: – Batas jangkauan nomor port yang digunakan 
untuk sambungan. Nilai standar yang digunakan sama 
dengan yang ditetapkan untuk pengaturan Internet.

Jalur akses standar: – Sambungan yang akan Anda gunakan 
sebagai sambungan standar. Nilai standar yang digunakan 
sama dengan yang ditetapkan untuk pengaturan Internet.

Proxy
Gunakan proxy: – Untuk menggunakan server proxy, pilih 
pilihan ini.

Alamat server: – Alamat IP server proxy, atau nama domain. 
Contoh nama domain adalah: perusahaan.com dan 
organisasi.org.

Nomor port: – Nomor port proxy. Nomor port berkaitan 
dengan protokol. Port standar adalah 1091.

Pengaturan regional
Buka Meja > Panel kontrol > P'aturan regional.

Pada halaman berikut Anda dapat menetapkan format 
untuk waktu lokal, tanggal, penulisan angka dan nilai 
tukar mata uang.

Waktu
Format waktu: – Memilih format waktu 24-jam atau 
12-jam.

Format am/pm: – Jika Anda memilih format waktu 12-jam 
pada kolom sebelumnya, pilih lokasi dan tampilan 
indikator.

Pemisah: – Memilih tanda pisah yang digunakan antara 
jam dan menit.

Tanggal
Format tanggal: – Memilih susunan tanggal.

Pemisah: – Memilih tanda pisah yang digunakan antara 
bagian tanggal.

Minggu mulai di: – Memilih hari pertama dalam seminggu

Hari kerja: – Memilih hari kerja dalam seminggu

Nomor
Pemisah desimal: – Memilih tanda pisah yang digunakan 
untuk menyatakan bilangan desimal.
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Pemisahan ribuan: – Centang kotak pilihan ini jika Anda 
ingin menggunakan tanda pisah antara ribuan dan 
ratusan.

Pemisah ribuan: – Memilih tanda pisah untuk ribuan.

Unit ukuran: – Memilih satuan pengukuran lokal untuk 
besaran panjang.

Mata uang
Simbol mata uang: – Masukkan simbol untuk mata uang 
lokal.

Tempat desimal: – Tekan - atau + untuk memilih jumlah 
titik desimal yang digunakan dalam nilai mata uang.

Posisi simbol: – Memilih posisi simbol mata uang yang 
menyertai nilai mata uang.

Format nilai negatif: – Memilih bentuk penulisan nilai 
negatif mata uang yang akan ditampilkan.

Pengamanan
Buka Meja > Panel kontrol > Keamanan.

Di sini Anda dapat menetapkan tingkat keamanan 
smartphone Anda.

Kode ditampilkan dalam tanda bintang. Jika Anda 
mengubah kode, Anda akan diminta untuk memasukkan 
kode terakhir kemudian kode baru sebanyak dua kali. 
Untuk informasi lebih lanjut tentang kode akses, lihat 
“Kode akses” pada halaman 26.

Hindari penggunaan kode yang mirip dengan nomor 
darurat, misalnya 112, untuk mencegah pemanggilan 
nomor darurat secara tidak disengaja.

Mengunci perangkat
Periode kunci otomatis: – Anda dapat mengatur rentang 
waktu penguncian otomatis, smartphone akan terkunci 
secara otomatis setelah batas waktu yang ditentukan tiba 
dan hanya dapat digunakan kembali setelah kode kunci 
yang benar dimasukkan.

Catatan: Bila telepon terkunci, panggilan akan tetap 
dapat dilakukan ke nomor darurat yang sudah 
diprogram ke dalam telepon Anda.

Kode kunci: – Panjang kode kunci harus terdiri dari 5 
hingga 10 digit. Pengaturan awal untuk kode kunci adalah 
12345. Untuk menghindari penyalahgunaan smartphone 
oleh orang lain, gantilah kode kunci tersebut. Jaga 
kerahasiaan kode baru tersebut dan catat di tempat yang 
aman terpisah dari smartphone Anda.

Kunci bila kartu SIM berubah: – Anda dapat mengatur 
smartphone ini agar meminta kode kunci bila kartu SIM 
tak dikenal dimasukkan ke dalam smartphone Anda. 
smartphone ini menyimpan daftar kartu SIM yang dikenali 
sebagai kartu pemilik.
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Kode PIN
Permintaan kode PIN: – Jika diaktifkan, kode ini akan 
diminta setiap kali smartphone dinyalakan. Ingat, 
sejumlah kartu SIM kemungkinan tidak memperbolehkan 
penonaktifan kode PIN. Jika Anda memasukkan kode PIN 
yang salah sebanyak tiga kali berturut-turut, Anda akan 
diminta untuk memasukkan kode PUK (PIN Unblocking 
Key) untuk mengaktifkan kembali kartu SIM yang diblokir. 
Saat kartu SIM diblokir, Anda hanya dapat menghubungi 
nomor darurat yang telah diprogram. Diluar itu, Anda tidak 
akan dapat menggunakan smartphone sampai Anda 
memasukkan kode yang diminta. 

Ingat, pengaturan ini tidak dapat diubah jika telepon 
dinonaktifkan atau jika kartu SIM yang tidak sah 
dimasukkan. Ingat juga, beberapa kartu SIM tidak 
memungkinkan Anda menonaktifkan permintaan kode 
PIN.

Konfirmasi layanan SIM: (layanan jaringan) – Untuk 
mengatur smartphone agar menampilkan pesan 
konfirmasi saat Anda menggunakan layanan kartu SIM.

Kode PIN: – Panjang kode PIN harus terdiri dari 4 hingga 8 
digit.

Kode PIN2: – Panjang kode PIN2 yang baru harus terdiri dari 
4 hingga 8 digit. Kode PIN2 diperlukan untuk mengakses 
beberapa fungsi, seperti pengaturan biaya panggilan, yang 
harus didukung oleh kartu SIM Anda. Jika Anda 
memasukkan kode PIN2 yang salah sebanyak tiga kali 

berturut-turut, Anda akan diminta memasukkan kode 
PUK2 untuk mengaktifkan kembali PIN2 yang diblokir. 
Panjang kode PIN2 yang baru harus terdiri dari 4 hingga 8 
digit.

Pembatasan panggilan
Sandi pembatasan: – Tekan Ubah untuk mengganti sandi 
pembatasan. Panjang sandi pembatasan harus terdiri dari 
4 digit. Jika Anda memasukkan sandi yang salah sebanyak 
tiga kali berturut-turut, maka sandi tersebut akan diblokir 
dan Anda harus meminta sandi baru kepada penyedia 
layanan jaringan Anda.

Penentu layar
Buka Meja > Panel kontrol > Kalibrasi layar.

Jika respon dari bidang permukaan sensitif pada layar 
tidak akurat, maka diperlukan kalibrasi. Ikuti petunjuk 
pada layar.

Tema
Buka Meja > Panel kontrol > Tema.

Tema adalah file-file khusus yang berisi informasi 
pemformatan, gambar dan suara. Melalui tema Anda 
dapat mengubah tampilan dan suara smartphone Anda. 
Tema standar tidak dapat dihapus.
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Untuk mengubah tampilan atau suara pada 
smartphone Anda, tekan Tema. Pilih tema dari daftar, 
lalu tekan Terapkan. Untuk melihat bentuk tampilan 
tema yang dipilih, tekan Tes, kemudian Lihat dulu. 
Tekan Suara untuk mendengarkan suara tema (jika 
tersedia).

Bahasa perangkat
Buka Meja > Panel kontrol > Bahasa perangkat.

Untuk mengubah bahasa yang digunakan 
smartphone, tekan Bahasa perangkat:. Perubahan 
bahasa yang dilakukan juga akan mempengaruhi 
beberapa pengaturan regional, misalnya simbol mata 
uang dan satuan pengukuran.

Perintah layanan
Buka Meja > Panel kontrol > Perintah layanan.

Anda dapat mengirim permintaan layanan, seperti 
perintah pengaktifan layanan jaringan kepada penyedia 
layanan Anda. Untuk informasi lebih lanjut, hubungi 
penyedia layanan Anda.

Untuk mengirim permintaan, ketik permintaan dalam 
kolom, kemudian tekan Kirim. 
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Virtual private networking
Melalui virtual private networking (VPN), Anda dapat 
membuat sambungan terenkripsi ke informasi yang 
diperlukan saat berada di luar kantor. Anda tetap 
terhubung dan dalam kendali dengan akses terenkripsi ke 
jaringan perusahaan untuk e-mail, aplikasi database dan 
intranet.

Lalu lintas jaringan remote harus dilindungi. Perusahaan 
Anda dapat menggunakan VPN untuk membatasi lalu 
lintas jaringan dan menerapkan aturan pengamanan yang 
diperlukan. VPN membantu menyediakan transaksi 
jaringan dengan kerahasiaan dan integrasi serta 
menerapkan otentikasi dan otorisasi bagi pengguna untuk 
mengakses ke jaringan dan layanan jaringan. 

Untuk membuat VPN, gateway dan smartphone akan 
saling melakukan otentikasi satu sama lain serta 
menyesuaikan enkripsi dan algoritma otentikasi untuk 
membantu melindungi kerahasiaan dan integritas 
informasi yang Anda akses.

Catatan: Sistem VPN pada Nokia 7710 smartphone 
saat ini mendukung gateway berikut: Nokia IP VPN 
Gateway, Cisco VPN 3000 Concentrator Series dan 
Nokia IP Security Platform. Cari www.nokia-asia.com 
untuk informasi terkini pada gateway yang didukung.

Menjalankan virtual private 
networking
Untuk menggunakan sambungan VPN, Anda harus 
membuat jalur akses VPN terlebih dulu, dan kemudian 
memilih jalur akses VPN jika Anda menggunakan aplikasi 
untuk tersambung ke perusahaan. Sambungan VPN dibuat 
ke jaringan perusahaan melalui sambungan jalur akses 
Internet jenis lainnya. 
Sambungan dibuat dan dienkripsi sesuai pengamanan VPN 
yang ditampilkan saat Anda tersambung ke salah satu jalur 
akses VPN.

Untuk menggunakan virtual private networking

1 Buka Meja > Panel kontrol > Manajemen VPN..
2 Tentukan sambungan ke server pengamanan VPN. 

Anda dapat menetapkan server pengamanan VPN 
dalam Manajemen VPN atau menginstal pengaturan 
dari file Symbian installation system (SIS).
Untuk informasi lebih lanjut, lihat “Menyambung ke 
server pengamanan VPN” pada halaman 140.

Catatan: Jika pengamanan VPN diinstal dari file 
SIS, Anda tidak perlu membuat sambungan ke 
server pengamanan VPN.
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3 Instal pengamanan VPN dari server pengamanan VPN.
Untuk informasi lebih lanjut, lihat “Menginstal 
pengamanan VPN dari server pengamanan VPN” pada 
halaman 136.

4 Buat jalur akses VPN.
Jalur akses VPN akan menentukan jalur akses Internet 
dan pengamanan VPN. Untuk informasi lebih lanjut 
tentang pembuatan jalur akses, lihat “Membuat 
pengaturan jalur akses Internet” pada halaman 124.

Catatan: Jalur akses VPN menggabungkan 
pengamanan VPN dengan jalur akses Internet. Saat 
Anda melakukan sinkronisasi server pengamanan 
VPN untuk pertama kalinya, pencocokan jalur akses 
VPN dibuat untuk setiap pengamanan yang diinstal 
pada smartphone. 

5 Pilih jalur akses VPN jika Anda menggunakan aplikasi 
untuk tersambung ke jaringan perusahaan.
Untuk informasi lebih lanjut, lihat “Menggunakan VPN 
dengan aplikasi” pada halaman 145.
Sambungan VPN dibuat lebih dulu dari sambungan 
jalur akses Internet.

Menjalankan pengamanan VPN
Pengamanan VPN menetapkan metode bahwa VPN client 
dan gateway VPN saling mengotentikasi satu sama lain 
dan algoritma enkripsi yang digunakan keduanya untuk 
membantu melindungi kerahasiaan data. Administrator 

membuat pengamanan VPN dan menyimpannya pada 
server pengamanan VPN atau mengirimnya ke Anda 
sebagai file SIS. Anda dapat menginstal pengamanan VPN 
dari server pengamanan VPN dalam Manajemen VPN. 

Menginstal pengamanan VPN dari 
server pengamanan VPN
Dalam Manajemen VPN, Anda dapat menginstal 
pengamanan VPN dari server pengamanan VPN.

Tip: Server pengamanan VPN merupakan server 
jaringan perusahaan yang berisi pengamanan VPN.

Untuk menginstal pengamanan VPN

1 Buka Panel kontrol > Manajemen VPN. 
2 Tekan Ya jika Manajemen VPN meminta Anda untuk 

menginstal pengamanan VPN.
3 Tekan kembali Ya untuk menambahkan server 

pengamanan VPN.
4 Tentukan pengaturan untuk sambungan server 

pengamanan VPN, kemudian tekan Selesai.
Untuk informasi lebih lanjut, lihat “Menyambung ke 
server pengamanan VPN” pada halaman 140.

5 Tekan Ya untuk melakukan sinkronisasi server 
pengamanan VPN.
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6 Buat tombol perlindungan sandi, kemudian tekan OK.
Tip: Tombol perlindungan sandi akan membantu 
mengamankan tombol pribadi dalam pengamanan 
VPN dan sambungan server pengamanan VPN dari 
penggunaan yang tidak sah.

Untuk informasi lebih lanjut, lihat “Membuat atau 
mengubah tombol perlindungan sandi” pada 
halaman 144.
Smartphone tersambung ke server pengamanan VPN.

7 Verifikasikan kode identitas server pengamanan VPN, 
lalu masukkan karakter yang hilang untuk membangun 
kepercayaan antara smartphone dan server 
pengamanan VPN, kemudian tekan OK. 
Anda dapat mengabaikan langkah ini jika pengaturan 
server pengamanan VPN diinstal dari file SIS.

Tip: Kode identitas server pengamanan VPN 
merupakan sidik jari dari sertifikat server 
pengamanan VPN yang akan mengenali sertifikat 
tersebut.

Untuk informasi lebih lanjut, lihat “Menambahkan 
server pengamanan VPN” pada halaman 141.

8 Masukkan informasi otentikasi untuk mengakses server 
pengamanan VPN, kemudian tekan OK.
Administrator akan memberitahukan informasi yang 
harus Anda masukkan.

Pengamanan VPN diinstal pada smartphone. 

Catatan: Jika Anda menekan Batalkan, pengamanan 
VPN tidak akan diinstal. Pilih Pasang untuk menginstal 
pengamanan VPN dari server pengamanan VPN.

Menginstal pengamanan VPN dari 
file SIS
Administrator dapat mengirim pengamanan VPN kepada 
Anda sebagai file SIS. Jika Anda menginstal pengamanan 
VPN dari file SIS, maka Anda tidak perlu membuat 
sambungan ke server pengamanan VPN. Setelah 
pengamanan VPN diinstal, Anda dapat membuat jalur 
akses VPN dan menghubungkannya ke aplikasi.
Jika pengamanan VPN berisi tombol pribadi dan sertifikat 
terkait, administrator akan membuat tombol impor sandi 
untuk membantu mengamankan tombol pribadi. 
Administrator harus menggunakan metode yang aman 
untuk mengirim tombol impor sandi tersebut ke Anda.

Tip: Tombol impor sandi akan membantu 
mengamankan tombol pribadi dalam file pengamanan 
VPN.

Untuk menginstal pengamanan VPN dari file SIS, 
tulis tombol impor sandi dalam Sandi impor tombol: lalu 
tekan OK. Kemudian tulis tombol perlindungan sandi 
dalam Sandi untuk menyimpan tombol lalu tekan OK.
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Melihat pengamanan VPN
Dalam Manajemen VPN, Anda dapat melihat, memperbarui, 
dan menghapus pengamanan VPN yang diinstal pada 
smartphone.

Untuk melihat rincian pengamanan VPN, pilih 
pengamanan VPN lalu tekan Buka untuk melihat 
informasi lebih lanjut.

Gulir untuk melihat informasi berikut tentang masing-
masing pengamananVPN:

• Deskripsi: menunjukkan informasi tambahan tentang 
pengamanan VPN. Keterangan dibaca dari 
pengamanan VPN. Administrator akan memasukkan 
keterangan saat membuat pengamanan VPN.

• Status kebijakan: menunjukkan apakah pengamanan 
VPN siap digunakan atau tidak atau apakah sudah 
digunakan. 

• Status sertifikat: menunjukkan apakah sertifikat 
pengguna yang sah tersedia dalam smartphone.

• Nama kebijakan: menunjukkan nama pengamanan VPN. 
Administrator akan menetapkan nama tersebut saat 
membuat pengamanan VPN.

• Server kebijakan: menunjukkan nama server 
pengamanan VPN dari lokasi asal penginstalan 
pengamanan VPN. Berikan nama untuk server 
pengamanan VPN saat Anda membuat sambungan ke 
server pengamanan VPN. Kolom ini tidak akan terlihat 
jika Anda menginstal pengamanan VPN dari file SIS.

• Diperbaharui: menunjukkan tanggal pembaruan 
terakhir untuk pengamanan VPN dari server 
pengamanan VPN. Kolom ini tidak akan terlihat jika 
Anda menginstal pengamanan VPN dari file SIS. 

Memeriksa status pengamanan
Status kebijakan: dapat berisi nilai-nilai berikut:
Sedang digunakan – Anda telah membuat sambungan ke 
jalur akses VPN yang terkait dengan pengamanan VPN. 
Saat Anda membuat sambungan, pengamanan VPN 
diaktifkan.
Berhubungan den-gan jalur akses VPN – Anda 
menghubungkan pengamanan VPN dengan satu atau 
beberapa jalur akses VPN. Anda dapat memilih jalur akses 
VPN apa saja untuk mengaktifkan pengamanan VPN 
tersebut.
Tak berhubungan jalur akses VPN – Anda harus 
menghubungkan pengamanan VPN dengan salah satu 
jalur akses VPN untuk mengaktifkan pengamanan VPN.

Catatan: Tampilan rincian VPN tidak akan diperbarui 
jika status pengamanan berubah saat tampilan dibuka.

Memeriksa status sertifikat

Status sertifikat: dapat berisi nilai-nilai berikut:
Tidak diketahui – Client VPN tidak dapat menentukan 
status sertifikat.
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OK – sekurangnya satu sertifikat yang berlaku tersedia 
dalam smartphone atau Anda tidak menggunakan 
sertifikat untuk otentikasi ke gateway VPN.
Kadaluarsa – masa berlaku dari satu atau beberapa 
sertifikat telah berakhir. Jika Anda tidak dapat membuat 
sambungan VPN, perbarui pengamanan VPN untuk 
mendaftarkan sertifikat baru. 
Tidak ada sertifikat – Satu atau beberapa sertifikat yang 
diperlukan tidak dapat ditemukan pada smartphone. Jika 
Anda tidak dapat membuat sambungan VPN, coba 
perbarui pengamanan VPN untuk mendaftarkan sertifikat 
baru.
Belum berlaku – satu atau beberapa sertifikat belum 
digunakan untuk saat ini. Nilai ini juga dapat menunjukkan 
bahwa tanggal dan waktu pada smartphone sudah diatur 
sebelumnya, penetapan zona waktu salah, atau 
pengaturan perbedaan waktu siang hari diaktifkan.

Untuk menghapus pengamanan VPN, tekan Hapus. 

Untuk menutup rincian pengamanan VPN, tekan 
Tutup.

Memperbarui pengamanan VPN
Jika Anda membuat sambungan ke jalur akses VPN, VPN 
client periksa status pengamanan VPN yang berhubungan 
dengan jalur akses VPN dari server pengamanan VPN. Jika 
administrator membuat versi baru pengamanan VPN, 
maka versi baru tersebut diinstal pada smartphone. Jika 
administrator menghapus pengamanan VPN dari server 

pengamanan VPN, maka pengamanan VPN juga akan 
terhapus dari smartphone. 
Perubahan akan berlaku ketika Anda kembali membuat 
sambungan ke jalur akses VPN, sehingga tidak akan 
mempengaruhi sambungan VPN yang sedang berlangsung.
Anda juga dapat memperbarui pengamanan VPN dalam 
Manajemen VPN.

Untuk memperbarui pengamanan VPN, pilih salah 
satu pengamanan VPN, lalu tekan Perbaharui. VPN 
client akan memeriksa status pengamanan VPN dari 
server pengamanan VPN.

Menghapus pengamanan VPN
Pengamanan VPN akan terhapus secara otomatis setelah 
administrator menghapusnya dari server pengamanan 
VPN saat Anda memperbarui pengamanan VPN atau 
melakukan sinkronisasi server pengamanan VPN. 
Jika Anda menghapus pengamanan VPN dalam 
Manajemen VPN yang masih terdapat pada server 
pengamanan VPN, maka pengamanan VPN tersebut akan 
diinstal kembali saat Anda melakukan sinkronisasi 
pengamanan VPN dari server pengamanan VPN.

Untuk menghapus pengamanan VPN, pilih 
pengamanan VPN, lalu tekan Hapus. 

Jalur akses VPN tidak dapat digunakan lagi jika Anda 
menghapus pengamanan VPN yang terkait.
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Menjalankan server 
pengamanan VPN
Dalam Server kebijakan, Anda dapat menginstal 
pengamanan VPN dari server pengamanan VPN. Saat Anda 
membuat sambungan ke jalur akses VPN, smartphone akan 
tersambung ke server pengamanan VPN untuk secara 
otomatis memperbarui pengamanan VPN yang 
berhubungan dengan jalur akses VPN tersebut. Untuk 
memperbarui semua pengamanan VPN, lakukan 
sinkronisasi server pengamanan VPN dengan smartphone.

Menyambung ke server pengamanan 
VPN
Saat Anda menginstal pengamanan VPN dari server 
pengamanan VPN, maka Anda membuat hubungan 
kepercayaan antara smartphone dengan server 
pengamanan VPN. Untuk membuat hubungan 
kepercayaan ini, Anda harus mengotentikasi server 
pengamanan VPN dan server pengamanan VPN harus 
mengotentikasi Anda. 
Setelah server pengamanan VPN mengotentikasi Anda, 
VPN client akan memberikan tombol pribadi dan 
mendaftarkan sertifikat untuk Anda. Tombol pribadi dan 
sertifikat disimpan dalam salah satu kode sandi pada 
smartphone. Sertifikat akan mengotentikasi Anda ke server 
pengamanan VPN. 

Tip: Administrator dapat mengirim kepada Anda file 
SIS yang berisi pengaturan untuk menentukan 
sambungan ke server pengamanan VPN atau Anda 
dapat menambahkan server pengamanan VPN dalam 
Manajemen VPN.

Menginstal pengaturan dari file SIS
Anda dapat menginstal pengaturan server pengamanan 
VPN pada server pengamanan VPN dari file SIS. Anda 
menginstal pengaturan pada smartphone dengan cara 
yang sama seperti ketika Anda menginstal perangkat 
lunak lainnya. 
Pengaturan tersebut berisi alamat dan sertifikat server 
untuk server pengamanan VPN. Sertifikat server akan 
membuat smartphone percaya terhadap server 
pengamanan VPN, sehingga Anda hanya perlu 
memasukkan nama dan sandi untuk membuktikan 
identitas Anda.
File SIS tidak berisi pengaturan jalur akses Internet untuk 
tersambung ke server pengamanan VPN. Untuk 
menetapkan jalur akses Internet, edit pengaturan server 
pengamanan VPN. Anda juga dapat memilih jalur akses 
Internet saat membuat sambungan ke server pengamanan 
VPN.
Jika administrator tidak mengesahkan file SIS, peringatan 
keamanan akan mucul saat Anda menginstal file SIS. Anda 
dapat mengabaikan peringatan tersebut jika yakin Anda 
telah menerima file SIS tersebut dari administrator.
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Anda harus keluar dari Manajemen VPN sebelum 
menginstal pengaturan dari file SIS atau jika penginstalan 
gagal.

Menambahkan server pengamanan 
VPN
Dalam Server kebijakan, Anda dapat menetapkan 
pengaturan server pengamanan VPN jika pengaturan 
tersebut tidak diinstal dari file SIS.

Saat Anda membuat sambungan ke alamat server 
pengamanan VPN untuk pertama kalinya, smartphone 
tidak akan mempercayai server pengamanan VPN, oleh 
karena itu Anda harus mengotentikasi server pengamanan 
VPN tersebut. Anda akan menerima kode identitas server 
pengamanan VPN dari administrator. Anda memeriksa dan 
melengkapi kode identitas server pengamanan VPN, 
kemudian VPN client akan memverifikasikannya.
Setelah otentikasi berhasil, VPN client akan mendaftarkan 
sertifikat dari server pengamanan VPN untuk otentikasi 
server pengamanan VPN selanjutnya.

Untuk menambahkan server pengamanan VPN, 
tekan Baru. Masukkan pengaturan berikut:

• Nama server: – Anda dapat memilih nama saja, namun 
harus unik dalam Server kebijakan. 

Jika Anda membiarkan kolom ini kosong, Alamat server: 
akan dimasukkan ke dalam kolom ini. 
Nama server pengamanan VPN akan muncul dalam 
daftar server pengamanan VPN.

• Alamat server: – nama host atau alamat IP server 
pengamanan VPN tempat penginstalan pengamanan 
VPN. Anda juga dapat memilih nomor port, dipisahkan 
dengan tanda titik dua (:).
Anda menerima alamat server pengamanan dari 
administrator.

• Jalur akses internet: – Jalur akses Internet yang 
digunakan untuk sambungan ke server pengamanan 
VPN ini. 
Administrator akan memberitahukan jalur akses yang 
dapat Anda pilih.
Untuk menginstal pengamanan VPN dari server 
pengamanan VPN, tekan Ya jika Manajemen VPN 
meminta Anda untuk melakukan sinkronisasi server 
pengamanan VPN.

Tip: Sinkronisasi berarti VPN client akan tersambung 
ke server pengamanan VPN untuk memeriksa 
pengamanan VPN yang baru, diperbarui, atau dihapus 
dan menginstal pengamanan VPN pada smartphone.

Saat Anda membuat sambungan ke alamat server 
pengamanan VPN untuk pertama kalinya, server 
pengamanan VPN tidak dipercaya, oleh karena itu Anda 
harus mengotentikasi server pengamanan VPN tersebut. 
Anda akan menerima kode identitas server pengamanan 
VPN dari administrator.
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Untuk memverifikasi identitas server pengamanan 
VPN, bandingkan dengan teliti kode identitas server 
pengamanan VPN dalam dialog Kode identitas server 
kebijakan VPN dengan kode yang diterima dari 
administrator, masukkan karakter yang hilang dalam 
Karakter yang hilang:, lalu tekan OK.

Catatan: Jika Anda menginstal pengaturan server 
pengamanan VPN dari file SIS, maka Anda tidak perlu 
lagi memverifikasi identitas server VPN dan tampilan 
ini tidak akan muncul.
Untuk mengotentikasi server pengamanan VPN, 
masukkan nama pengguna Anda ke dalam Nama 
pengguna: dan sandi ke dalam Sandi: kemudian tekan 
OK dalam dialog Autentikasi server kebijakan VPN.

Administrator akan memberitahukan nama pengguna dan 
sandi yang harus Anda masukkan.

Tip: Nama pengguna dan sandi server pengamanan 
akan membantu mengamankan server pengamanan 
VPN dari akses pihak yang tidak sah.

VPN client akan mendaftarkan sertifikat untuk otentikasi 
ke server pengamanan VPN berikutnya dan menginstal 
pengamanan VPN pada smartphone.

Tip: Mendaftar sertifikat artinya mengirim permintaan 
sertifikasi ke otoritas sertifikasi dan menerima 
sertifikat.

Anda kini dapat membuat jalur akses VPN dan 
menghubungkannya dengan aplikasi.

Mengedit server pengamanan VPN
Dalam Server kebijakan, Anda dapat melihat, mengedit, 
melakukan sinkronisasi dan menghapus server 
pengamanan VPN.

Untuk melihat atau mengubah pengaturan server 
pengamanan VPN,  pilih server pengamanan VPN 
kemudian tekan Edit untuk mengubah:

• Nama server: – nama untuk server pengamanan. Server 
kebijakan menunjukkan nama baru.

• Jalur akses internet: – Jalur akses Internet yang 
digunakan untuk membuat sambungan ke server 
pengamanan VPN ini. 

Jika Anda menghapus jalur akses yang berhubungan 
dengan server pengamanan VPN, Jalur akses internet: 
akan menampilkan teks Tidak terpilih. Jika Anda 
menghapus semua jalur akses, Manajemen VPN tidak 
dapat menyimpan pengaturan tersebut.

Anda tidak dapat mengubah Alamat server: setelah Anda 
menginstal pengamanan VPN dari server pengamanan 
VPN, karena server pengamanan VPN akan mengirim 
alamat ke manajemen VPN saat tersambung pertama 
kalinya.
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Untuk menghapus server pengamanan VPN, tekan 
Hapus. 

Untuk menyimpan pengaturan, tekan Selesai.

Tip: Untuk menutup tampilan tanpa menyimpan 
perubahan, tekan Esc .

Melakukan sinkronisasi server 
pengamanan VPN

Untuk menginstal dan memperbarui pengamanan 
dari server pengamanan VPN, pilih server 
pengamanan VPN lalu tekan Sinkronisasi. VPN client 
akan menghubungkan server pengamanan VPN untuk 
memeriksa apakah administrator telah menambah, 
memperbarui, atau menghapus pengamanan VPN. 

Jika server pengamanan VPN berisi pengamanan VPN yang 
baru atau pengamanan VPN versi baru, maka pengamanan 
VPN tersebut juga akan diinstal pada smartphone. Jika 
administrator menghapus pengamanan VPN dari server 
pengamanan VPN, maka pengamanan VPN tersebut juga 
akan terhapus dari smartphone. 

Catatan: Saat Anda melakukan sinkronisasi server 
pengamanan VPN untuk pertama kalinya, pencocokan 
jalur akses VPN dibuat untuk setiap pengamanan yang 
diinstal pada smartphone. Jalur akses VPN 
menggabungkan pengamanan VPN dengan jalur akses 

Internet. Jika Anda tersambung ke server pengamanan 
VPN untuk menginstal atau memperbarui 
pengamanan VPN, maka Anda harus mendaftarkan 
sertifikat VPN dari server pengamanan VPN.

Mendaftarkan sertifikat VPN
VPN client akan membuat permintaan sertifikasi untuk 
setiap sertifikat yang diperlukan dan mengirim 
permintaan tersebut ke server pengamanan VPN. Server 
pengamanan VPN akan mendaftar setiap sertifikat yang 
diminta dari otoritas sertifikasi kemudian 
mengembalikannya ke VPN client. 

Permintaan sertifikasi dan sertifikat terkait berisi identitas 
pengguna. Tergantung pada konfigurasi server 
pengamanan VPN, identitas pengguna server pengamanan 
VPN dapat digunakan sebagai identitas pengguna dalam 
sertifikat VPN. Jika ini tidak dimungkinkan, Manajemen 
VPN akan meminta identitas pengguna untuk domain 
tertentu dari Anda. Administrator akan memberitahukan 
informasi yang harus Anda masukkan.

Untuk membuat permohonan sertifikat, dalam 
dialog Identitas pengguna VPNmasukkan identitas 
pengguna sertifikat Anda untuk menentukan domain 
dalam Identitas pengguna: lalu tekan OK.
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Melihat log VPN
Log VPN berisi pesan log yang tercatat saat Anda 
memperbarui dan melakukan sinkronisasi pengamanan 
VPN serta menggunakan jalur akses VPN untuk membuat 
sambungan VPN ke gateway VPN. 
Dalam Log, Anda dapat melihat dan menghapus pesan log. 
Anda dapat melihat tulisan pesan, waktu pencatatan 
setiap pesan, dan awal pesan log. 

 menunjukkan error,  peringatan, dan 
 informasi.
Untuk melihat seluruh pesan log, tekan Buka.

Log menyusun pesan log berdasarkan urutan jam dan 
tanggal pencatatan, pesan terbaru akan ditampilkan lebih 
dulu. Anda dapat melihat pesan hingga waktu ketika Log 
dibuka. 

Untuk melihat pesan log terbaru, tekan Buka ulang.

Pesan log dapat berisi kode error, status, dan alasan. 
Sertakan kode kesalahan saat Anda melaporkan error 
kepada administrator.

Untuk menghapus semua pesan log dari log, tekan 
Hapus log.

Pesan log disimpan dalam memori penyangga sirkular. Jika 
ukuran log mencapai 20 kilobyte, pesan log baru akan 
tercatat di bagian atas pesan log yang paling lama.

Tombol perlindungan sandi
Dalam Sandi simpan tombol, Anda dapat membuat atau 
mengubah tombol perlindungan sandi. Tombol 
perlindungan sandi akan membantu mengamankan 
tombol pribadi dalam smartphone dan sambungan server 
pengamanan VPN dari penggunaan yang tidak sah. 

Membuat atau mengubah tombol 
perlindungan sandi
Tombol perlindungan sandi dibuat saat Anda menginstal 
pengamanan VPN untuk pertama kalinya. Buat tombol 
perlindungan sandi yang cukup panjang dan rumit untuk 
membantu mengamankan informasi yang tersimpan 
dalam smartphone. Jika tombol perlindungan sandi 
terpecahkan, jaringan perusahaan akan terbuka bagi akses 
yang tidak sah.

Tip: Tombol perlindungan sandi paling sedikit harus 
terdiri dari 6 karakter dan dapat berisi huruf, angka, 
dan karakter khusus.

Untuk mengubah tombol perlindungan sandi, tekan 
Tetapkan.

Masukkan sandi yang mudah Anda ingat namun sulit 
diterka oleh orang lain dalam Sandi baru:. Untuk 
menghindari kesalahan pengetikan, masukkan kembali 
sandi tersebut dalam Verifikasi sandi: lalu tekan OK.
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Memasukkan tombol perlindungan 
sandi
Anda harus memasukkan tombol perlindungan sandi pada 
saat:
• Menginstal baru atau memperbarui pengamanan VPN 

dari server pengamanan VPN.
• Menggunakan aplikasi untuk tersambung ke jalur akses 

VPN yang memerlukan otentikasi sertifikat. 

Menggunakan VPN dengan 
aplikasi
Bila Anda menggunakan aplikasi untuk membuat 
sambungan ke jalur akses VPN, smartphone akan:
• Menyambung ke jalur akses Internet yang 

berhubungan dengan jalur akses VPN.
• Mengambil pengamanan VPN yang berhubungan 

dengan jalur akses VPN.
• Menyambung ke gateway VPN untuk membuat 

sambungan VPN.

Otentikasi ke gateway VPN
Anda harus membuktikan identitas diri ketika mengakses 
VPN perusahaan. Pengamanan VPN akan menetapkan 
metode otentikasi yang Anda gunakan:

• Otentikasi berbasis sertifikat – Anda harus memiliki 
sertifikat yang disahkan oleh otoritas sertifikasi 
terpercaya. Anda dapat menggunakan pendaftaran 
sertifikat online untuk memperoleh sertifikat atau 
menginstal sertifikat saat Anda menginstal 
pengamanan VPN dari file SIS.

• Otentikasi keabsahan – Anda menggunakan nama 
pengguna dan sandi atau kode akses untuk otentikasi. 
Administrator akan membuat nama pengguna dan 
sandi tersebut atau memberikan token SecurID untuk 
membuat kode akses Anda.
Jika Anda menggunakan sertifikat untuk 
otentikasi, masukkan tombol perlindungan sandi.

Jika Anda menggunakan otentikasi keabsahan,  
masukkan informasi otentikasi VPN saat Anda 
menggunakan aplikasi untuk tersambung ke jalur 
akses VPN. Kemudian smartphone akan mengatur 
sambungan terenkripsi dengan gateway VPN.

Untuk menggunakan nama pengguna dan sandi 
dalam otentikasi ke gateway VPN, masukkan nama 
pengguna VPN Anda dalam Nama pengguna VPN: dan 
sandi VPN dalam Sandi VPN:. Tekan OK

Untuk menggunakan nama pengguna dan kode 
akses dalam otentikasi ke gateway VPN,masukkan 
nama pengguna VPN Anda dalam Nama pengguna VPN: 
Buat kode akses SecurID, lalu masukkan dalam Kode 
sandi VPN:. Tekan OK
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Jika SecurID token tidak tersinkronisasi dengan waktu jam 
ACE/Server, maka Anda akan diminta untuk kode akses 
berikutnya dengan yang digunakan ACE/Server sebagai 
referensi baru untuk dasar waktu token. Masukkan nama 
pengguna VPN Anda dalam Nama pengguna VPN:. Buat dan 
masukkan kode akses baru dalam Kode sandi berikutnya: lalu 
tekan OK. Jika tidak berhasil, hubungi administrator.

Mengatasi masalah
Bagian ini berisi daftar pesan error menurut abjad, 
menjelaskan kemungkinan penyebab error, dan 
memberikan saran tindakan untuk mengatasi error.
Otentikasi gagal. Periksa nama pengguna dan sandi.
• Anda memasukkan nama pengguna atau sandi yang 

salah ketika melakukan otentikasi ke server 
pengamanan VPN atau ketika mengakses VPN.

• Anda memasukkan kode akses yang salah ketika 
dimintai Kode akses berikutnya.

Coba atasi dengan cara berikut:
• Periksa nama pengguna dan sandi Anda, kemudian 

ulangi.
• Buat dan masukkan kode akses.
Gagal logon server kebijakan. Tulis nama pengguna server 
kebijakan dan sandinya.
Sertifikat otentikasi Anda ke server pengamanan VPN telah 
kadaluarsa atau administrator membatalkan sertifikat 
tersebut.

Laporkan error ini kepada administrator yang memberikan 
Anda sandi sekali pakai untuk mengakses. Masukkan nama 
pengguna dan sandi sekali untuk otentikasi ke server 
pengamanan VPN. VPN client akan mendaftarkan 
sertifikat baru untuk Anda.
Gagal logon server kebijakan. Lihat log VPN untuk rinciannya.
Masa berlaku sertifikat untuk otentikasi Anda ke server 
pengamanan VPN belum diaktifkan.
Periksa pengaturan tanggal dan waktu atau tunggu 
sampai masa berlaku sertifikat diaktifkan.
Gagal menggunakan klien VPN. Perpustakaan kriptografik 
terlalu lemah.
Jika cryptographic library yang diinstal pada smartphone 
terlalu lemah, Anda tidak dapat menggunakan sambungan 
VPN.
Hubungi administrator.
Sandi salah
Anda memasukkan tombol perlindungan sandi atau 
tombol impor sandi yang salah.
Periksa sandi tersebut, kemudian ulangi.
Anda menerima tombol impor sandi dari administrator. 
Anda membuat tombol perlindungan sandi sendiri.
Server kebijakan sedang digunakan. Gagal menghapus.
Anda tidak dapat menghapus server pengamanan VPN jika 
Anda memperbarui pengamanan VPN dari server. Jika 
Anda menggunakan aplikasi yang membuat sambungan 
ke jalur akses VPN, maka pengamanan VPN akan 
diperbarui secara otomatis.
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Tunggu sampai pengamanan VPN selesai diperbarui dan 
ulangi.
Gagal logon server kebijakan. Hapus server dan tetapkan ulang 
rincian.
Sertifikat server untuk server pengamanan VPN telah 
kadaluwarsa.

Untuk menghapus server pengamanan VPN, pilih 
server pengamanan VPN dalam Server kebijakan lalu 
tekan Hapus. 

Untuk menambahkan kembali server pengamanan 
VPN, tekan Baru, atau dapatkan file SIS yang berisi 
pengaturan baru untuk server pengamanan VPN dari 
administrator.

Gagal memperbaharui kebijakan. Lihat log VPN untuk 
rinciannya.
Gagal mensinkronisasi. Lihat log VPN untuk rinciannya.
Muncul error saat pengamanan VPN di-download dari 
server pengamanan VPN atau diinstal pada smartphone.

Untuk memperbarui pengamanan VPN, pilih 
pengamanan VPN dalam Kebijakan lalu tekan 
Perbaharui.

Untuk menginstal pengamanan dari server 
pengamanan VPN, pilih server pengamanan VPN 
dalam Server kebijakan lalu tekan Sinkronisasi.

Kode identitas server salah
Anda memasukkan string yang salah saat diminta 
memasukkan kode identitas server pengamanan VPN.
Periksa dengan cermat kode identitas server pengamanan 
VPN, bandingkan dengan yang Anda terima dari 
administrator kemudian masukkan kembali karakter yang 
hilang.
Gagal mengaktivasi hubungan VPN. Lihat log VPN untuk 
rinciannya.
Otentikasi keabsahan gagal atau sertifikat yang Anda 
gunakan untuk otentikasi ke gateway VPN terhapus, telah 
kadaluarsa atau belum diaktifkan.
Periksa pengaturan tanggal dan jam pada smartphone.

Untuk memperbarui pengamanan VPN, pilih 
pengamanan VPN dalam Kebijakanlalu tekan 
Perbaharui.

Kebijakan VPN dihapus. Coba menetapkan ulang jalur akses 
VPN.
Pengamanan VPN yang dulu dihubungkan dengan jalur 
akses VPN tersebut sudah kadaluarsa dan dihapus secara 
otomatis.
Untuk menghubungkan pengamanan VPN lainnya dengan 
jalur akses VPN, dalam Control Panel > Internet Setup, 
pilih kembali sambungan VPN kemudian hubungkan 
pengamanan yang berlaku untuknya.
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Manajer file 
Buka Meja > Manajer file.

Pada aplikasi manajer file Anda dapat memindahkan, 
menyalin, mengubah nama serta membuka file dan folder.

Perlindungan hak cipta mungkin membuat beberapa 
gambar, nada dering dan materi lainnya tidak dapat 
disalin, dimodifikasi, dipindahkan atau dialihkan.

Tip: Gunakan aplikasi manajer file beserta kartu 
memori untuk menghapus file dan folder dari memori 
internal sehingga dapat mengurangi memori yang 
terpakai. Lihat “Mengelola kartu kontak” pada 
halaman 149.

Gbr. 33: Manajer file

Untuk membuka file atau folder, tekan dua kali.

Untuk membuka kembali file yang terakhir dibuka, 
tekan  kemudian pilih File > File terakhir. Pilih file 
yang akan dibuka.

Untuk melihat rincian file atau folder, tekan  
lalu pilih Peralatan > Rincian. Jika Anda memilih Hanya 
dibaca: pada kotak pilihan, file tidak akan dapat diubah.

Mengelola file
Untuk menemukan file, tekan Cari. Masukkan nama 
atau bagian nama file yang akan Anda cari. Anda juga 
dapat mencari berdasarkan jenis file. Untuk pencarian 
yang lebih akurat, tekan Pilihan kemudian tentukan 
lokasi pencarian dan rentang waktu dari file yang 
dicari. Tekan Cari untuk memulai pencarian.

Untuk membuat file baru, tekan  kemudian pilih 
File > File baru.... Tentukan jenis file dan lokasi untuk 
menyimpan file baru tersebut.

Untuk mengubah urutan pengelompokan file, tekan 
 kemudian pilih Tampilan > Sortir.... Pilih kategori 

berdasarkan pengelompokan file yang dikehendaki, 
kemudian urutan pengelompokan.
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Mengelola folder
Untuk menutup folder dan berpindah ke atas dalam 
susunan folder, tekan Naik satu tingkat.

Untuk membuat folder baru, tekan  kemudian 
pilih File > Folder baru.... Beri nama untuk folder baru 
kemudian pilih lokasi.

Untuk mengubah nama file atau folder yang dipilih, 
tekan  kemudian pilih File > Ubah nama....

Mengelola kartu kontak
Untuk mengganti dari drive internal ke kartu 
memori, tekan  kemudian pilih Browse > Memori > 
Kartu memori.

Untuk mengubah nama kartu memori, tekan  
kemudian pilih Kartu memori > Ubah nama....

Untuk memformat kartu memori, tekan , lalu 
pilih Kartu memori > Format. Semua data dalam kartu 
memori akan terhapus secara permanen! Tekan 
Format untuk melanjutkan format. Memformat juga 
akan menghapus perlindungan sandi pada kartu.

Untuk membuat salinan informasi cadangan ke 
kartu memori, tekan , pilih Peralatan > 
Cadangkan/Kembalikan... kemudian tekan Cadangkan. 
Pilih, apakah Anda akan membuat salinan semua data 
atau hanya jenis file tertentu. Tekan OK untuk 
memulai penyalinan. Disarankan untuk menyalin data 
smartphone sebagai cadangan secara berkala.

Untuk mengembalikan informasi dari kartu memori, 
tekan , pilih Peralatan > Cadangkan/Kembalikan... 
kemudian tekan Kembalikan.

Untuk menetapkan sandi kartu memori, tekan , 
lalu pilih Peralatan > Tetapkan sandi..., kemudian 
masukkan sandi di kedua kolom. Untuk mengedit 
sandi, tekan , lalu pilih Peralatan > Edit sandi....

Untuk informasi lebih lanjut tentang kartu memori, lihat 
“Melepas dan memasang kartu memori” pada halaman 16.

Ingat, dengan menggunakan PC Suite Anda juga dapat 
membuat salinan data cadangan ke PC Anda. Untuk 
informasi lebih lanjut tentang pilihan membuat salinan 
data cadangan dengan bantuan Nokia PC Suite, lihat buku 
Petunjuk PC Suite dalam CD-ROM.
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Log
Buka Meja > Log.

Melalui aplikasi Log Anda dapat memonitor panggilan 
telepon, pesan, dan sambungan data yang terdaftar pada 
smartphone. Log dapat dipisahkan untuk menampilkan 
hanya satu jenis informasi dan kartu kontak dapat dibuat 
berdasarkan informasi log tersebut.

Untuk memilih jenis aktivitas yang Anda ingin 
tampilkan, tekan  kemudian pilih Lihat grup > 
Semua komunikasi / Panggilan suara / Pesan / Koneksi 
GPRS / Panggilan data. Ingat, aktivitas tertentu seperti 
pesan teks yang dikirim dalam beberapa bagian dan 
sambungan GPRS, akan dicatat sebagai satu aktivitas 
komunikasi.

Untuk menyusun urutan daftar aktivitas, tekan 
Sortir kemudian pilih urutan yang diinginkan untuk 
susunan dalam daftar.

Untuk melihat rincian aktivitas, pilih log aktivitas 
kemudian tekan Rincian. Misalnya, Anda dapat 
melihat nama pengirim atau penerima, nomor telepon, 
nama operator selular atau jalur akses. Untuk 
menyalin nomor telepon yang terdapat dalam log 
aktivitas, tekan Salin nomor.

Untuk menghapus seluruh isi log, tekan  
kemudian pilih Edit > Hapus log. Daftar panggilan 
terakhir juga akan turut terhapus. Untuk menghapus 
satu aktivitas tertentu pada log, pilih aktivitas, tekan 

 kemudian pilih Edit > Hapus rincian komunikasi.

Untuk menetapkan batas waktu log, tekan  
kemudian pilih Peralatan > Lamanya log.... Tekan  
dan  untuk menetapkan jumlah hari. Log aktivitas 
akan tetap tersimpan dalam memori smartphone 
selama beberapa hari sesuai pengaturan lamanya log, 
setelah itu log akan dihapus dari memori secara 
otomatis. Ingat, jika Anda menetapkan nol (0) sebagai 
nilai, maka penyimpanan log akan dinonaktifkan dan 
seluruh isi log, Daftar panggilan terakhir dan Laporan 
pengiriman pesan akan dihapus secara permanen. 
Ingat juga, jumlah maksimum untuk log aktivitas yang 
terdaftar adalah 300, jika lebih dari itu akan dihapus, 
dimulai dari log aktivitas yang paling lama.

Untuk memanggil nomor telepon yang terdapat 
dalam log, pilih log aktivitas kemudian tekan Panggil. 
Untuk mengirim pesan ke nomor tersebut, tekan 

 kemudian pilih Pilihan > Buat pesan teks....

Untuk menambahkan nomor telepon ke daftar 
kontak, tekan  kemudian pilih Pilihan > Tambah ke 
Kontak....
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Panggilan terakhir
Pada dialog Panggilan terakhir Anda dapat melihat 
panggilan keluar, panggilan masuk dan panggilan tidak 
terjawab. Anda juga dapat memilih nomor telepon dan 
memanggil nomor tersebut atau menambahkannya ke 
dalam Kontak.

Untuk memeriksa nomor telepon yang dihubungi, 
diterima, dan panggilan tidak terjawab, tekan  
kemudian pilih Pilihan > Panggilan terakhir. smartphone 
akan mencatat panggilan tidak terjawab atau 
panggilan yang diterima hanya jika fungsi ini didukung 
oleh jaringan, dan smartphone diaktifkan serta berada 
dalam jangkauan layanan jaringan.

Untuk menghapus daftar panggilan terakhir, tekan 
 pada tampilan utama Log lalu pilih Edit > Hapus 

log. Seluruh isi daftar panggilan terakhir dan log 
aktivitas akan dihapus.

Lamanya panggilan dan 
penghitung data GPRS

Untuk memonitor lamanya panggilan, tekan  
kemudian pilih Peralatan > Lamanya panggilan. Pada 
daftar ditampilkan perkiraan lama panggilan keluar 
dan panggilan masuk. Untuk menghapus penghitung 
waktu lamanya panggilan, tekan Hapus penghitung 
waktu. Untuk itu, Anda harus memasukkan kode 
kunci.

Catatan: Tagihan sebenarnya dari operator selular 
Anda untuk biaya panggilan akan berbeda-beda, 
tergantung dari fasilitas jaringan, pembulatan tagihan 
dan sebagainya.

Untuk melihat penghitung data GPRS, tekan  
kemudian pilih Peralatan > Penghitung data GPRS. Pada 
daftar ditampilkan jumlah data yang dikirim dan 
diterima selama sambungan data paket (GPRS) 
berlangsung. Misalnya, Anda mungkin akan dikenakan 
biaya untuk sambungan GPRS sesuai dengan jumlah 
data yang dikirim dan diterima. Untuk menghapus 
penghitung data GPRS, tekan Hapus penghitung. 
Untuk itu, Anda harus memasukkan kode kunci.
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Konverter
Anda dapat menggunakan Konverter untuk mengkonversi 
unit pengukuran dan mata uang.

Catatan:  Konverter ini memiliki keterbatasan akurasi 
dan kesalahan pembulatan mungkin terjadi.

Untuk mengkonversi unit, pilih jenis unit dalam 
kolom kiri, pilih unit yang akan dikonversi dalam 
bidang bagian atas pada kolom kanan, kemudian unit 
yang akan dikonversi dalam bidang bagian bawah. 
Masukkan nilai yang akan dikonversi dalam bidang 
Jumlah: di bagian atas. Tekan kolom kanan untuk 
mengatur kembali tampilan, jika perlu.

Mengkonversi mata uang
Untuk menetapkan mata uang dasar, tekan , lalu 
pilih Atur mata uang dasar. Pilih mata uang standar dari 
daftar.

Untuk menetapkan nilai tukar uang sebelum 
mengkonversi, tekan , lalu pilih Edit mata uang.... 
Pilih mata uang yang akan diedit, tekan Edit, kemudian 
masukkan nilai tukar uang saat itu.

Untuk menambahkan mata uang baru, tekan , 
lalu pilih Edit mata uang.... Tekan Baru, kemudian 
masukkan informasi yang diperlukan.

Untuk menghapus salah satu mata uang, tekan , 
lalu pilih Edit mata uang.... Pilih mata uang, kemudian 
tekan Hapus. Tekan kembali Hapus untuk konfirmasi.
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Pesan area
Buka Meja > Pesan area.

Di area jangkauan Layanan Pesan Area (Cell Broadcast 
Service: CBS), Anda dapat menerima pesan tentang 
berbagai topik dari operator selular, seperti laporan cuaca 
atau kondisi lalu lintas. Untuk ketersediaan dan jumlah 
topik terkait, hubungi operator selular Anda.

Pesan area adalah layanan jaringan. Untuk ketersediaan 
CBS, hubungi operator selular Anda.

Ingat, sambungan data paket (GPRS) mungkin dapat 
mengganggu penerimaan pesan info. Hubungi operator 
jaringan Anda untuk memperoleh pengaturan GPRS yang 
benar.

Membaca dan mengelola pesan
Untuk membaca pesan, tekan Baca.

Untuk menyimpan pesan yang sedang Anda baca, 
tekan  lalu pilih Edit > Simpan pesan.

Untuk menghapus pesan yang sedang Anda baca, 
tekan  lalu pilih Edit > Hapus pesan.

Untuk mengunci pesan yang sedang Anda baca, tekan 
 lalu pilih Edit > Kunci pesan. Anda dapat mengunci 

pesan untuk memastikan bahwa pesan tersebut tidak 

akan terhapus, jika pesan baru dengan topik yang sama 
diterima.

Untuk membuka pesan berikut atau sebelumnya, 
tekan Berikutnya atau Sebelumnya.

Untuk memulai atau menghentikan penerimaan 
pesan CBS, tekan Penerimaan aktif atau Penerimaan 
tidak aktif.

Mengelola topik
Tip: Anda dapat mencari berbagai topik. Masukkan 
nama topik dalam kolom cari.

Untuk menerima pemberitahuan tentang topik baru 
tertentu, tekan  lalu pilih Topik > Topik menarik. 
Topik menarik ditampilkan dengan tanda seru “!”.

Untuk mengedit atau menghapus topik bila 
penerimaan tidak aktif, tekan  lalu pilih Topik > 
Pilihan tambahan > Edit topik... atau Hapus topik. Ingat, 
Anda tidak dapat mengedit topik dalam tampilan 
Semua daftar.

Untuk mendaftar, gulir ke salah topik, lalu tekan 
Daftar. Tanda centang muncul di layar dalam kotak di 
sebelah kiri topik. Untuk keluar, tekan Keluar.
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Untuk membuat daftar topik baru, tekan , lalu 
pilih Daftar > Atur daftar.... Tekan Baru, lalu masukkan 
nama untuk daftar baru tersebut.

Untuk mengubah nama daftar topik, tekan , lalu 
pilih Daftar > Atur daftar.... Pilih daftar yang namanya 
akan Anda ubah, lalu tekan Ubah nama. Ingat, 
penerimaan harus dinonaktifkan.

Untuk membuka daftar topik yang berbeda, tekan 
, pilih Daftar lalu pilih daftar topik yang akan 

dibuka.

Pada daftar topik yang berbeda, Anda masih dapat 
mendaftar dan keluar dari topik serta mengaturnya 
sebagai topik menarik.

Pengaturan pesan area
Untuk mengubah pengaturan, tekan , lalu pilih 
Peralatan > Pengaturan.... Tetapkan berikut ini:

Tambah topik baru ke daftar: – Jika Anda memilih pilihan ini, 
semua topik baru akan ditambahkan secara otomatis ke 
daftar topik Anda saat ini. Jika pilihan ini tidak dipilih, 
Anda hanya akan menerima pesan tentang topik terdaftar 
atau topik menarik yang sudah ada dalam daftar topik 
Anda.

Bahasa: – Pilih bahasa untuk topik yang akan Anda terima. 
Pilih Semua untuk menerima pesan topik dalam semua 
bahasa.

Tip: Buat daftar topik kosong yang baru, pilih Tambah 
topik baru ke daftar: pilihan dan semua bahasa dalam 
pengaturan di atas untuk menerima daftar topik 
lengkap yang tersedia di area tersebut.

Penerima aktif: – Memilih ini memungkinkan penerimaan 
otomatis.

Waktu 'penerima aktif': – Tekan  untuk menetapkan 
waktu saat penerimaan otomatis dimulai.

Waktu 'penerima tidak aktif': – Tekan  untuk menetapkan 
waktu saat penerimaan otomatis berakhir.

Interval penghapusan pesan (jam): – Menetapkan seberapa 
sering semua pesan yang sudah dibaca akan dihapus.
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Sambungan
Sambungan Bluetooth
Buka Meja > Panel kontrol > Bluetooth.

Smartphone ini sudah memenuhi persyaratan untuk 
Bluetooth Specification 1.1 dan mendukung berbagai 
profil berikut: Dial-Up Networking Profile, Object Push 
Profile, File Transfer Profile, dan Handsfree Profile. Untuk 
memastikan antar-operasional antara perangkat lain yang 
mendukung teknologi Bluetooth, gunakan perangkat 
tambahan yang telah disetujui oleh Nokia untuk model ini. 
Tanyakan produsen perangkat lain tersebut untuk 
memastikan kompatibilitasnya dengan perangkat ini.

Teknologi Bluetooth memungkinkan sambungan nirkabel 
untuk pengiriman gambar, teks, kartu nama, catatan 
kalender, atau untuk terhubung tanpa kabel ke perangkat 
yang kompatibel dengan teknologi nirkabel Bluetooth, 
misalnya, komputer.

Perangkat Bluetooth berkomunikasi melalui gelombang 
radio, karena itu smartphone dan perangkat lainnya tidak 
perlu berhadapan langsung. Kedua perangkat hanya perlu 
berada maksimal dalam jangkauan 10 meter dari posisinya 
masing-masing, namun sambungan ini dapat terganggu 
misalnya oleh dinding atau perangkat elektronik lainnya.

Di beberapa tempat, terdapat pembatasan untuk 
penggunaan teknologi Bluetooth. Tanyakan hal ini kepada 

pejabat yang berwenang di tempat Anda atau operator 
selular.

Fitur yang menggunakan teknologi Bluetooth, atau 
menjalankan fitur-fitur demikian di latar belakang saat 
fitur lain sedang digunakan, akan meningkatkan 
kebutuhan daya baterai dan mengurangi masa pakai 
baterai.

Mengaktifkan aplikasi Bluetooth untuk 
pertama kali
1 Buka aplikasi Panel kontrol, kemudian pilih Bluetooth.
2 Beri nama Bluetooth untuk smartphone Anda. Tulis 

nama (maks. 82 karakter) atau gunakan nama standar. 
Jika data dikirim melalui Bluetooth sebelum Anda 
memberikan nama Bluetooth pada smartphone Anda, 
maka nama standar akan digunakan.

3 Pilih Aktifkan Bluetooth: centang kotak pilihan untuk 
mengaktifkan Bluetooth. Jika Anda mengosongkan 
kotak pilihan, maka semua sambungan Bluetooth yang 
aktif akan diakhiri dan Bluetooth tidak dapat 
digunakan untuk mengirim atau menerima data.
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4 Pilih kotak pilihan Terlihat untuk semua: agar 
smartphone dan nama yang Anda berikan pada 
perangkat tersebut dapat dilihat oleh pengguna 
perangkat Bluetooth lain. Jika Anda mengosongkan 
kotak pilihan, smartphone Anda tidak akan dapat 
ditemukan oleh perangkat lain selama pencarian 
perangkat.

5 Tekan OK untuk menyimpan pengaturan dan menutup 
dialog.
Untuk menonaktifkan aplikasi Bluetooth, tekan  
pada kolom indikator status kemudian pilih 
Nonaktifkan. Bluetooth tidak dapat digunakan untuk 
mengirim atau menerima data sampai Anda memilih 
kotak pilihan Aktifkan Bluetooth: sekali lagi. Ingat, 
biasanya sambungan Bluetooth akan terputus secara 
otomatis setelah pengiriman atau penerimaan data. 
Kecuali beberapa aksesori seperti headset, sambungan 
akan tetap berlangsung meskipun tidak digunakan 
secara aktif.

Mengirim data melalui Bluetooth
Anda hanya dapat mengirim data ke satu perangkat pada 
satu waktu.
1 Buka aplikasi penyimpan objek yang akan Anda kirim. 

Misalnya, untuk mengirim foto ke perangkat lain, buka 
aplikasi Gambar.

2 Pilih objek yang akan Anda kirim, kemudian tekan 
Kirim, atau tekan  lalu cari perintah Kirim > Via 
Bluetooth.

3 Jika sebelumnya Anda sudah melakukan pencarian 
perangkat Bluetooth, daftar perangkat yang telah 
ditemukan tersebut akan muncul pertama kali. Anda 
akan melihat sebuah ikon perangkat dan nama 
Bluetooth perangkat tersebut.

4 Untuk memulai pencarian baru, tekan Cari baru.
5 Pilih perangkat yang ingin Anda hubungkan, kemudian 

tekan Kirim.
6 Jika perangkat lain memerlukan pembuatan pasangan 

sebelum data dapat dikirim, Anda akan diminta untuk 
memasukkan kode akses. Buat kode sandi Anda sendiri 
(panjang 1-16 karakter, dalam angka) dan Anda harus 
sepakat dengan pemilik perangkat Bluetooth lainnya 
untuk menggunakan kode yang sama. Kode sandi ini 
hanya digunakan sekali dan tidak perlu disimpan. 
Perangkat yang tidak memiliki interface pengguna 
memiliki kode sandi awal. Bila sambungan sudah 
berhasil dibuat, akan muncul pesan Mengirim.

Data yang diterima melalui Bluetooth dapat dilihat dalam 
folder Kotak masuk pada aplikasi Pesan. Untuk informasi 
lebih lanjut, lihat “Folder” pada halaman 52.

Ingat, jika pengiriman gagal, maka pesan atau data akan 
dihapus. Folder Konsep pada aplikasi Pesan tidak 
menyimpan pesan yang dikirim melalui Bluetooth.
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Menerima data melalui Bluetooth
Agar dapat menerima data melalui Bluetooth, pastikan 
Anda telah mengatur Bluetooth sebagai aktif dan memilih 
kotak pilihan Terlihat untuk semua: pada dialog Bluetooth.

Bila Anda menerima data melalui Bluetooth dari perangkat 
yang tidak terotorisasi, Anda akan diminta 
mengkonfirmasikan penerimaan pesan Bluetooth. Jika 
Anda menerimanya, objek akan dimasukkan dalam folder 
Kotak masuk pada aplikasi Pesan.

Perangkat pasangan
Membuat pasangan berarti melakukan otentikasi. 
Pembuatan pasangan dengan perangkat lain akan 
memudahkan dan mempercepat pencarian perangkat.

Pengguna perangkat yang mengaktifkan Bluetooth harus 
menyetujui bersama kode sandi dan menggunakan kode 
sandi yang sama untuk kedua perangkat agar dapat 
menjadi pasangan.

Membuat pasangan perangkat
1 Buka aplikasi Panel kontrol, kemudian pilih Bluetooth. 

Anda juga dapat membuat pasangan perangkat 
sebelum mengirim data.

2 Tekan Perangkat berpasangan. Perangkat 
berpasangan dapat dilihat dalam daftar. 

3 Tekan Cari untuk membuka dialog Cari perangkat. Jika 
sebelumnya Anda sudah melakukan pencarian 
perangkat Bluetooth, daftar perangkat yang telah 
ditemukan tersebut akan muncul pertama kali.

4 Tekan Mulai untuk memperbarui daftar perangkat 
yang ditemukan, bila perlu, pilih perangkat yang akan 
dipasangkan, kemudian tekan Berpasangan.

5 Masukkan kode akses, kemudian tekan OK.
Untuk menetapkan nama pendek pada perangkat 
berpasangan, buka aplikasi Panel kontrol, pilih 
Bluetooth, lalu tekan Perangkat berpasangan. Pilih 
perangkat yang namanya akan Anda ubah, lalu tekan 
Edit. Anda dapat memberikan nama pendek (sebutan, 
alias) untuk membantu mengenali perangkat tertentu. 
Nama ini akan disimpan dalam memori perangkat dan 
tidak dapat dilihat oleh pengguna perangkat 
Bluetooth lainnya.

Tip: Pilih nama yang mudah diingat dan dikenali. 
Nantinya bila Anda mencari perangkat atau perangkat 
meminta sambungan, nama yang Anda pilih tersebut 
akan digunakan untuk mengidentifikasi perangkat.

Untuk membatalkan pasangan, buka aplikasi Panel 
kontrol, pilih Bluetooth, lalu tekan Perangkat 
berpasangan. Pilih perangkat yang pasangannya akan 
Anda batalkan, lalu tekan Hapus. Jika Anda sedang 
tersambung ke perangkat dan menghapus pasangan 
dengan perangkat tersebut, maka pasangan akan 
segera dihapus dan sambungan akan terputus.
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Untuk memberikan otorisasi perangkat 
berpasangan, buka aplikasi Panel kontrol, pilih 
Bluetooth, lalu tekan Perangkat berpasangan. Pilih 
perangkat berpasangan yang akan Anda otorisasikan, 
lalu tekan Edit. Hapus Konfirmasi permintaan koneksi:. 
Sambungan antara smartphone Anda dengan 
perangkat lain dapat dibuat tanpa sepengetahuan 
Anda. Tidak perlu ada konfirmasi atau otorisasi khusus. 
Gunakan status ini untuk perangkat Anda sendiri, 
misalnya PC atau perangkat milik orang yang Anda 
percaya. Ikon  muncul di sebelah perangkat yang 
diotorisasi dalam daftar perangkat yang dipasangkan. 
Untuk mengatur perangkat berpasangan agar tidak 
diotorisasi, pilih kotak pilihan Konfirmasi permintaan 
koneksi:. Permintaan sambungan dari perangkat ini 
setiap kali harus dikonfirmasi secara terpisah.

Menghubungkan smartphone 
Anda ke komputer yang 
kompatibel
Anda dapat menghubungkan smartphone Anda ke PC yang 
kompatibel melalui kabel sambungan DKU-2. Untuk 
informasi lebih lanjut tentang membuat sambungan ke 
komputer yang kompatibel melalui Bluetooth, dan cara 
menginstal Nokia PC Suite, lihat buku petunjuk PC Suite 
pada CD-ROM. Untuk informasi lebih lanjut tentang 
penggunaan Nokia PC Suite, lihat bantuan online untuk PC 
suite.

Akhiri panggilan telepon, tutup dokumen, dan hentikan 
semua proses lainnya yang masih aktif pada smartphone 
sebelum menghubungkan smartphone ke PC dengan 
menggunakan kabel sambungan.

Menggunakan CD-ROM
CD-ROM dalam kemasan penjualan ini kompatibel dengan 
Windows 2000/XP. Aplikasi CD-ROM harus ditampilkan 
secara otomatis setelah dimasukkan ke dalam drive 
CD-ROM pada PC kompatibel Anda. Jika tidak, ikuti 
langkah-langkah berikut ini:
1 Klik tombol Start pada Windows, lalu pilih Programs > 

Accessories > Windows Explorer.
2 Pada drive CD-ROM, cari file yang disebut 

Nokia7710.exe kemudian klik dua kali. Interface 
CD-ROM ditampilkan.

3 Anda dapat menemukan PC Suite di bagian “Install 
Software” CD-ROM. Klik dua kali ‘Nokia PC Suite’. 
Wizard instalasi akan menuntun Anda selama proses 
penginstalan.

Menggunakan smartphone Anda 
sebagai modem
Ingat, Anda tidak dapat membuat panggilan telepon 
selama smartphone digunakan sebagai modem.
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Untuk informasi tentang menghubungkan smartphone 
Anda ke PC kompatibel, lihat dokumentasi yang menyertai 
Nokia PC Suite. Untuk informasi tentang menggunakan 
aplikasi komunikasi data, lihat dokumentasi yang 
menyertainya.

Nokia PC Suite
Perangkat lunak Nokia PC Suite tersedia dalam CD-ROM 
yang menyertai smartphone Anda. Misalnya, dengan 
perangkat lunak PC Suite Anda dapat melakukan 
sinkronisasi isi daftar telepon dan catatan kalender antara 
smartphone dengan PC, membuat salinan data cadangan 
ke PC, serta menyusun foto yang diambil dengan 
menggunakan kamera perangkat.

Untuk informasi lebih lanjut tentang aplikasi yang tersedia 
dengan Nokia PC Suite, lihat buku petunjuk PC Suite pada 
CD-ROM dan bantuan online untuk masing-masing 
aplikasi.

Untuk menggunakan Nokia PC Suite, Anda harus 
menginstalnya pada PC yang kompatibel kemudian 
menghubungkan smartphone ke PC melalui sambungan 
Bluetooth atau menggunakan kabel USB DKU-2.

Menyalin data dari perangkat yang 
kompatibel
Anda dapat menyalin informasi dari berbagai telepon 
Nokia yang berbeda atau dari PC yang kompatibel ke 
smartphone Anda dengan menggunakan PC Suite. 

Selengkapnya, silakan lihat Buku Petunjuk PC Suite pada 
CD-ROM kemasan penjualan. CD-ROM dalam kemasan 
penjualan ini kompatibel dengan Windows 2000/XP.

Persyaratan sistem untuk Nokia PC 
Suite
• PC dengan sistem pengoperasian Windows 2000 atau 

Windows XP
• Sekurangnya 250 MB ruang disk kosong dan ruang 

tambahan untuk musik
• Port USB untuk sambungan kabel atau peralatan dan 

perangkat lunak teknologi nirkabel Bluetooth untuk 
sambungan Bluetooth nirkabel 

• Bluetooth wireless technology equipment should come 
with one of the following Bluetooth stacks:Peralatan 
teknologi nirkabel Bluetooth harus dilengkapi salah 
satu stack Bluetooth berikut: Microsoft Windows XP 
Bluetooth (terdapat dalam XP SP2), WIDCOMM BTW 
1.4 dan BTW 3.0, Toshiba Bluetooth Stack untuk 
Windows XP/2000, VT BlueSoleil Bluetooth Stack 
untuk Windows XP/2000. Untuk mengetahui fitur 
Bluetooth yang terinstal dalam PC Anda: dalam menu 
Start Windows, klik Control Panel > System > Hardware 
> Device Manager, atau dalam jendela utama Nokia PC, 
klik Help > About > System Information.
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• Untuk menginstal driver kabel DKU-2, Anda 
memerlukan Windows 2000 dengan Service Pack 3 
atau yang terbaru, atau Windows XP dengan Service 
Pack 1 atau yang terbaru.

Menginstal Nokia PC Suite
Instal Nokia PC Suite dari CD-ROM, atau dari halaman 
Web Nokia PC Suite di www.nokia-asia.com/pcsuite.

Untuk membuat sambungan antara smartphone dan PC, 
Anda juga memerlukan driver pada PC. Driver untuk 
sambungan DKU-2 USB dan sambungan Bluetooth akan 
terinstal secara otomatis bila Anda menginstal PC Suite 
atau bila smartphone dihubungkan ke PC melalui wizard 
Get Connected.

Persiapan menginstal
Jika versi Nokia PC Suite terdahulu (5.x atau 6.x) terinstal 
pada PC Anda, maka versi tersebut akan digantikan secara 
otomatis saat penginstalan berlangsung. Jika Anda harus 
menghapus penginstalan versi lama secara manual, maka 
program penginstalan akan meminta Anda untuk 
melakukannya.

Jika sambungan Bluetooth akan digunakan, Anda harus 
menginstal perangkat lunak teknologi nirkabel Bluetooth 
pada PC Anda. Untuk informasi lebih lanjut tentang 
perangkat lunak Bluetooth yang dapat digunakan dengan 
Nokia PC Suite, lihat “Persyaratan sistem untuk Nokia PC 
Suite” pada halaman 159.

Jika Anda melakukan peningkatan kemampuan (misalnya, 
dari PC Suite 6.41 atau yang terbaru menjadi PC Suite 6.6), 
sinkronisasikan smartphone Anda dengan PC Suite yang 
ada sebelum peningkatan kemampuan tersebut dilakukan, 
untuk menghindari penggandaan janji pada kalender. Bila 
Anda telah menginstal PC Suite 6.6, jalankan kembali 
sinkronisasi.

Menginstal PC Suite 6.6 dari CD-ROM
1 Masukkan CD-ROM ke dalam drive CD-ROM PC Anda, 

kemudian klik pilihan penginstalan untuk mulai 
menginstal Nokia PC Suite 6.6.

2 Pilih bahasa, kemudian klik OK. Program penginstalan 
akan dimulai.

3 Ikuti petunjuk di layar. Anda harus membaca dan 
menerima perjanjian lisensi sebelum melanjutkan.
Jika versi Nokia PC Suite terdahulu terinstal pada PC 
Anda, maka Anda akan diberitahu bahwa penginstalan 
versi tersebut akan dihapus. Anda mungkin akan 
diminta untuk mengaktifkan ulang komputer saat 
penginstalan berlangsung.

4 Bila penginstalan selesai, wizard Get Connected akan 
ditampilkan secara otomatis, lalu Anda dapat memilih 
jenis sambungan yang akan digunakan.
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Menginstal PC Suite 6.6 dari Web
1 Buka browser Web, kemudian kunjungi 

www.nokia.com/pcsuite > Download. Bantuan 
Download akan ditampilkan.

2 Pilih Nokia 7710 dari daftar, kemudian klik Lanjut. Jika 
terdapat dua versi untuk smartphone ini, Anda akan 
diminta untuk memilih sistem operasional PC Anda.

3 Pilih bahasa untuk mendownload dalam daftar 
drop-down, kemudia klik Download. 

4 Simpan file tersebut dalam PC Anda. Klik Lanjut, 
kemudian ikuti petunjuk di layar terakhir Download 
Assistant (Bantuan Download).

5 Telusuri file Nokia_PC_Suite_66_xx.exe yang 
didownload (xx berarti bahasa), kemudian klik. Program 
penginstalan akan dimulai.

6 Ikuti petunjuk di layar. Anda harus membaca dan 
menerima perjanjian lisensi sebelum melanjutkan.Jika 
versi lama Nokia PC Suite terinstal dalam PC Anda, 
maka Anda akan diberitahu bahwa penginstalan versi 
tersebut akan dihapus. Anda mungkin akan diminta 
untuk mengaktifkan ulang komputer saat penginstalan 
berlangsung.

7 Bila penginstalan selesai, wizard Get Connected akan 
ditampilkan secara otomatis, lalu Anda dapat 
mengkonfigurasi jenis sambungan yang akan 
digunakan.

Menghubungkan smartphone Anda 
dengan PC
Memilih jenis sambungan
Bila Anda telah menginstal Nokia PC Suite, maka wizard 
Get Connected akan ditampilkan secara otomatis dan 
memandu Anda dalam mengkonfigurasi jenis sambungan 
yang akan digunakan.

Anda dapat menghubungkan smartphone ini dengan kabel 
USB atau teknologi nirkabel Bluetooth.

Rincian jenis sambungan
Kabel DKU-2 USB merupakan cara transfer data yang 
cepat dan dapat diandalkan antara smartphone dan PC.

Teknologi nirkabel Bluetooth akan menghubungkan 
smartphone ini secara nirkabel dengan PC Anda dalam 
waktu singkat. Smartphone dan PC harus dalam 
jangkauan 10 meter.

Jika smartphone tidak disertai kabel, maka Anda dapat 
membeli kabel tersebut dari agen Nokia terdekat.

Status sambungan
Anda dapat melihat status sambungan di bagian bawah 
jendela utama Nokia PC Suite.

Jika sambungan smartphone terputus, Anda dapat 
menghubungkannya kembali ke PC melalui Get Connected. 
Buka Get Connected dari bagian bawah jendela utama PC 
Suite. 
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Menghubungkan smartphone Anda dengan PC 
melalui kabel
1 Dalam Get Connected, pilih Cable connection sebagai 

jenis sambungan.
2 Sambungkan kabel ke PC bila Get Connected meminta 

Anda untuk melakukannya, kemudian sambungkan 
bagian ujung kabel lainnya ke smartphone.

3 Saat pertama kali sambungan kabel digunakan, Anda 
harus menunggu hingga Get Connected selesai 
menginstal driver yang diminta.

Menghubungkan smartphone ini ke PC 
menggunakan Bluetooth
1 Buat smartphone Anda dikenali oleh perangkat 

Bluetooth lain, kemudian aktifkan sambungan 
Bluetooth pada smartphone ini. Untuk petunjuk, lihat 
buku petunjuk smartphone Anda.

2 Bila Bluetooth diaktifkan untuk pertama kalinya, Anda 
akan diminta untuk memberikan nama smartphone ini. 
Nama tersebut akan digunakan setiap kali Anda 
membuat pasangan smartphone ini dengan PC.

3 Jika Anda menggunakan adaptor Bluetooth, pastikan 
adaptor tersebut terpasang ke PC.

4 Dalam Get Connected, pilih Bluetooth stack yang akan 
digunakan dari daftar yang didukung oleh stack 
Bluetooth.

5 Dalam Get Connected, ikuti petunjuk untuk membuat 
pasangan smartphone Anda dengan PC.

Membuat pasangan perangkat untuk 
sambungan Bluetooth
Untuk menggunakan Bluetooth sebagai jenis sambungan, 
Anda harus membuat pasangan smartphone ini dengan 
PC. Membuat pasangan berarti menghubungkan dua 
perangkat agar keduanya dapat saling berkomunikasi. 
Anda hanya perlu membuat pasangan tersebut sekali, 
sebelum sambungan digunakan untuk pertama kalinya. 
Ikuti petunjuk dalam Get Connected.

Bila Anda diminta untuk memasukkan kode akses, 
masukkan kode akses tersebut yang diperoleh dari Get 
Connected. Atau, masukkan kode akses pilihan Anda (1-16 
karakter, angka) pada PC, kemudian masukkan kembali 
pada smartphone ini. Kode akses ini hanya digunakan 
sekali dan tidak perlu disimpan.

Anda harus mengotorisasi sambungan antara smartphone 
Nokia dengan PC Anda. Pilih Ya bila permintaan 
sambungan ditampilkan di layar smartphone ini.

Anda dapat menetapkan PC sebagai disepakati, agar 
setiap sambungan antara smartphone ini dengan PC tidak 
memerlukan otorisasi tersendiri. Buka tampilan Perangkat 
berpasangan pada smartphone ini, pilih PC Anda, kemudian 
edit PC yang akan disepakati atau dipercaya, tergantung 
pada persyaratan yang digunakan smartphone Anda. 
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Konfigurasi remote (layanan 
jaringan)
Buka Meja > Man. Perangkat.

Aplikasi Manajer perangkat memudahkan Anda dalam 
mengkonfigurasi pengaturan sambungan smartphone 
Anda, misalnya, e-mail, pesan multimedia atau 
pengaturan Internet. Sambungan konfigurasi remote 
biasanya dimulai oleh server saat pengaturan perangkat 
ini harus diperbarui.

Konfigurasi remote dilakukan melalui panggilan data GSM 
atau sambungan GPRS.

Aplikasi konfigurasi remote menggunakan teknologi 
SyncML Device Management versi 1.1.1. Untuk informasi 
tentang kompatibilitas Konfigurasi Remote, silakan 
hubungi penyedia solusi konfigurasi yang akan Anda 
gunakan untuk pengelolaan pengaturan smartphone Anda.

Untuk memulai sesi konfigurasi, buka aplikasi 
Manajer perangkat. Pilih profil dari daftar, tekan  
lalu pilih Konfigurasi > Mulai.

Untuk melihat log konfigurasi, tekan Log setelah sesi 
konfigurasi selesai. File log akan memperlihatkan 
status konfigurasi dari profil yang dipilih.

Untuk menonaktifkan konfigurasi, tekan  lalu 
pilih Konfigurasi > Nonaktifkan semua. Anda tidak dapat 
menerima pengaturan konfigurasi dari sembarang 
server konfigurasi yang memiliki profil Anda. Hapus 

perintah ini untuk mengizinkan penerimaan 
pengaturan konfigurasi dari server yang menyimpan 
profil Anda dan memiliki konfigurasi yang diizinkan.

Membuat profil server konfigurasi 
yang baru
Profil server konfigurasi adalah pengaturan untuk server 
remote. Anda dapat membuat beberapa profil untuk 
keperluan mengakses berbagai server.

Anda mungkin menerima pengaturan profil server 
konfigurasi sebagai pesan khusus dari operator selular.
1 Buka aplikasi Manajer perangkat, kemudian tekan . 

Pilih Profil > Baru.... Pilih apakah Anda akan menyalin 
nilai dari profil yang ada untuk digunakan sebagai 
basis profil baru.

2 Wizard Profil ditampilkan. Tetapkan berikut ini:
Nama server: – Ketik nama untuk server konfigurasi.
ID Server: – Ketik ID untuk identifikasi server 
konfigurasi. Hubungi operator selular atau sistem 
administrator Anda untuk memperoleh nilai yang 
benar.
Sandi: – Ketik sandi untuk identifikasi perangkat Anda 
oleh server. Konfirmasikan sandi tersebut.
Jalur akses: – Pilih jalur akses yang akan Anda gunakan 
untuk sambungan data ke server.
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Alamat asal: – Ketik alamat URL server. Hubungi 
operator selular atau sistem administrator Anda untuk 
memperoleh nilai yang benar.
Port: – Ketik nomor port server. Hubungi operator 
selular atau sistem administrator Anda untuk 
memperoleh nilai yang benar.
Nama pengguna: – Ketik nama pengguna Anda untuk 
server tersebut.
Sandi: – Ketik sandi Anda untuk server, kemudian 
konfirmasikan.
Memperbolehkan konfigurasi: – Pilih agar server dapat 
menginisialisasi sesi konfigurasi.
Terima otomatis p'mintaan sinkron: – Pilih jika Anda tidak 
ingin server meminta konfirmasi Anda saat inisialisasi 
sesi konfigurasi.

3 Tekan OK untuk menyimpan pengaturan.
Untuk mengedit pengaturan profil konfigurasi, pilih 
profil kemudian tekan Pengaturan.

Pengiriman data
Buka Meja > Transfer data.

Aplikasi Pengiriman data memungkinkan Anda melakukan 
sinkronisasi atau menyalin data kontak atau kalender 
antara smartphone dengan telepon selular yang 
mendukung Bluetooth. 

Untuk memulai wizard pengiriman data, tekan Baru 
kemudian ikuti petunjuk. Anda dapat menetapkan 
jenis dan lokasi pengiriman kemudian memilih objek 
yang akan dikirim.

Sinkronisasi
Buka Meja > Sinkronisasi.

Aplikasi Sinkronisasi memungkinkan kalender atau kontak 
Anda disinkronisasikan dengan berbagai aplikasi kalender 
dan buku alamat di komputer yang kompatibel atau di 
Internet. Sinkronisasi remote dijalankan melalui panggilan 
data GSM atau sambungan GPRS, sinkronisasi lokal 
dijalankan melalui sambungan USB dan Bluetooth.

Aplikasi Sinkronisasi menggunakan teknologi SyncML 
(versi 1.1.1) untuk sinkronisasi remote. Untuk informasi 
tentang kompatibilitas SyncML, hubungi penyedia aplikasi 
kalender atau buku alamat yang akan disinkronisasikan 
dengan smartphone Anda.

Untuk melakukan sinkronisasi data, buka aplikasi 
Sinkronisasi, pilih profil dari daftar kemudian tekan 
Sinkronisasi. Anda akan diberitahukan bila proses 
sinkronisasi sudah selesai.
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Untuk melihat log sinkronisasi, tekan Lihat setelah 
sinkronisasi selesai. File log menunjukkan status 
sinkronisasi untuk profil yang dipilih, dan jumlah entri 
kalender atau kontak yang ditambahkan, diperbarui, 
dihapus, atau dibuang (tidak disinkronisasikan) dalam 
smartphone Anda pada server.

Membuat profil sinkronisasi yang baru
Profil sinkronisasi adalah pengaturan untuk server remote. 
Anda dapat membuat beberapa profil untuk 
mensinkronisasikan data Anda dengan berbagai server 
atau aplikasi.

Anda mungkin menerima pengaturan sinkronisasi sebagai 
pesan khusus dari operator selular.
1 Buka aplikasi Sync, kemudian tekan . Pilih Profil > 

Baru.... Pilih apakah Anda akan menyalin nilai dari profil 
yang ada untuk digunakan sebagai basis profil baru.

2 Wizard Profil ditampilkan. Tetapkan berikut ini:
Nama: – Ketik nama profil.
Media data: – Tentukan apakah Anda akan melakukan 
sinkronisasi melalui Internet atau dengan 
menggunakan sambungan lokal.
Jalur akses: – Pilih jalur akses yang akan Anda gunakan 
untuk sambungan data.
Alamat asal: – Hubungi operator selular atau sistem 
administrator Anda untuk memperoleh nilai yang 
benar.

Port: – Hubungi operator selular atau sistem 
administrator Anda untuk memperoleh nilai yang 
benar.
Nama pengguna: – ID Anda untuk server sinkronisasi. 
Hubungi operator selular atau sistem administrator 
Anda untuk memperoleh ID yang benar.
Sandi: – Ketik sandi Anda, kemudian konfirmasikan. 
Hubungi operator selular atau sistem administrator 
Anda untuk memperoleh nilai yang benar.

3 Pilih objek yang akan Anda sinkronisasikan: entri 
kontak atau kalender.

4 Bila perlu, pilih lokasi yang tepat untuk pangkalan data 
kontak atau kalender lokal. Anda juga dapat memilih 
lokasi yang tepat untuk kalender remote atau buku 
alamat di server. Tentukan juga, jenis sinkronisasi yang 
Anda inginkan (Normal, Hanya ke perangkat, Hanya ke 
server).

5 Tekan Selesai untuk menyimpan pengaturan.
Untuk mengedit pengaturan profil sinkronisasi, pilih 
profil kemudian tekan Pengaturan. Selain pengaturan 
yang telah ditetapkan selama pembuatan profil, Anda 
dapat menetapkan pilihan berikut ini:

Memperbolehkan permintaan sinkron: – Jika dipilih, sesi 
sinkronisasi dapat dimulai secara otomatis oleh server.
Terima otomatis p'mintaan sinkron: – Pilih ini jika Anda 
tidak ingin server meminta konfirmasi Anda saat 
inisialisasi sesi sinkronisasi.
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Mengatasi masalah
Mengatasi masalah
• Smartphone tidak dapat diaktifkan.

- Pastikan baterai sudah terpasang dengan benar dan 
terisi daya.

- Pastikan kontak pada baterai dalam keadaan bersih.
- Coba aktifkan smartphone dengan menekan tombol 

daya  selama beberapa detik.
- Keluarkan baterai, tunggu sedikitnya selama 10 detik, 

kemudian pasang kembali baterai.
• Layar atau tombol telepon berkedip saat saya 

mencoba mengisi daya baterai.
- Pastikan baterai sudah terpasang dengan benar.

• Baterai tidak diisi ulang secara benar.
- Pastikan konektor terpasang pada tempatnya dan 

stopkontak yang digunakan berfungsi dengan baik.
- Baterai Anda kemungkinan sudah habis masa 

pakainya atau rusak. Hubungi agen Nokia terdekat.
- Selama pengisian daya baterai berlangsung, jangan 

gunakan fitur seperti browser Web atau RealPlayer, 
karena membutuhkan daya yang cukup besar. 
Aktivitas yang memerlukan daya terlalu besar dapat 
mengganggu proses pengisian daya baterai.

• Titik-titik yang hilang, tidak berwarna atau 
berwarna terang selalu muncul setiap kali 
smartphone diaktifkan.
- Ini merupakan karakteristik yang normal pada jenis 

layar ini.
• Layar sentuh tidak merespon dengan akurat.

- Kalibrasikan layar sentuh. Gunakan tombol gulir 
untuk membuka aplikasi Panel Kontrol, pilih Kalibrasi 
layar, kemudian ikuti petunjuk selanjutnya.

• Smartphone akan berhenti menjalankan beberapa 
atau semua perintah.
- Tunggu sebentar. Beberapa proses mungkin 

berlangsung lama hingga selesai. Jika perangkat ini 
masih tidak menjalankan perintah, mungkin salah 
satu aplikasi mengambil terlalu banyak memori. 
Tekan  kurang lebih selama 5 detik untuk menutup 
semua aplikasi (kecuali aplikasi yang sedang 
digunakan). Jika tindakan ini tidak membantu, 
nonaktifkan smartphone Anda, kemudian aktifkan 
kembali. Jika masih belum berfungsi, nonaktifkan 
telepon, keluarkan baterai, tunggu kurang lebih 
selama 10 detik, kemudian pasang kembali baterai. 
Untuk menghindari masalah dengan animasi Web, 
nonaktifkan plug-in: Dalam browser Web, tekan , 
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lalu pilih Peralatan > Pengaturan.... Buka halaman 
Plugins, lalu kosongkan kotak pilih Aktifkan plug-in. 
Menonaktifkan plug-in akan membatasi 
fungsionalitas browser Web Anda.

• Aplikasi dan tombol daya tidak memberikan respon.
- Keluarkan baterai, tunggu sedikitnya selama 10 detik, 

kemudian pasang kembali baterai tersebut.
- Cobalah mengisi daya smartphone.
Jika prosedur yang dijelaskan di atas tidak membantu, 
sebagai upaya terakhir sebelum menghubungi agen 
Nokia terdekat, Anda dapat mencoba memformat 
memori internal smartphone. Ingat, memformat 
memori akan menghapus semua objek kecuali 
aplikasi standar yang diinstal pabrik ke memori 
ROM! 
Jika Anda telah membuat salinan data cadangan ke 
kartu memori, lihat “Mengelola kartu kontak” pada 
halaman 149.
Saat Anda memformat memori internal, semua 
pengaturan, dokumen dan data lain di dalamnya yang 
pernah Anda buat atau modifikasi akan terhapus 
secara permanen. Untuk memformat memori internal, 
ikuti langkah berikut:
1 Putuskan sambungan pengisi daya, kemudian 

keluarkan baterai.
2 Tunggu sedikitnya selama 10 detik, kemudian 

masukkan kembali baterai untuk mengaktifkan 
smartphone. 

3 Saat Anda melihat layar Pembuka Nokia, segera 
tekan terus tombol + + . Tombol  harus 
ditekan terakhir. 

4 Konfirmasikan bahwa Anda akan memformat. 
Pemformatan dimulai.

• Saya tidak dapat membuat atau menerima 
panggilan.
- Periksa apakah Anda telah mengaktifkan profil 

Penerbangan. Jika profil ini aktif, Anda tidak akan 
dapat membuat atau menerima panggilan.

- Jika Anda hanya dapat membuka Telepon untuk 
membuat panggilan darurat, maka kartu SIM Anda 
belum dimasukkan.

- Periksa status pembatasan dan pengalihan 
panggilan. Pada aplikasi Telepon, tekan  lalu pilih 
Peralatan > Pengaturan > Pembatasan panggilan... atau 
Pengalihan panggilan....

- Smartphone mungkin sibuk: sedang mengirim atau 
menerima data, atau smartphone sedang digunakan 
sebagai modem. Tunggu sampai pengiriman data 
selesai, atau akhiri panggilan data.

• Kualitas panggilan buruk.
- Lokasi Anda tidak memungkinkan kualitas panggilan 

yang lebih baik. Pindah ke lokasi dengan penerimaan 
sinyal radio yang lebih baik. Penerimaan sinyal 
biasanya akan lebih baik di atas lantai dasar, di luar 
ruangan dan saat diam. Terkadang meski saat 
berjalan smartphone akan meningkatkan penerimaan 
sinyal secara perlahan.
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• Saya tidak dapat mengalihkan atau membatasi 
panggilan suara atau panggilan data.
- Anda mungkin tidak berlangganan untuk layanan 

yang dimaksud, atau tidak didukung oleh jaringan.
- Pastikan nomor pusat pesan dan nomor yang akan 

menerima panggilan yang dialihkan tidak kurang 
atau salah.

• Saya tidak dapat mengirim atau menerima pesan 
atau e-mail.
- Anda mungkin tidak berlangganan untuk layanan 

yang dimaksud, atau tidak didukung oleh jaringan.
- Pastikan Anda telah mengkonfigurasikan pengaturan 

yang berkaitan.
- Smartphone mungkin kekurangan memori.
- Format nomor yang Anda gunakan kemungkinan 

salah.
- Smartphone mungkin sibuk: sedang mengirim atau 

menerima data, atau smartphone sedang digunakan 
sebagai modem. Tunggu sampai pengiriman data 
selesai, atau akhiri panggilan data.

• Saya tidak dapat mengirim pesan multimedia.
- Anda mungkin tidak berlangganan untuk layanan 

yang dimaksud, atau tidak didukung oleh jaringan.
- Pastikan Anda telah mengkonfigurasikan pengaturan 

yang berkaitan.

- Smartphone mungkin kekurangan memori.
- Jika Anda mendapat pesan error saat memasukkan 

klip media ke dalam pesan, periksa apakah Modus 
multimedia pengaturan dalam pengaturan Pesan 
multimedia, halaman Umum tidak dipilih ke Modus 
pembatasan:.

• Saya tidak dapat mengakhiri sambungan Bluetooth.
- Jika perangkat lain dipasangkan dengan smartphone 

Anda dan sambungan dibiarkan terbuka tanpa 
aktivitas pengiriman data, maka satu-satunya cara 
untuk memutuskan sambungan adalah 
menonaktifkan sama sekali hubungan Bluetooth. 
Buka aplikasi Panel kontrol, kemudian pilih Bluetooth. 
Hapus kotak pilihan Aktifkan Bluetooth:.

• Saya tidak dapat menemukan perangkat Bluetooth 
aktif yang lain.
- Periksa apakah kedua perangkat sudah mengaktifkan 

Bluetooth.
Pastikan jarak antara kedua perangkat tidak lebih 
dari 10 meter atau pastikan bahwa tidak ada dinding 
atau penghalang lain di antara keduanya.

- Pastikan perangkat lainnya tidak berada dalam 
modus ‘sembunyi’.
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• Smartphone mungkin kekurangan memori.
- Periksa apakah Anda telah menerima banyak e-mail 

atau menyimpan gambar atau objek lainnya yang 
menggunakan banyak memori. Untuk membebaskan 
memori perangkat, hapus data yang sudah tidak 
terpakai, pindahkan objek ke kartu memori atau, bila 
perlu, pindahkan ke PC kompatibel. Untuk memeriksa 
pemakaian memori, buka aplikasi Panel kontrol 
kemudian pilih Memori.

• Saya memiliki masalah untuk terhubung ke PC.
- Pastikan PC Suite Nokia 7710 telah diinstal dan dapat 

dijalankan pada PC Anda. Lihat Petunjuk PC Suite 
untuk informasi lebih lanjut.

- Jika Anda menggunakan sambungan kabel, periksa 
apakah kedua ujung kabel telah dipasangkan dengan 
benar.
Jika Anda menggunakan sambungan Bluetooth, 
periksa apakah PC sudah kompatibel Bluetooth dan 
driver Bluetooth telah diinstal dan diaktifkan.

- Untuk masalah PC Suite lainnya, lihat Petunjuk PC 
Suite dan bantuan online PC Suite.

• Saya tidak mengetahui kode akses saya.
- Kode kunci standar smartphone Anda adalah 12345. 

Jika Anda lupa atau kehilangan kode kunci, hubungi 
agen smartphone Anda.

- Jika Anda lupa atau kehilangan kode PIN atau PUK, 
atau jika Anda belum menerima kode tersebut, 
hubungi operator selular jaringan.
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Informasi baterai
Pengisian dan Pengosongan
Perangkat Anda dilengkapi dengan baterai yang dapat diisi 
ulang. Kinerja penuh baterai baru hanya akan tercapai setelah 
dua atau tiga kali siklus pengisian dan pengosongan. Baterai 
dapat diisi dan dikosongkan ratusan kali, namun pada akhirnya 
baterai akan mengalami keausan. Bila waktu bicara dan waktu 
siaga terasa lebih singkat daripada biasanya, sudah waktunya 
Anda membeli baterai baru. Gunakan hanya baterai yang 
disarankan oleh Nokia, dan lakukan pengisian daya baterai 
hanya dengan pengisi daya yang dianjurkan oleh Nokia untuk 
perangkat ini.

Lepaskan steker pengisi daya dari stopkontak dan perangkat 
ini jika tidak digunakan. Jangan tinggalkan baterai dalam 
keadaan tersambung ke pengisi daya. Pengisian yang 
berlebihan dapat mempersingkat masa pakai baterai. Jika 
tidak digunakan, baterai yang terisi penuh akan kosong 
dengan sendirinya beberapa waktu kemudian. Temperatur 
yang berlebihan dapat mempengaruhi kemampuan pengisian 
daya baterai.

Gunakan baterai hanya untuk tujuan yang telah ditetapkan. 
Jangan gunakan pengisi daya atau baterai yang sudah rusak.

Baterai tidak boleh mengalami hubungan arus pendek. 
Hubungan arus pendek yang tidak disengaja dapat terjadi jika 
benda logam seperti uang logam, klip atau pena menyebabkan 
hubungan langsung ke terminal positif (+) dan negatif (–) 
baterai. (Terlihat seperti baris logam pada baterai). Hal ini 

dapat terjadi, misalnya jika Anda membawa baterai cadangan 
di saku baju atau tas. Terminal yang mengalami hubungan 
arus pendek dapat merusak baterai atau perangkat 
penghubungnya.

Membiarkan baterai di tempat yang panas atau dingin, 
misalnya di dalam mobil yang tertutup di musim panas atau 
musim dingin, akan mengurangi kapasitas dan masa pakai 
baterai. Usahakan agar baterai selalu berada pada temperatur 
antara 15°C dan 25°C (59°F dan 77°F). Perangkat dengan 
baterai yang panas atau dingin tidak dapat berfungsi untuk 
sementara, meskipun daya baterai dalam keadaan penuh. 
Kinerja baterai menjadi terbatas terutama sekali pada 
temperatur di bawah titik beku.

Jangan buang baterai ke dalam api! Buanglah baterai sesuai 
dengan peraturan dan ketentuan setempat yang berlaku. Bila 
memungkinkan, lakukan daur ulang baterai. Jangan buang 
baterai sebagai limbah rumah tangga.

Pedoman otentikasi baterai Nokia
Gunakan selalu baterai Nokia asli untuk keamanan Anda. 
Untuk memastikan bahwa Anda memperoleh baterai Nokia 
asli, belilah baterai dari agen Nokia resmi, cari logo Perangkat 
Tambahan Asli Nokia pada kemasannya dan periksa label 
hologram menggunakan langkah-langkah berikut:
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Menjalankan keempat langkah ini tidak merupakan jaminan 
penuh keaslian baterai. Jika karena alasan tertentu baterai 
yang diterima bukan baterai Nokia asli, sebaiknya hentikan 
penggunaan baterai tersebut dan bawa baterai ke pusat 
layanan resmi atau agen Nokia terdekat untuk mendapatkan 
bantuan. Pusat layanan resmi atau agen Nokia akan 
memeriksa keaslian baterai tersebut. Jika keasliannya tidak 
dapat diperiksa, kembalikan baterai ke tempat pembelian. 

Otentikasi hologram
1 Saat mengamati stiker hologram, 
logo Nokia connecting hands harus 
terlihat dari satu sudut dan logo 
Perangkat Tambahan Asli Nokia 
terlihat dari sudut yang lain.

2 Jika Anda memiringkan hologram ke 
kiri, kanan, bawah dan atas, maka 
Anda akan melihat 1, 2, 3 dan 4 titik di 
setiap sisinya.

3 Gores bagian samping label untuk 
melihat kode 20 angka, misalnya 
12345678919876543210. Balikkan 
baterai sehingga angka-angka 
tersebut menghadap ke atas. Baca 
kode 20 angka dimulai dari angka 
pada baris atas, kemudian lanjutkan 
dengan angka di baris bawah.

4 Pastikan kode 20 angka tersebut 
adalah benar dengan mengikuti 
petunjuk yang diberikan dalam 
www.nokiaoriginals.com/check.

Untuk membuat pesan teks, masukkan kode 20 angka, 
misalnya 12345678919876543210, kemudian kirim ke +44 
7786 200276.

Untuk membuat pesan teks,

• Untuk negara di Asia Pasifik kecuali India: Masukkan kode 
20 angka, misalnya 12345678919876543210, kemudian 
kirim ke +61 427151515.

• Hanya untuk India: Masukkan kata ’Baterai’ diikuti kode 
baterai 20 angka, misalnya Baterai 
12345678919876543210, kemudian kirim ke 5555.
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Tagihan operator nasional dan internasional akan berlaku.

Anda akan menerima pesan yang memastikan keaslian kode 
tersebut.

Jika Anda memerlukan bantuan untuk memastikan kode 
baterai, hubungi Nokia Care Centre terdekat yang tercantum 
di www.nokia-asia.com/carecentrelocator.

Bagaimana jika baterai Anda tidak asli?

Jika Anda tidak dapat memastikan keaslian baterai Nokia 
melalui hologram pada label, jangan gunakan baterai tersebut. 
Bawa baterai ke tempat layanan atau agen Nokia resmi untuk 
bantuan. Penggunaan baterai yang tidak disetujui manufaktur 
dapat berbahaya, dan berkinerja buruk serta merusak 
perangkat utama beserta perangkat tambahannya. 
Penggunaan tersebut juga dapat membatalkan persetujuan 
atau jaminan yang berlaku untuk perangkat.

Untuk informasi lebih lanjut tentang baterai Nokia asli, 
kunjungi www.nokiaoriginals.com/check. 
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Perangkat tambahan asli Nokia

Berbagai pilihan perangkat tambahan baru tersedia untuk 
telepon Anda. Pilih perangkat tambahan yang sesuai 
dengan kebutuhan komunikasi Anda. Beberapa perangkat 
tambahan dijelaskan secara rinci di bawah ini.

Daftar perangkat tambahan yang kompatibel:

Audio

Fashion Stereo Headset HS-3

Headset HS-5

Stereo Headset HDS-3

Boom Headset HDB-4

Wireless Headset HDW-3

Wireless Clip-on Headset HS-3W

Wireless Boom Headset HS-4W

Inductive Loopset LPS-4

Mobil

Headrest Handsfree BHF-3

Plug-in Car Handsfree HF-3

Mobile Charger LCH-12

Advanced Car Kit CK-7W

Penutup telepon (Cover)

Penutup telepon yang dapat diganti

Data

Kabel Sambungan DKU-2

Kartu memori DTS-64

Wireless GPS Module LD-1W

Gambar

Nokia Remote Camera PT-6

Image Album PD-1

Daya

Baterai BP-5L

Compact Charger AC-1A

Travel Charger ACP-12

Beberapa perangkat tambahan dijelaskan secara rinci di 
bawah ini.
Untuk ketersediaan perangkat tambahan, hubungi agen 
Nokia terdekat. Beberapa aturan penggunaan untuk 
perangkat tambahan:
• Jauhkan perangkat tambahan dari jangkauan anak-

anak.
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• Bila Anda melepas kabel sambungan aksesori, pegang 
dan cabut steker, bukan kabelnya.

• Periksa secara teratur apakah semua peralatan telepon 
selular di dalam kendaraan sudah terpasang dan 
berfungsi dengan benar.

Gunakan hanya baterai, pengisi daya (charger) dan 
perangkat tambahan yang telah diakui oleh Nokia. 
Penggunaan jenis lain akan membatalkan persetujuan 
atau jaminan atas telepon, dan mungkin 
membahayakan.

Baterai

# Waktu pengoperasian dapat berbeda-beda, tergantung 
pada kartu SIM, jaringan dan pengaturan pemakaian, serta 
cara dan kondisi pemakaian.

Wireless Clip-on Headset HS-3W

Headset nirkabel yang mudah digunakan dengan 
komponen utama penjepit dan alat dengar, untuk 
keperluan bisnis dan pribadi. 

Headset ini menggunakan teknologi nirkabel Bluetooth 
antara komponen utama dengan telepon yang kompatibel. 
Penggunaan fungsi panggilan dasar dari headset dan LED 
menunjukkan sambungan nirkabel aktif.

Jenis Tekn.
Waktu 
bicara#

Waktu siaga#

BP-5L Li-Polymer hingga 3,5 - 
12 jam

hingga 175 (7 hari) - 
220 jam (9 hari)
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Boom Headset HDB-4
Perangkat headset yang mungil dan ringan ini memiliki 
keindahan dan keistimewaan desain Nokia. Memberikan 
kualitas audio yang sangat baik, Anda dapat menjawab 
atau mengakhiri panggilan dengan menekan tombol pada 
bagian mikrofon headset.

Nokia Advanced Car Kit CK-7W
Nokia Advanced Car Kit CK-7W menawarkan komunikasi 
handsfree yang ramah pengguna dan dapat digunakan 
secara nirkabel maupun dengan kabel

Perangkat ini terdiri dari:

• Handsfree Unit HF-5

• Remote Control CU-7

• External HF Speaker HFS-12

• Mikrofon HFM-8

• Kabel Data CA-27

• Pelat Pemasangan MK-2

• Kabel Daya PCU-4

• Buku Petunjuk Pengguna/Pemasangan
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Travel Charger ACP-12
Perangkat ini mampu mengisi daya baterai dengan cepat 
dan efisien. Cocok untuk Anda yang sering bepergian. 
Pengisi daya baterai multi-voltase yang berdaya guna.

Catatan: Jenis steker bervariasi tergantung kebutuhan 
pasar.
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Perawatan dan Pemeliharaan
Perangkat Anda merupakan produk unggulan dan karenanya 
harus ditangani secara benar. Saran berikut akan membantu 
Anda memenuhi ketentuan jaminan.
• Pastikan perangkat dalam keadaan kering. Air hujan, 

kelembaban dan segala jenis cairan atau uap air dapat 
mengandung mineral yang akan menimbulkan korosi pada 
sirkuit elektronik. Jika perangkat Anda terkena air, 
lepaskan baterai dan biarkan perangkat ini benar-benar 
kering sebelum memasang kembali baterai.

• Jangan gunakan atau jangan simpan perangkat di tempat 
yang berdebu dan kotor. Komponen yang dapat dilepas dan 
komponen elektronik mungkin akan rusak.

• Jangan simpan perangkat ini di tempat yang panas. 
Temperatur yang tinggi dapat mempersingkat masa pakai 
perangkat elektronik, merusak baterai dan melelehkan 
komponen yang terbuat dari plastik.

• Jangan simpan perangkat ini di tempat dingin. Ketika 
temperatur kembali hangat (ke temperatur normal), uap 
air dapat terbentuk di dalam perangkat dan akan merusak 
panel sirkuit elektronik.

• Jangan coba membuka perangkat selain seperti yang 
diperintahkan dalam buku petunjuk ini.

• Perangkat jangan sampai terjatuh, terbentur atau 
terguncang. Penanganan yang tidak tepat dapat 
mematahkan panel sirkuit internal dan komponen yang 
halus.

• Jangan gunakan bahan kimia keras, larutan pembersih 
atau deterjen keras untuk membersihkan perangkat.

• Jangan cat perangkat. Lapisan cat dapat menyumbat 
komponen-komponen yang dapat dilepas dan 
menghambat penggunaan yang semestinya.

• Gunakan kain lembut, bersih, dan kering untuk 
membersihkan lensa, seperti lensa kamera, lensa sensor 
jarak, dan lensa sensor cahaya.

• Gunakan hanya antena pengganti yang sudah disediakan 
atau direkomendasikan. Antena, modifikasi antena atau 
peralatan tambahan yang tidak direkomendasikan dapat 
merusak perangkat ini dan melanggar peraturan yang 
mengatur tentang perangkat radio.

• Gunakan pengisi daya di dalam ruangan.

• Sebelum perangkat dikirim ke pusat layanan, buat salinan 
data cadangan yang akan Anda simpan (seperti kontak dan 
catatan kalender).

Semua saran di atas berlaku untuk perangkat ini, baterai, 
pengisi daya atau perangkat tambahan apapun. Jika salah satu 
komponen tersebut tidak bekerja sebagaimana mestinya, 
bawalah ke pusat layanan resmi yang terdekat.



Hak cipta © 2005 Nokia. Semua hak dilindungi undang-undang.

In
fo

rm
as

i K
es

el
am

at
an

 T
am

ba
ha

n

178

Informasi Keselamatan Tambahan
Kondisi pengoperasian

Patuhi semua peraturan khusus setempat yang berlaku, 
nonaktifkan perangkat jika terdapat larangan, atau jika dapat 
menimbulkan gangguan atau bahaya. Gunakan perangkat ini 
hanya dalam posisi pengoperasian normal. Perangkat ini telah 
memenuhi peraturan untuk hubungan frekuensi radio (RF) bila 
digunakan dalam posisi normal di dekat telinga atau bila 
berada sekurangnya 2,2 cm dari badan. Tas jinjing, pengait ikat 
pinggang, atau kantong telepon yang dikenakan di badan 
tidak boleh mengandung bahan logam, dan perangkat harus 
berada pada jarak yang disebutkan di atas dari badan Anda. 

Agar dapat mengirim file data atau pesan, perangkat ini 
memerlukan sambungan yang berkualitas baik ke jaringan. 
Pada beberapa kasus, pengiriman file data atau pesan dapat 
terganggu hingga kualitas sambungan tersebut tersedia. 
Patuhi petunjuk jarak di atas hingga pengiriman selesai.

Semua komponen telepon bersifat magnetis. Bahan dari logam 
dapat tertarik ke perangkat, dan orang yang memakai alat 
bantu dengar sebaiknya tidak mendekatkan perangkat ini ke 
telinga. Jangan letakkan kartu kredit atau media penyimpan 
yang bersifat magnetis di dekat telepon, karena informasi yang 
tersimpan pada media tersebut dapat terhapus.

Perangkat medis

Pengoperasian peralatan transmisi radio, termasuk telepon 
selular, dapat mengganggu fungsi peralatan medis yang tidak 
dilindungi secara memadai. Konsultasikan dengan dokter atau 
perusahaan pembuat peralatan medis tersebut guna 
menentukan apakah peralatan dimaksud cukup terlindung dari 
energi frekuensi radio (RF) eksternal atau jika Anda memiliki 
pertanyaan lainnya. Nonaktifkan telepon Anda di tempat 
perawatan kesehatan, bila ada larangan penggunaan telepon 
selular. Rumah sakit atau tempat perawatan kesehatan 
mungkin menggunakan peralatan yang sensitif terhadap 
energi RF eksternal.

Alat pacu jantung Produsen alat tersebut menganjurkan 
agar jarak antara telepon selular dengan alat pacu jantung 
minimal 15,3 cm. Jarak ini untuk menghindari kemungkinan 
terjadinya gangguan pada alat pacu jantung. Rekomendasi ini 
sesuai dengan penelitian independen yang dilakukan dan 
direkomendasikan oleh Lembaga Penelitian Teknologi 
Nirkabel. Pemakai alat pacu jantung harus:

• Selalu menjaga jarak perangkat ini lebih dari 15,3 cm dari 
alat pacu jantung

• Tidak menyimpan perangkat ini di dalam saku baju

• Menggenggam perangkat ini di telinga yang berlawanan 
dengan posisi alat pacu jantung untuk memperkecil 
potensi gangguan.
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Jika Anda mencurigai telah terjadi gangguan, nonaktifkan dan 
jauhkan perangkat ini.

Alat bantu dengar Beberapa perangkat selular digital 
mungkin terganggu dengan sejumlah alat bantu dengar. Jika 
terjadi gangguan seperti itu, hubungi operator selular Anda.

Kendaraan

Sinyal RF dapat mempengaruhi sistem elektronik kendaraan 
bermotor yang tidak dipasang dengan benar atau yang tidak 
cukup terlindungi (mis. sistem pengisian bahan bakar 
elektronik, sistem rem anti slip (anti penguncian), sistem 
kontrol kecepatan elektronik, sistem kantung udara). Untuk 
informasi lebih lanjut, tanyakan kepada pabrik pembuat atau 
perwakilannya mengenai kendaraan Anda atau perangkat 
tambahan di dalamnya.

Hanya petugas yang memenuhi syarat yang boleh 
memperbaiki perangkat ini atau memasangnya di dalam 
kendaraan. Pemasangan atau perbaikan yang keliru dapat 
menimbulkan bahaya dan membatalkan jaminan yang berlaku 
untuk perangkat ini. Periksa secara teratur untuk memastikan 
bahwa semua peralatan untuk perangkat selular di dalam 
kendaraan Anda sudah terpasang dan beroperasi dengan 
benar. Jangan simpan atau jangan bawa cairan yang mudah 
terbakar, gas atau bahan peledak dalam satu tempat bersama 
perangkat ini, komponen-komponennya atau perangkat 
tambahannya. Untuk kendaraan yang dilengkapi dengan 
kantong udara, ingatlah bahwa kantong udara akan 
mengembang dengan kuat. Jangan letakkan benda, termasuk 

peralatan yang terpasang atau peralatan nirkabel yang 
portabel di sekitar kantong udara atau di tempat 
mengembangnya kantong udara. Jika peralatan nirkabel di 
dalam kendaraan tidak terpasang dengan benar dan kantung 
udara mengembang, maka hal ini dapat mengakibatkan 
cedera berat.

Dilarang menggunakan perangkat ini saat berada dalam 
pesawat terbang. Nonaktifkan perangkat Anda sebelum naik 
ke pesawat terbang. Penggunaan perangkat telepon selular di 
dalam pesawat terbang dapat membahayakan pengoperasian 
pesawat terbang, mengganggu jaringan telepon dan 
melanggar hukum.

Kawasan berpotensi ledakan

Nonaktifkan telepon Anda ketika berada di wilayah dengan 
kandungan udara yang dapat menyebabkan ledakan serta 
patuhi semua petunjuk dan tanda. Kawasan berpotensi 
ledakan juga termasuk tempat yang biasanya meminta agar 
Anda mematikan mesin kendaraan. Percikan api di wilayah 
seperti ini dapat mengakibatkan ledakan atau kebakaran yang 
dapat menimbulkan cedera atau kematian. Nonaktifkan 
perangkat ini di tempat pengisian bahan bakar seperti di dekat 
pompa bensin. Patuhi semua larangan tentang penggunaan 
peralatan radio di tempat pengisian, penyimpanan dan 
distribusi bahan bakar, tempat bahan kimia atau di tempat 
yang sedang terjadi ledakan. Tempat-tempat yang berpotensi 
ledakan sering kali tidak diberi tanda dengan jelas. Termasuk 
dek bawah kapal; tempat pengiriman atau penyimpanan 
bahan kimia; kendaraan yang menggunakan bahan bakar gas 
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cair (seperti propane atau butane); tempat yang udaranya 
mengandung bahan kimia atau partikel seperti butir-butir, 
debu atau serbuk logam.

Panggilan darurat

Penting: Telepon selular, termasuk perangkat ini, 
beroperasi menggunakan sinyal radio, jaringan 
nirkabel, jaringan darat dan fungsi-fungsi yang 
diprogram untuk pengguna. Karenanya, jaminan 
sambungan di segala kondisi tidak dapat dilakukan. 
Oleh karena itu, Anda tidak boleh hanya 
mengandalkan perangkat selular untuk komunikasi 
penting seperti darurat medis.

Untuk membuat panggilan darurat:

1 Jika telepon tidak aktif, aktifkanlah. Pastikan kekuatan 
sinyal memadai.

Beberapa jaringan mungkin akan meminta kartu SIM yang 
berlaku dimasukkan dengan benar ke dalam perangkat ini.

2 Tekan terus  untuk menampilkan tombol telepon 
pada layar.

3 Masukkan nomor darurat resmi yang berlaku. Nomor 
darurat berbeda untuk setiap lokasi.

4 Tekan tombol .

PERINGATAN: Dalam profil Penerbangan, Anda tidak 
dapat membuat atau menerima panggilan, termasuk 
panggilan darurat, atau menggunakan fitur jaringan. 
Untuk membuat panggilan, pertama-tama aktifkan fungsi 
telepon dengan mengganti profil. Jika perangkat ini 
terkunci, masukkan kode kunci.

Nonaktifkan terlebih dahulu semua fitur yang sedang 
digunakan agar panggilan darurat dapat dibuat. Jika 
perangkat ini dalam modus offline atau penerbangan, Anda 
harus mengubah profil tersebut untuk mengaktifkan fungsi 
telepon agar dapat membuat panggilan darurat. Untuk 
informasi lebih lanjut, baca buku petunjuk ini atau hubungi 
operator selular Anda.

Saat membuat panggilan darurat, berikan semua informasi 
yang diperlukan sejelas mungkin. Perangkat selular Anda 
mungkin merupakan satu-satunya alat komunikasi di tempat 
kejadian. Jangan akhiri panggilan sebelum diperbolehkan.
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Informasi Pengesahan (SAR)

TELEPON MODEL INI TELAH MEMENUHI PERATURAN 
INTERNASIONAL UNTUK HUBUNGAN KE GELOMBANG RADIO. 
Telepon selular Anda merupakan pemancar sekaligus penerima 
radio. Telepon dirancang dan diproduksi untuk tidak 
melampaui batas hubungan ke energi frekuensi radio (RF) 
seperti yang direkomendasikan oleh peraturan internasional 
(ICNIRP). Batasan ini merupakan bagian dari pedoman 
menyeluruh dan menetapkan level energi RF yang 
diperbolehkan untuk masyarakat umum. Pedoman tersebut 
dikembangkan oleh organisasi ilmiah independen melalui 
evaluasi studi ilmiah yang cermat dan berkala; serta 
mencakup margin keamanan penting yang dirancang untuk 
menjamin keselamatan semua orang, tanpa memperhitungkan 
usia dan kesehatan.
Standar hubungan untuk telepon selular menggunakan unit 
pengukuran yang dikenal sebagai Angka Absorsi Spesifik atau 
SAR. Batas SAR yang direkomendasi oleh peraturan 
internasional adalah 2,0 Wkg*. Pengujian untuk SAR dilakukan 
menggunakan posisi pengoperasian standar dengan 
pemancaran telepon pada level daya tercatat dan tertinggi di 
semua gelombang frekuensi yang diuji. Walaupun SAR 
ditentukan pada level daya tercatat dan tertinggi, level SAR 
telepon yang sebenarnya ketika beroperasi dapat berada di 
bawah nilai maksimum. Hal ini karena telepon dirancang 

untuk beroperasi pada level daya yang beragam, jadi telepon 
hanya akan menggunakan daya yang diperlukan untuk 
mencapai jaringan. Secara umum, semakin Anda dekat 
dengan stasiun pangkalan untuk antena, maka semakin 
rendah output daya.
Nilai SAR tertinggi untuk model telepon ini saat diuji untuk 
penggunaan di telinga adalah 0,53 W/kg. Mungkin terdapat 
perbedaan antara level SAR dari berbagai telepon dan 
berbagai posisi, namun semua itu telah memenuhi peraturan 
internasional untuk hubungan RF.
Produk ini telah memenuhi peraturan untuk hubungan 
frekuensi radio (RF) bila digunakan dalam posisi normal di 
dekat telinga atau bila berada sedikitnya 2,2 cm dari badan. 
Jika Anda menggunakan tas jinjing, pengait ikat pinggang 
atau kantung telepon yang dikenakan di badan, semua 
aksesori tersebut tidak boleh mengandung bahan logam dan 
harus berada sedikitnya 2,2 cm dari badan Anda.

* Batas SAR untuk telepon selular yang digunakan oleh publik 
adalah 2,0 wattkilogram (Wkg) atau setara dengan sepuluh 
gram jaringan tubuh manusia. Batas ini mencakup margin 
keselamatan yang penting untuk memberikan perlindungan 
tambahan bagi publik dan untuk memperhitungkan setiap 
variasi pengukuran. Nilai SAR dapat bervariasi tergantung 
pada perkiraan kebutuhan nasional dan pita jaringan. Untuk 
informasi SAR di wilayah lainnya, silahkan lihat pada 
informasi produk di http://www.nokia.com.
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Indeks
A
Agenda 75

ikon 76
aksesori 123
Alamat IP 126
alarm 115

kalender 73
album musik 103
animasi flash 78
aplikasi

grup 35
melepas 119
melihat rincian tentang 119
memasang 29
membuka 20

Aplikasi Java 29
memasang 30

B
bahasa perangkat 134
bar peralatan 20, 21
baterai

indikator status 24
informasi 170
melepas 14

memasang 14
mengisi daya 17

bebas genggam 28
Bluetooth

sinkronisasi 164
browser

Lihat  Web
buku kerja 111

C
cache 80
cara pintas 34
Cari 23
CBS 153

daftar topik 153
pengaturan 154

CD-ROM 158
cookie 82

D
daftar lagu 103
daftar putar 98

membuat 98
menambah 99
menambahkan lagu 98
mencari 99

mengedit 99
menghapus 100

daftar topik untuk CBS 153
daftar tugas 75
data

indikator sambungan 25
jalur akses 33, 124
menyalin 159
penghitung 151
sambungan 33

data berkecepatan tinggi (HSCSD) 33
data paket 32
daya

mengaktifkan dan 
menonaktifkan 17

Di dalam kemasan 52
simbol 52

Dokumen 109
Lihat juga dokumen teks

dokumen teks 109
memasukkan karakter khusus 109, 

111
memasukkan tanggal 109
mengedit jenis paragraf 110
mengirim 109
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E
e-mail

Di dalam kemasan 52
jalur akses 124
Kotak keluar 52
lampiran 59
mengambil dari kotak surat 55
mengirim 57
menjawab 56
pemformatan 58
pengaturan 53

F
file

file .JAD dan .JAR 29
file .SIS 29
mengelola 148

folder
mengelola 149

format angka 131
format mata uang 132
Foto

foto latar belakang 35
foto latar belakang 35
fotograf

kamera 83
frame 81
fungsi

dasar 22
umum 23

fungsi umum 23
fungsi-fungsi dasar 22

G
Gambar

mengedit 90
menyusun 88
pengaturan 89
peralatan menggambar 90

GPRS 32, 33
Pengaturan sambungan 

Internet 128
penghitung data 151
tarif 33

grafik 112
grup

aplikasi 35
catatan agenda 75
kartu kontak 71

H
headset 29

pengaturan 123
HSCSD 32

I
ID layanan visual 105
ikon

area status 23
catatan agenda 76

kalender 74
kekuatan sinyal 24
level daya baterai 24
sambungan data 25

ikon status 23
indikator

Lihat ikon
indikator kekuatan sinyal 24
Informasi Pengesahan (SAR) 181
Internet

Lihat juga  Web
pengaturan jalur akses 124
pengaturan sambungan 128
persyaratan akses 124

J
jalur akses 33

mengatur 124
Jam 115

alarm 115
kota 116

jenis paragraf 110

K
Kalender 72

alarm 73
entri 73
ikon 74
sinkronisasi 164
tampilan hari 72
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tampilan minggu 74
Kalkulator 117
kalkulator meja 117
kalkulator till roll 117
Kamera 83

mengambil gambar 83
pengaturan 84

karakter khusus
memasukkan 109, 111

kartu kontak 68
grup kontak 71
kartu kontak SIM 69
kolom 69
membuat 68
mengedit 68
mengirim 70
menyalin dari kartu SIM 19
menyalin ke dan dari kartu SIM 70
nada dering pribadi 69
nomor sambungan cepat 69
tag suara 70

kartu memori 149
melepas 16
memasang 16
membuat salinan data 

cadangan 149
mengembalikan salinan data 149
mengubah nama 149
menyimpan kembali data 149

kartu memori, perlindungan 149
Kartu SIM

memasang 14
kembali ke Meja 20
keyboard 38
keyboard layar 38
klip suara 107
kode 26, 132

kode kunci 132
Kode PIN 133
kode PUK 133
periode kunci otomatis 132
sandi pembatasan 133

kode akses 26, 132
kode akses SecurID 146
kode kunci 26, 132

memasukkan 18
Kode PIN

memasukkan 18, 133
mengganti 133

kode PIN 26
kode PUK 26, 133
Kolom alamat server pengamanan 141
Kolom diperhaharui 138
Kolom identitas pengguna 143
kolom jalur akses Internet 141
kolom Kode akses berikutnya 146
Kolom kode akses VPN 145

Kolom konfirmasi 144
Kolom nama pengguna server 

pengamanan 142
Kolom nama pengguna VPN 145
kolom nama pengguna VPN 145, 146
Kolom nama server pengamanan 138, 

141
Kolom sandi 144
kolom sandi server pengamanan 142
kolom sandi VPN 145
kolom status sertifikat 138
kolom-kolom

Alamat server pengamanan 141
Diperbarui 138
Identitas pengguna 143
jalur akses Internet 141
Kode akses berikutnya 146
Kode akses VPN 145
Konfirmasi 144
Nama pengguna server 

pengamanan 142
Nama pengguna VPN 145
nama pengguna VPN 145, 146
Nama server pengamanan 138, 
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